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About This Guide

This guide describes how to administer and maintain the Cisco IP Solution Center Traffic Engineering 
Management (ISC TEM) software. This chapter describes how this guide is organized, who should read 
it, related information, and the document conventions used throughout the guide. 

Objective and Audience
The purpose of this user guide is to enable users to take advantage of the features provided by ISC TEM 
to enhance the traffic performance and predictability in an IP network.

This book is written as a resource for experienced users and administrators who must install, configure, 
deploy and monitor the ISC TEM software. 

It is assumed you have a basic understanding of network design, operation, and terminology, a general 
familiarity with the ISC software, and that you are familiar with your own network configurations.

A general understanding of MPLS TE concepts and traffic engineering is also required.

How This Guide Is Organized
This guide is organized as follows:

Chapter 1, “Introduction to ISC TEM,” gives an overview of the ISC TEM software.

Chapter 2, “Setting Up the Service,” describes the bootstrapping process required to enable network data 
collection and deployment of TE configurations on the network.

Chapter 3, “TE Network Discovery,” describes the process of discovering the network for a particular 
TE provider.

Chapter 4, “TE Resource Management,” explains how to modify resource characteristics to optimize 
tunnel placement.

Chapter 5, “Basic Tunnel Management,” provides an overview of the stages required to create and 
deploy primary and backup tunnels with a base license.

Chapter 6, “Advanced Primary Tunnel Management,” describes the stages required to create and deploy 
primary tunnels using the planning functions.

Chapter 7, “Protection Planning,” explains how to compute protection tunnels for network elements and 
deploy these on the network.

Chapter 8, “Traffic Admission,” explains how to assign traffic to traffic-engineered tunnels.
ix
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About This Guide
Related Documentation
Chapter 9, “Administration,” describes various administrative tools and features.

Chapter 10, “Task Monitoring,” explains how deployment and collection tasks are monitored and how 
task details are logged.

Chapter 11, “TE Topology,” explains how to use the TE Topology tool to display the layout of the 
network.

Appendix A, “Traffic Engineering Management GUI,” describes the ISC TEM GUI and the various 
fields and other GUI elements. 

Appendix B, “Warnings and Violations,” lists warnings and violations that might be invoked when using 
the planning tools in ISC TEM.

Appendix C, “Document Type Definition (DTD) File,” contains a sample DTD file that specifies the 
structure and rules used for XML import.

Related Documentation
The entire documentation set for Cisco IP Solution Center, 4.0 can be accessed at: 

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/isc/4_0

The following documents comprise the ISC 4.0 documentation set.

General documentation (in suggested reading order):

• Cisco IP Solution Center Documentation Guide, 4.0

• Cisco IP Solution Center Release Notes, 4.0

• Cisco IP Solution Center Installation Guide, 4.0

• Cisco IP Solution Center Infrastructure Reference, 4.0

• Cisco IP Solution Center System Error Messages, 4.0

Application and technology documentation (listed alphabetically):

• Cisco IP Solution Center L2VPN User Guide, 4.0

• Cisco IP Solution Center MPLS VPN User Guide, 4.0

• Cisco IP Solution Center Quality of Service User Guide, 4.0

• Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

API documentation:

• Cisco IP Solution Center API Programmer Guide, 4.0

• Index: Cisco IP Solution Center API Programmer Reference, 4.0 

Note All documentation might be upgraded.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.
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About This Guide
Documentation Feedback
Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 800 553-NETS (6387).

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco 
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical 
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical 
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service 
contract, contact your reseller.
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About This Guide
Obtaining Technical Assistance
Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 
365 days a year at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. 
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool automatically 
provides recommended solutions. If your issue is not resolved using the recommended resources, your 
service request will be assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at 
this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.
xii
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About This Guide
Obtaining Additional Publications and Information
Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit 
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at this 
URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html

Conventions and Terminology
This section discusses conventions and terminology used throughout this manual.

• pointer—indicates where the mouse action is to occur

• select—to push and hold down the left mouse button

• release—to let up on a mouse button to initiate an action

• click—to select and release a mouse button without moving the pointer

• double-click—to click a mouse button twice quickly without moving the pointer
xiii
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About This Guide
Conventions and Terminology
• drag—to move the pointer by sliding the mouse with one or more buttons selected.

This manual uses this terminology throughout (even though it is possible for individual users to 
customize their devices to use the buttons in an alternative manner). In situations that allow more than 
one item to be selected from a list simultaneously, the following actions are supported:

• To select a single item in a list, click on the entry. Clicking a second time on a previously selected 
entry deselects it.

• To select a contiguous block of items, click on the first entry; then, without releasing the mouse 
button, drag to the last desired entry and release. (A subsequent click anywhere on the screen 
deselects all previous selections.)

• To extend a currently selected block, hold the Shift key down and click on the entry at the end of 
the group to be added

• To add a non-contiguous entry to the selection group, press the Ctrl (Control) key and click on the 
entry to be added.

Names of on-screen elements that you click, or select (menu names and commands, and controls such 
as buttons, drop-down lists, and so on) are printed in bold font. Bold font is also used for keywords, 
names of commands, and names of keys on the keyboard. Text displayed as on-screen examples is 
printed in courier font.

When set off from the main text, words and characters you should enter by the keyboard are printed in 
bold font. When the word or character string is enclosed in angle brackets (< and >), you should 
substitute your own character string for the example presented in the text.

For example, when you see:

login: root

you should specify the string root at the login prompt. However, when you see:

password: <rootpassword>

you should specify your own password in place of the character string <rootpassword>. The italic style 
is used to emphasize words, to introduce new terms, and for titles of printed publications (however, not 
titles of CD-ROMs or floppy disks).
xiv
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C H A P T E R 1

Introduction to ISC TEM

This guide contains a detailed description of the Cisco IP Solution Center Traffic Engineering 
Management (ISC TEM) product, including the various features, the GUI, and the step-by-step processes 
needed to perform various traffic engineering management tasks.

This chapter contains the following sections:

• ISC TEM Overview, page 1-1

• Features in ISC TEM, page 1-2

• Prerequisites and Limitations, page 1-2

• Supported Platforms, page 1-2

• Licensing Schemes, page 1-3

• ISC TEM Basics, page 1-3

– Managed/Unmanaged Primary Tunnels, page 1-3

– Conformant/Non-Conformant Tunnels, page 1-3

– Bandwidth Pools, page 1-4

– Planning Tools, page 1-4

• Process Flows, page 1-5

ISC TEM Overview
ISC TEM is the Traffic Engineering Management module of IP Solution Center. It is a tool for managing 
Multiprotocol Label Switching Traffic Engineering (MPLS TE) primary tunnels and backup tunnels for 
the purpose of offering traffic Service Level Agreement (SLA) guarantees. It provides bandwidth 
protection management, network discovery, and support for configuring MPLS TE. It includes a number 
of powerful planning tools, including a sophisticated primary path calculation tool and backup tunnel 
calculation for element protection.

MPLS TE mechanisms are provided to support requirements for predictability, traffic flow matched to 
QoS requirements, and Fast Restoration with Guaranteed Bandwidth, ensuring that strict SLA 
performance criteria (availability, delay, jitter) are met.
1-1
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Features in ISC TEM
Features in ISC TEM
ISC TEM adds a range of MPLS TE primary tunnel management features:

• Tunnel Audit—finding inconsistencies after making tunnel modifications

• Tunnel Admission—admitting new tunnels onto the network

• Tunnel Repair—fixing tunnel inconsistencies after network and service changes

• Network Grooming—optimizing global network utilization.

In addition, ISC TEM offers interaction and integration with ISC features:

• Service activation focus

• Integration with other ISC modules (MPLS VPN, IPsec VPN, L2VPN, QoS)

• Data Persistence

• Logging of user intent

• Service state management

• Service auditing

• Web-based GUI

• Role-Based Access Control (RBAC)

Prerequisites and Limitations
See Cisco IP Solution Center Installation Guide for general system recommendations.

A number of requirements are associated with the TE Discovery task. These are described in TE 
Discovery Prerequisites, page 3-1.

Some features might only be available with a particular license. For more information, see Licensing 
Schemes, page 1-3.

The number of nodes provided by the license limits the size of the network.

In the Planning portion of the current implementation of ISC TEM, concurrent use is not recommended 
as users working simultaneously risk being unable to commit their changes.

ISC TEM Topology and Java Webstart requires JRE version 1.4.2_04.

Supported Platforms
For supported IOS platforms, see Cisco IP Solution Center Installation Guide.

Supported hardware platforms:

• 12xxx

• 75xx

• 72xx
1-2
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Licensing Schemes
Licensing Schemes
The ISC TEM installation comes with three types of licenses, TE, TE/RG, and TE/BRG, that gives 
access to all ISC TEM features, including Planning Tools for protection planning (backup tunnels).

The licensing for the TE license is based specifically on the scale of the MPLS-TE network, that is the 
number of nodes. 

Ranges are as follows:

• Up to 20 (starter pack)

• Up to 50

• Up to 100

• Up to 150

For a larger number of nodes, please contact your Cisco sales representative.

ISC TEM Basics
To understand how ISC TEM works, certain key concepts must be explained.

Managed/Unmanaged Primary Tunnels
In ISC TEM, the concept of managed tunnels is at the center of TE planning activities. 

It is important to understand the differences:

• Managed TE tunnels:

– (setup/hold) priority zero

– non-zero RSVP bandwidth

– explicit first path option

– auto bandwidth must have a max value

• Unmanaged tunnels: All other tunnels.

In the ISC TEM Graphical User Interface (GUI), there is a separate entry point for dealing with managed 
and unmanaged tunnels. The GUIs are very similar and the differences are described in Create 
Unmanaged TE Tunnel, page A-58.

Conformant/Non-Conformant Tunnels
In the ISC TEM design, a sharp distinction has been made between conformant and non-conformant 
tunnels:

• Conformant tunnel—A well-behaved tunnel that meets ISC TEM’s TE management paradigm 
(described below). A managed tunnel can only be a conformant tunnel. A non-zero priority 
unmanaged tunnel would also be a conformant tunnel. However, a conformant tunnel is not 
necessarily a managed tunnel.
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• Non-conformant tunnel—A TE tunnel, which might impact ISC TEM’s ability to meet bandwidth 
guarantees. This could be due to unknown bandwidth requirements such as no max bandwidth 
configured for auto-bandwidth, potential for pre-emption, dynamic paths, etc. A zero priority 
unmanaged tunnel would also be a non-conformant tunnel.

Conformant tunnels are preferred. They allow the system to offer bandwidth guarantees for managed 
tunnels. Unmanaged non-conformant tunnels might or might not provide the needed bandwidth and no 
bandwidth guarantees are given.

Non-conformant tunnels introduce factors that might not be accounted for during planning, which makes 
it difficult to offer bandwidth guarantees for managed tunnels. They represent an obstacle to meeting 
strict SLA guarantees due to their potential for impacting critical traffic on managed tunnels.

ISC TEM only allows the creation of conformant tunnels. Non-conformant tunnels can be introduced 
through the TE Discovery process (see Chapter 3, “TE Network Discovery”). However, when a 
non-conformant tunnel is discovered a warning is logged. ISC TEM tracks non-conformant tunnels so 
that they can be decommissioned.

Bandwidth Pools
The bandwidth of each TE enabled interface is assigned a number of nested bandwidth pools. Currently, 
IOS supports two, namely Global Pool and Sub Pool.

For a better understanding of bandwidth pools, see Figure 1-1.

Figure 1-1 Bandwidth Pools

As Figure 1-1 illustrates, Sub Pool is nested inside Global Pool. Thus, if a primary tunnel reserves 
bandwidth from the Sub Pool, it will also reserve the same bandwidth from the Global Pool. 

Bandwidth reservations (primary tunnels) from the Sub Pool must not exceed, in total, the Sub Pool size.  
Likewise, bandwidth reservations from the Global Pool must not exceed, in total, the Global Pool size.

Planning Tools
They are intended for evaluating planned improvements to a traffic-engineered network based on 
What-If scenarios .

The planning tools include the following features:

• Primary planning tools:
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– Tunnel Audit—Audits for inconsistencies in primary placement on the existing network with or 
without proposed tunnel or resource changes.

– Tunnel Placement—Usually for new tunnels. Tunnel Placement can generate a new route. It can 
be used for a tunnel that did not have a path before and needs to be placed.

– Tunnel Repair—Logically performed after Tunnel Audit (if something is wrong). Tunnel Repair 
has re-routing capabilities and can be used to move tunnels.

– Grooming—An optimization tool that works on the whole network. It is only available when no 
tunnel attributes have been changed.

• Protection planning tools:

– Audit SR—Audits protection for manually added, modified and deleted tunnels before they are 
deployed.

– Compute Backup—Automatically calculates the optimal backup tunnel for selected network 
elements.

– Audit Protection—Audits protection of the selected elements against the existing backup 
tunnels.

The planning tools are fully integrated within ISC TEM and are available from various locations within 
the GUI:

• TE Resource Modification (Tunnel Audit, Tunnel Repair)

• TE Protected Elements (Compute Backup and Audit Protection)

• Create Managed TE Tunnel (Tunnel Audit, Tunnel Placement, Tunnel Repair, Grooming)

• Create TE Backup Tunnel (Audit SR)

Process Flows
The following illustration shows the main components and flows in ISC TEM.

Figure 1-2 Main Process Flows in TEM

The illustration includes the following components:
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• Bootstrapping—Sets up key parameters that enable the system to collect TE network information 
and subsequently deploy TE configurations on the chosen network. (See Chapter 2, “Setting Up the 
Service”)

• Performance Tasks—Calculates interface/tunnel bandwidth utilization using the Simple Network 
Management Protocol (SNMP). (See Chapter 9, “Administration”)

• Resource Management—Tuning of certain properties on the TE interfaces to optimize the tunnel 
placement. (See Chapter 4, “TE Resource Management”)

• Primary Tunnel Management—Create and manage primary tunnels, either unmanaged (See 
Chapter 5, “Basic Tunnel Management”) or managed. (See Chapter 5, “Basic Tunnel Management” 
or Chapter 6, “Advanced Primary Tunnel Management”)

• Protection Management—Protect selected elements in the network (links, routers, or SRLGs) 
against failure. (See Chapter 7, “Protection Planning”)

• Traffic admission—Assign traffic to traffic-engineered tunnels. (See Chapter 8, “Traffic 
Admission”)
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Setting Up the Service

Cisco IP Solution Center Traffic Engineering Management (ISC TEM) offers the license structure 
described in Chapter 1, “Introduction to ISC TEM.” The ISC TEM specific installation steps are 
described in this chapter whereas the general installation procedure for Cisco IP Solutions Center (ISC) 
is described in Cisco IP Solution Center Installation Guide, 4.0.

This chapter contains the following sections:

• Bootstrapping Process Overview, page 2-1

• ISC TEM Client Setup and Installation, page 2-3

• Creating a TE Provider, page 2-4

Bootstrapping Process Overview
The bootstrapping process sets up key parameters that enable the system to collect TE network 
information and subsequently deploy TE configurations on the chosen network.

An overview of the bootstrapping process is provided in Figure 2-1.
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Figure 2-1 Bootstrapping Process

The process includes the following steps:

Step 1 Set up new user and install license keys—To run the TEM blade of ISC, it is necessary to create a new 
user and install license keys. These keys will enable the user to view and manage the TE tunnels and 
resources using ISC. (see ISC TEM Client Setup and Installation, page 2-3)

Step 2 Create a provider and a region for the provider—The provider is a concept designed to allow many 
different operators to work on ISC TEM simultaneously, each working on different networks. Thus, each 
provider has to be defined and used as a reference operator for future work on the system. The region is 
important because a single provider could have multiple networks. The region is used as a further level 
of differentiation to allow for such circumstances. (To create a provider and a region, see Cisco IP 
Solution Center Infrastructure Reference, 4.0.)

Step 3 Create a seed device—This IOS Device will be the seed router for network discovery. The network 
discovery process uses the seed router as an initial communication point to discover the MPLS TE 
network topology. A set of TE enabled devices, links, explicit paths, tunnels, and static routes are then 
populated to the database. (To create a seed router, see Cisco IP Solution Center Infrastructure 
Reference, 4.0.)
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Step 4 Create a TE Provider—Providers can be defined as TE provider, if they are supporting MPLS TE in 
their network. It is necessary to create a TE provider to enable a TE network to be managed. All TE 
related data associated with a given network is stored under a unique TE provider. A provider and region 
uniquely define a TE provider (see Creating a TE Provider, page 2-4).

Step 5 Run Discovery Task—Discover the TE network for a particular TE provider to populate the repository 
with a view to creating primary and backup tunnels (see Chapter 3, “TE Network Discovery”).

Note If Telnet is selected to communicate with the seed router, Telnet must also be used for the other 
network devices. Likewise, if SSH is selected for the seed router, SSH must be used for all other 
devices.

ISC TEM Client Setup and Installation
Before setting up ISC TEM, the ISC software must be installed. To do so, see Cisco IP Solution Center 
Installation Guide, 4.0.

To set up a new ISC TEM user, one or more users with a TE role must be created. For step by step 
instructions, see Cisco IP Solution Center Infrastructure Reference, 4.0.

For an explanation of license keys in ISC, see Cisco IP Solution Center Infrastructure Reference, 4.0.

To install a TE license, use the following steps:

Step 1 Log into ISC with the following default values:

• User Name: admin

• Password: cisco

Step 2 Navigate Administration > Security > Users.

Step 3 Click Create.

Step 4 Fill in User ID, Password, Verify Password, and the Personal Information section.

Step 5 Click Edit to edit the assigned roles.

Step 6 Select TERole and click OK. TERole provides full access to ISC TEM. The TEServiceOpRole only 
has the privilege to access the tunnel admission SR.

Step 7 Click Save.

Step 8 Navigate Administration > Control Center > Licensing.

Step 9 Enter the three TEM license keys for TE, TE/RG, and TE/BRG successively:

• Click Install.

• Enter a license key.

• Click Save.

Repeat the procedure for each license key.

Typing in all three license keys is the only valid installation.

Step 10 Log out as admin.

Step 11 Log in as the user created above.
2-3
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



Chapter 2      Setting Up the Service
Creating a TE Provider
You are now ready to start using ISC TEM.

Note The admin role should only be used to manage ISC and not to perform network management operations.

Creating a TE Provider
After a provider and a region for that provider have been set up (see Cisco IP Solution Center 
Infrastructure Reference, 4.0), create a TE provider using the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

The Traffic Engineering Management Services window shown in Figure 2-2 appears.

Figure 2-2 Traffic Engineering Management Services

Step 2 Click TE Providers.
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The TE Providers window shown in Figure 2-3 appears.

Figure 2-3 TE Providers

For an explanation of the various window elements, see the “TE Providers” section on page A-3.

Step 3 Click Create to create a TE provider.

The Create / Edit TE Provider window shown in Figure 2-4 appears.

Figure 2-4 Create/Edit TE Provider

For an explanation of the various window elements, see Create/Edit TE Provider, page A-3.

To select a provider name, click the Select button next to the Provider Name field. The Provider for 
Create TE Provider window shown in Figure 2-5 appears.
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Step 4 Add primary and backup route generation parameters. To understand Fast Re-Route (FRR) protection 
pools, see Bandwidth Pools, page 1-4.

Figure 2-5 Provider for Create TE Provider

Step 5 Select the desired provider using the radio buttons or search for a provider with search criteria matching 
a provider name and click Find.

Step 6 Click Select to select the desired provider. The Provider for Create TE Provider window closes.

The selected provider name is displayed in the Provider Name field.

Step 7 Fill in the remaining required fields (marked ‘*’) and any optional fields as desired.

Step 8 For the required Region for TE Devices field, click the corresponding Select button. The Region for 
Create TE Provider window shown in Figure 2-6 appears.

Figure 2-6 Region for Create TE Provider

Step 9 Select the desired region using the radio buttons.

Step 10 Click Select to select the desired region. The Region for Create TE Provider window closes.

The selected region name is displayed in the Region for TE Devices field.

Step 11 For the optional Customer for Primary Tunnels field, click the corresponding Select button. The 
Customer for Create TE Provider window shown in Figure 2-7 appears.
2-6
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



Chapter 2      Setting Up the Service
Creating a TE Provider
Figure 2-7 Customer for Create TE Provider

Step 12 If desired, select a customer using the radio buttons or search for a customer by entering customer search 
criteria in the Show Customers with Customer Name matching field and click Find.

Step 13 Click Select to select the desired customer. The Customer for Create TE Provider window closes.

The selected customer name is displayed in the Customer for Primary Tunnels field of the Create / 
Edit TE Provider window.

Step 14 Click Save.
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TE Network Discovery

After the bootstrapping process has been completed and a seed router created, you can discover the TE 
network for a particular TE provider to populate the repository with a view to creating primary and 
backup tunnels. 

The TE network is discovered by creating TE Discovery tasks and using a logging and verification 
mechanism.

This chapter describes the steps required to create and run a TE Discovery task and verify the results. 

It includes the following sections:

• Overview, page 3-1

• TE Discovery Prerequisites, page 3-1

• Creating a TE Discovery Task, page 3-2

• Verifying a TE Discovery Task, page 3-6

Overview
The purpose of the discovery process is to populate the repository with the network topology, tunnels, 
and static routes to tunnels present in the live network.

The discovery process uses a seed device to discover the MPLS TE network topology using either Telnet 
or SSH. It uses a schedulable task that can be run once or on a periodic basis. Any inconsistencies 
between the repository and the network are reported. The service state information is updated 
incrementally by logging tunnel in-use Label Switched Paths (LSPs) and updating the service request 
(SR) state.

TE Discovery Prerequisites
To successfully run a TE Discovery task, the seed router must be directly accessible from the 
management station.

For Telnet, there must be either direct Telnet access from the Cisco IP Solution Center Traffic 
Engineering Management (ISC TEM) management station to each device and/or Telnet access from the 
seed device. 

See Bootstrapping Process Overview, page 2-1 for instructions on how to select Telnet or SSH when 
setting up a seed router.
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Memory Shortage on Large Networks
When running discovery on a large network (250+ devices or 5000+ tunnels, for example) and an 
OutOfMemoryException is encountered, do the following:

Edit the watchdog.server.worker.java.flags property in the vpnsc.properties file to say -Xmx1024m 
instead of the default -Xmx512m. This increases the heapsize of the discovery task, which will clear up 
the OutOfMemoryException problem.

When no longer needed, make sure to revert the properties back to their original state to reduce the 
resource usage.

Creating a TE Discovery Task
To create a TE Discovery task on the TE network, use the following steps:

Step 1 Navigate Monitoring > Task Manager. The window in Figure 3-1 appears.

Figure 3-1 Tasks

Step 2 Create a new task by clicking Create. The window in Figure 3-2 appears.
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Figure 3-2 Create TE Discovery Task (Step 1)

Step 3 Select TE Discovery in the Type pull-down menu and click Next. The Select TE Provider window in 
Figure 3-3 appears.

Figure 3-3 Select TE Provider

Step 4 Select a TE provider and click Next. The Select Seed Device window in Figure 3-4 appears.
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Figure 3-4 Select Seed Device

Step 5 Select the seed device for discovery of the network and click Next. The Task Schedules window in 
Figure 3-5 appears.

Figure 3-5 TE Discovery Task Schedules Window Before Scheduling

Step 6 Click Now to schedule the task to run immediately or click Create to create a scheduler for this task. 
The Task Schedule window in Figure 3-6 appears. 
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Figure 3-6 Task Schedule

Step 7 In the Task Schedule window, make your selections to define when and how often the task should be run.

Note The default setting is to schedule a single TE Discovery task to take place immediately (“Now”).

Step 8 Click OK. The scheduled task should now appear in the Task Schedules table as shown in Figure 3-7. 

Figure 3-7 TE Discovery Task Schedules Window After Scheduling

Step 9 Click Next. A summary of the scheduled task in Figure 3-8 appears. 
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Figure 3-8 Discovery Task Summary

Step 10 Click Finish. This will add the task to the list of created tasks in the Tasks window (Figure 3-1).

Verifying a TE Discovery Task
The result of running the TE Discovery task can be assessed in three ways:

• Task Logs—View a summary log of any changes that have occured in the network.

• TE Topology—Display the latest TE Topology from the repository.

• View network element types—In the Traffic Engineering Management GUI, go to TE Nodes, TE 
Links, TE Primary Tunnels, and so on to verify the state of specific network element types.

Task Logs
The TE Discovery log captures the state of the network and compares it with the most recent snapshot 
of the repository.

To view the task log for a TE Discovery task, use the following steps:

Step 1 Navigate Monitoring > Task Manager.

Step 2 Select Logs in the table of contents on the left side of the Tasks window. The Task Runtime Actions 
window in Figure 3-9 appears.
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Figure 3-9 Task Runtime Actions

For an explanation of the various window elements, see Task Runtime Actions, page A-67.

The status of the tasks are shown in the displayed table. This updates automatically and indicates when 
the discovery process is complete.

If the task is not completed and Auto Refresh is selected, the table continues to update periodically until 
it is completed.

Step 3 Click the desired task in the Runtime Task Name field. The Runtime Actions window in Figure 3-10 
appears. 

Figure 3-10 Runtime Actions

For an explanation of the various window elements, see Runtime Actions, page A-67.

The Runtime Actions window shows the actions created for the selected task.

Step 4 To view the log for a particular task, click the log name in the Action column. A copy of a TE Discovery 
log is shown in the following screenshots, starting with Figure 3-11. 

Note To find the summary of changes in the network depicted in the following screenshots, scroll to 
the bottom of the log .
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Figure 3-11 TE Discovery Task Log - Devices/Interfaces

Figure 3-12 TE Discovery Task Log - Links

Figure 3-13 TE Discovery Task Log - Explicit Paths
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Figure 3-14 TE Discovery Task Log - Primary Tunnels

Figure 3-15 TE Discovery Task Log - Backup Tunnels

Figure 3-16 TE Discovery Task Log - Static Routes
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The TE Discovery task log window is organized into sections that each describes particular events in the 
TE network:

• either the state of the network as recorded in the repository the first time a TE Discovery task is run

• or changes in the network since the last time the TE Discovery task was run (repository delta).

The summary of changes in the network is reported in six steps:

1. Devices/Interfaces (Figure 3-11)

2. Links (Figure 3-12)

3. Explicit paths (Figure 3-13)

4. Primary tunnels (Figure 3-14)

5. Backup tunnels (Figure 3-15)

6. Static routes (Figure 3-16).

As seen in the figures, in each step a log table reports the changes in the following reporting categories:

• ADD—This section lists any new network elements that have been added to the repository since the 
last TE Discovery task was run.

• SKIP—This section lists any network elements that remain unchanged since the previous run of the 
TE Discovery task.

• MISSING—This section lists any network elements that are missing when compared with the 
repository.

• MISMATCH—This section lists any network elements, for which certain attributes have changed 
since the previous run of the TE Discovery task. The repository is not automatically modified. Any 
modifications must be performed manually.

• MODIFY—This section lists any network elements that have been modified since the previous run 
of the TE Discovery task. The repository has been modified to reflect the changes.

Step 5 Click Return to Logs to quit the current log with the option to open another log.

TE Topology
The TE Topology tool provides a visual snapshot of the current state of the network. It cannot be used 
to determine changes that have taken place in the network.

The steps required to generate a topology graph of the network are described in Chapter 4, “TE Resource 
Management.”

View Network Element Types
Another way to check the state of the network after running TE discovery is to go to the Traffic 
Engineering Management Services window and select the type of elements you want to verify.

For example, to check the status of the nodes after running TE discovery, navigate Service Inventory > 
Inventory and Connection Manager > Traffic Engineering Management > TE Nodes. Look at the 
updated list of TE nodes to assess which nodes are in the network.

Do the same for TE Links, TE Primary Tunnels, TE Backup Tunnels, and so on.
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TE Resource Management

TE resource management is defined as the tuning of certain properties on the TE interfaces to optimize 
the tunnel placement. 

This chapter includes the following sections:

• Overview, page 4-1

• Modifying Network Resources, page 4-2

• Change Link Status, page 4-6

Overview
When a tunnel placement is attempted and there is insufficient bandwidth, sometimes the resources on 
the TE links can be changed and the tunnel placement retried.  

Network resources in this context are understood to be routers in the TE network, the interfaces that 
connect them, and the RSVP bandwidths and other properties configured on the links.  Since ISC TEM 
relies on the discovery process to add the network elements to the repository, the resources must be 
discovered before resource management can be performed. 

TE resource management is a manual process that should be performed on an as needed basis. If the 
original configuration is already optimal, there is no need for the user to do any resource management 
tasks.  If  subsequent discovery unveils any discrepancy, or if you experience difficulty achieving desired 
results in protection planning or placing primary tunnels, adjustments on the resources may be 
warranted.

An overview of the resource management process is provided in Figure 4-1.
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Figure 4-1 Resource Management Processes

Modifying Network Resources
The resource management tasks are first of all carried out from the TE Links List window.

To modify a TE link, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > Assign TE Resources.

The TE Links List window shown in Figure 4-2 appears.

TEM Services
Cancel

TE Links List

TE Resource
Modification

Modification
Confirmation

Reports

Computation
in Progress

Reports

Save &
Deploy

11
66

23

Assign TE Resources

Cancel

Cancel

Cancel

Edit
SR

Back

Back

<<Edit

Repair

Edit
Interface

Continue

Audit

Moveable
Tunnel SelectionAbort

(Audit)

Computation Results
Changes

Detail

Service Requests

Proceed

Abort
(Repair)
4-2
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



Chapter 4      TE Resource Management
Modifying Network Resources
Figure 4-2 TE Links List

For an explanation of the various window elements, see TE Links, page A-21.

The links list shows the current active links in the TE network. Use the arrows to page forward as needed.

Step 2 Select the desired link in the links list.

Step 3 Click Edit > Interface A or Edit > Interface B to edit one of interfaces on the link.

Step 4 The TE Resource Modification window appears as shown in Figure 4-3.
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Figure 4-3 TE Resource Modification 

For an explanation of the various fields, see TE Links, page A-21.

Step 5 Make the desired modifications and click Continue >> to proceed to the confirmation page as shown in 
Figure 4-4 to verify the changes or click Cancel to quit without saving.
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Figure 4-4 TE Resource Modification (Confirmation Page)

Step 6 Click << Edit to return to the editable window or proceed in one of the following ways:

• Proceed with Changes >> (Figure 4-5)—If any change was made that impacts tunnel placement, 
click Proceed with Changes >> to perform a Tunnel Audit or Tunnel Repair.

For a detailed explanation of Tunnel Audit and Tunnel Repair, see Chapter 6, “Advanced Primary 
Tunnel Management.”

• Save & Deploy (Figure 4-6)—If the changes made do not affect tunnel placement, click Save & 
Deploy to proceed. In this case, there is no need for performing a Tunnel Audit or a Tunnel Repair.

Figure 4-5 TE Links List - Proceed with Changes
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Figure 4-6 Save & Deploy Tunnels

For an explanation of the options available under Proceed with Changes >> and Save & Deploy, see 
Edit Interface, page A-26

Note In ISC TEM, service requests (SRs) are generally deployed from each TE service, not from the 
Service Requests page in Inventory and Connection Manager.

After deployment, the SR status can be viewed from the SR window at Service Inventory > 
Inventory and Connection Manager > Service Requests.

If the SR does not go to the Deployed state, go to the Task Log to see the deployment log 
(Monitoring > Task Manager > Logs). Task logs are further described in TE Task Logs, page 10-1.

Change Link Status
From the TE Links List window (Figure 4-2), you can also find out what effect it will have if a link is 
taken offline. This approach can be used to move tunnels off a link before actually shutting down the 
interface.

Note Link status in ISC TEM is of local significance. Changing link status as described in this section is not 
provisioned down to the network.

To change the link status, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > Assign TE Resources.

The TE Links List window appears.

Step 2 Select one or more links and click the Change Status button as shown in Figure 4-7.
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Figure 4-7 Change Link Status

For an explanation of the various window elements, see TE Links, page A-21.

Step 3 Select Enable or Disable to enable or disable the selected link.

Step 4 As an example, selecting Disable will change the link status to DOWN as shown in Figure 4-8.

Figure 4-8 Link Status Down

Similarly, use Enable to change the status back to UP.

Step 5 Click Proceed with Changes >> to assess any impact on tunnel placement using Tunnel Audit or Tunnel 
Repair and deploy the changes (see Figure 4-9).

Figure 4-9 TE Links List - Proceed with Changes

For a detailed explanation of Tunnel Audit and Tunnel Repair, see Chapter 6, “Advanced Primary Tunnel 
Management.”.
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Basic Tunnel Management

This chapter describes the processes involved in creating primary and backup tunnels with ISC TEM. To 
create a tunnel, certain steps must first be performed as described in previous chapters.

Primary tunnels are characterized by carrying traffic during normal operation.  They have a prioritized 
list of possible paths, by which traffic can be routed.  At any one time, the highest priority path available 
will be used to route traffic.  If this fails, traffic will normally be re-routed via the next available path 
until a higher priority path becomes available again. 

Prior to setting up the tunnel, a TE policy governing the traffic must be defined. An explicit path is 
created to establish the route and, in the case of a primary tunnel, it is created as either a managed or an 
unmanaged tunnel.

The purpose of a backup tunnel is to carry FRR protected traffic around a failed element until the routing 
in the network has reconverged.  It is intended to protect traffic travelling along primary tunnels.  There 
can be many backup tunnels protecting the same traffic through the use of load balancing.

If the network fails to reconverge, the backup tunnel will remain in place.

The difference between managed and unmanaged tunnels is described in Managed/Unmanaged Primary 
Tunnels, page 1-3.

The concept of bandwidth pools from which tunnels reserve bandwidth is important to understand. This 
is described in Bandwidth Pools, page 1-4.

This chapter contains the following sections:

• Create TE Policy, page 5-2

• Create Explicit Path, page 5-3

• Primary Tunnel Operations, page 5-7

– Create Primary Tunnel, page 5-7

– Edit Primary Tunnel, page 5-14

– Delete Primary Tunnel, page 5-17

• Backup Tunnel Operations, page 5-18

– Create Backup Tunnel, page 5-18

– Edit Backup Tunnel, page 5-22

– Delete Backup Tunnel, page 5-24
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Create TE Policy
To create a primary tunnel, each primary tunnel must be associated with a policy. A policy can be used 
by multiple tunnels.

For backup tunnels, this step is not necessary. In this case, proceed to Create Explicit Path, page 5-3.

For other TE policy management operations, see TE Policies, page 9-2.

The TE policy is a set of rules governing the TE network and defines the Class-of-Service (for example, 
gold, silver, bronze) for primary tunnel traffic.

ISC TEM has a notion of Managed and Unmanaged policies. Managed policies have setup/hold 
priorities of 0/0 and can have additional pathing constraints such as protection level and max delay. 
Tunnels with Unmanaged policies are provisioned by the system, but the system only tracks the 
deployment, not the operation of the tunnel. Unmanaged policies cannot have a setup/hold priority of 
zero.

Policies are managed under Policy Manager in Service Design. For a more detailed explanation of the 
Policy Manager GUI, see TE Policies, page 9-2.

To create a TE policy, use the following steps:

Step 1 Navigate to Service Design > Policy Manager.

Step 2 Click the Policy Manager icon.

The Policies window in Figure 5-1 appears.

Figure 5-1 Policies Window

Step 3 Click Create and select TE Policy to set up a new TE policy. 

To edit an existing policy, select the policy that you want to modify and click Edit. The TE Policy Editor 
window in Figure 5-2 appears.

Note A policy that is being used by a tunnel cannot be modified. You can use Edit to view the path.
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Figure 5-2 TE Policy Editor

For an explanation of the various window elements, see TE Policies, page 9-2.

Step 4 Fill in the required fields marked with an asterisk (*) and any optional fields. 

If you intend to use the TE policy for managed tunnels, make sure to check the Managed check box. 
When setting up a policy for a managed tunnel, the Setup and Hold priorities are automatically set to 
zero (highest priority). In the case of a policy for an unmanaged tunnel, you can specify the desired 
Setup and Hold priority settings.

Step 5 Click Save. 

Create Explicit Path
This section describes how to create a TE explicit path. For other TE explicit path operations, see TE 
Explicit Paths, page A-32.

Paths are defined between source and destination routers, possibly with one or more hops in between. 
Paths are used for primary and backup tunnels in the explicit path option(s).

If you intend to create an explicit path for managed tunnels, the path should not contain any non-TE 
interfaces. Paths with non-TE interfaces will be filtered out by the tunnel path chooser of the tunnel 
editor for managed tunnels and backup tunnels (not unmanaged tunnels).

To create or edit an explicit path, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click TE Explicit Paths. The TE Explicit Path List window appears. (see Figure 5-3)
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Figure 5-3 TE Explicit Path List

For an explanation of the various window elements, see Create/Edit Explicit Path, page A-33.

Step 3 To create an explicit path in the TE Explicit Path List, click Create. The New TE Explicit Path window 
in Figure 5-4 appears.

To edit an explicit path in the explicit path list, select the explicit path that you want to modify and click 
Edit. The TE Explicit Path Editor window in Figure 5-5 appears.

Note An explicit path that is being used by a tunnel cannot be modified. However, use Edit to view 
the path.
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Figure 5-4 New TE Explicit Path

Figure 5-5 TE Explicit Path Editor

For an explanation of the various window elements, see Create/Edit Explicit Path, page A-33 and Edit 
TE SR (Primary or Backup), page A-51.
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Note If a path is used by any tunnel, no modifications are possible. The Outgoing Interface and 
Incoming Interface links are not selectable and the Provision Preference line as well as the Add 
Link, Delete Link, and Save buttons disappear.

Step 4 Specify a pathname and select a head router.

Step 5 Click Add Link. A blank line is added to the hop list table.

Step 6 Now an outgoing or an incoming interface must be selected for the head router. Under Outgoing 
Interface, click Add Link. The Select Next Hop window in Figure 5-6 appears.

Figure 5-6 Select Next Hop

The next hop list contains all the possible next hops of the router (pop1-dus, for example), excluding 
the ones already included in the explicit paths (to avoid path loops).

The next hop list contains TE interfaces and one non-TE interface for each router. For TE interfaces, the 
Outgoing Interface and Outgoing IP columns are populated by the application.

Note If a non-TE interface is selected, Provision Preference (Figure 5-4) is set to Incoming 
Interface. The provision preference cannot be set manually.

Step 7 Select an interface and click Select. The corresponding link information is added to the new explicit path 
in the Links table as shown in Figure 5-7.

The incoming interface field is automatically populated.
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Figure 5-7 New Link for TE Explicit Path

Step 8 To add another link, click Add Link again.

Step 9 To modify an existing link, click the link in the Outgoing Interface or the Incoming Interface columns, 
make the desired changes, and click Select.

Step 10 Optionally, select Provision Preference by clicking either the Outgoing Interface or the Incoming 
Interface radio button.

Note If you try to select the Provision Preference before adding a link when non-TE interfaces are 
present, the Add Link process overrides the Provision Preference and sets it to incoming.

Step 11 Click Save to keep the created TE explicit path or click Cancel to quit without saving. 

Primary Tunnel Operations
ISC TEM allows you to perform a number of primary tunnel operations, which are described in the 
following.

Create Primary Tunnel
After a TE Policy and an explicit path have been set up, a primary tunnel can be created. There are two 
types of primary tunnels:

• Managed Primary Tunnels

• Unmanaged Primary Tunnels
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Below, the GUI flow is described for creating unmanaged primary tunnels. It is very similar for managed 
primary tunnels and the few differences that exist are described in Managed/Unmanaged Primary 
Tunnels, page 1-3 and Create Unmanaged TE Tunnel, page A-58.

To create a managed or an unmanaged primary tunnel, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears .

or

Click Create Unmanaged TE Tunnel. The TE Unmanaged Primary Tunnels SR window in Figure 5-8 
appears.

In this example, we will create an unmanaged tunnel.

Figure 5-8 TE Unmanaged Primary Tunnels SR

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39 (same 
for managed and unmanaged).

Step 3 Click Create. The Create TE Unmanaged Primary Tunnel window in Figure 5-9 appears.
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Figure 5-9 Create TE Unmanaged Primary Tunnel

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39 and 
Create Unmanaged TE Tunnel, page A-58.

Step 4 To select a Head Device in the Create TE Unmanaged Primary Tunnel window, click the corresponding 
Select button to open the Select Device for TE Head Router window shown in Figure 5-10.
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Figure 5-10 Select Device for TE Head Router

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39 and 
Create Unmanaged TE Tunnel, page A-58.

Step 5 Select a head device and click Select. The Select Device for TE Head Router window closes and the 
prompt returns to the Create TE Unmanaged Primary Tunnel window.

Step 6 To select a Destination Device in the Create TE Unmanaged Primary Tunnel window, click the 
corresponding Select button to open the Select Device for TE Tail Router window shown in Figure 5-11.
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Figure 5-11 Select Device for TE Tail Router

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39 and 
Create Unmanaged TE Tunnel, page A-58.

Step 7 Select a destination device and click Select. The Select Device for TE Tail Router window closes and 
the prompt returns to the Create TE Unmanaged Primary Tunnel window.

Step 8 To select a Tunnel Policy in the Create TE Unmanaged Primary Tunnel window, click the corresponding 
Select button to open the Select Unmanaged TE Tunnel Policy window shown in Figure 5-12.

Note To create a managed tunnel, make sure that one or more managed tunnel policies are available. If that is 
not the case, go to Policy Manager (see Create TE Policy, page 5-2) and make sure to check the 
Managed check box. 

Figure 5-12 Select Unmanaged TE Tunnel Policy
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For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39 and 
Create Unmanaged TE Tunnel, page A-58.

Step 9 Select a policy and click the Select button. This brings you back to the tunnel editor.

Step 10 Click Add to set up path options for the tunnel. The Select TE Explicit Path window in Figure 5-13 
appears.

The Path Options section provides two path types, Explicit Path and Dynamic Path.

An Explicit Path is a fixed path from a specific head to a specific destination device. 

A Dynamic Path is provisioned by allowing the head router to find a path. The dynamic keyword is 
provisioned to the routers.

Figure 5-13 Select TE Explicit Path

For unmanaged tunnels, paths can be either explicit or dynamic.

Step 11 Select the desired TE Explicit Path unless you prefer dynamic path only. If none is available, you can set 
one up first. To do so, see Create Explicit Path, page 5-3. 

Click Select. 

The selected path appears in the Path Options section of the create window as shown in Figure 5-14.

Figure 5-14 Path Options

For explicit paths (<head_device>-><destination_device>), you can click the pathname to open the 
non-editable Explicit Path Viewer as shown in Figure 5-15.
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Figure 5-15 TE Explicit Path Viewer

For an explanation of the various window elements, see Create/Edit Explicit Path, page A-33.

Step 12 In the Create TE Unmanaged Tunnel window, click OK to accept the entered tunnel information or click 
Cancel to quit and return to the TE Unmanaged Primary Tunnels SR window. 

Step 13 In the TE Unmanaged Primary Tunnel SR window, the Op field changes to ADD.

Note The added tunnel can be reverted to its original state by selecting it and clicking Delete. The 
ADD flag in the Op column disappears.

Step 14 In the TE Unmanaged Primary Tunnel window, click Save & Deploy (see Note) to either deploy the new 
tunnel SR to the network or force deploy all tunnels, or you can create or edit more primary tunnels and 
then save and deploy all changes.

For a further description of save and deploy options, see Create Managed TE Tunnel, page A-39.

Note For managed tunnels, there is a Proceed with Changes >> button that is used to continue with Save & 
Deploy (see Chapter 6, “Advanced Primary Tunnel Management”).

Note With the exception of TE Traffic Admission SRs, TE SRs are always deployed immediately from the 
specific TE SR window, not from the Service Requests page in Inventory and Connection Manager.

Step 15 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) appears (see Figure 5-16) and displays the state of the deployed SR.
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Figure 5-16 Service Requests - Unmanaged Tunnels

If the SR does not go to the Deployed state, go to the Task Logs window to see the deployment log 
(Monitoring > Task Manager > Logs) as described in SR Deployment Logs, page 10-1.

To edit the service request from the Service Requests window, go back to the TE Managed Primary 
Tunnels SR or the TE Unmanaged Primary Tunnels SR window as described in Edit Primary Tunnel, 
page 5-14.

Edit Primary Tunnel
Primary tunnel attributes can be modified in the primary tunnel editor

There are two ways to access the primary tunnel editor: 

• from the managed or unmanaged primary tunnels SR window or

• from the Service Requests window.

Access from Primary Tunnel SR Window

To access the primary tunnel editor from the primary tunnel SR window (TE Managed Primary Tunnels 
SR or TE Unmanaged Primary Tunnels SR window) and edit a managed or an unmanaged primary 
tunnel, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.
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Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears .

or

Click Create Unmanaged TE Tunnel. The TE Unmanaged Primary Tunnels SR window in Figure 5-8 
appears.

Step 3 To edit a tunnel SR, select the desired SR and click Edit. The Edit TE Managed Primary Tunnel or the 
Edit TE Unmanaged Primary Tunnel window in Figure 5-17 appears.

Figure 5-17 Edit TE Unmanaged Primary Tunnel

The primary tunnel editor is identical to that of the create primary tunnel GUI. For an explanation of the 
various window elements, see Create Managed TE Tunnel, page A-39 and Create Unmanaged TE 
Tunnel, page A-58.

Step 4 Make the desired changes and click OK or Cancel to discard the changes. 
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Step 5 In the TE Unmanaged Primary Tunnel SR window, the Op field changes to MODIFY.

Note The modified tunnel can be reverted to its original state by selecting it and clicking Delete. The 
MODIFY flag in the Op column disappears.

Click Save & Deploy (see Note) to either deploy the new tunnel SR to the network or force deploy all 
tunnels, or you can create or edit more primary tunnels and then save and deploy all changes.

Step 6 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) appears (see Figure 5-16) and displays the state of the deployed SR.

Access from Service Requests Window

To access the primary tunnel editor from the Service Requests window, assuming that the SR has been 
created, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Service Requests.

Step 2 To edit the desired tunnel SR, select the SR in question and click Edit. The TE Primary Tunnel Type 
Selection window in Figure 5-18 appears.

Figure 5-18 TE Primary Tunnel Type Selection

Step 3 Specify the type of tunnel, managed or unmanaged. The TE Managed Primary Tunnel SR or the TE 
Unmanaged Primary Tunnel SR window appears displaying the SR selected in the Service Requests 
window. An example of the TE Unmanaged Primary Tunnel SR window is shown in Figure 5-8.

Step 4 Select the tunnel SR and click Edit. The Edit TE Unmanaged Primary Tunnel window in Figure 5-17 
appears.

Go to Access from Primary Tunnel SR Window, page 5-14 and continue the process from Step 4.
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Delete Primary Tunnel
To delete a managed or an unmanaged primary tunnel from the primary tunnel SR window (TE Managed 
Primary Tunnels SR or TE Unmanaged Primary Tunnels SR window), use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears .

or

Click Create Unmanaged TE Tunnel. The TE Unmanaged Primary Tunnels SR window in Figure 5-8 
appears.

Step 3 To delete a tunnel, select the desired tunnel(s) and click Delete. The Op field status changes to DELETE 
as shown in Figure 5-19.

Figure 5-19 TE Unmanaged Primary Tunnels SR - Delete Requested

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39 and 
Create Unmanaged TE Tunnel, page A-58.

Note The deleted tunnel can be reverted to its original state by selecting it and clicking Delete. The 
DELETE flag in the Op column disappears.

Click Save & Deploy to either deploy the new tunnel SR to the network or force deploy all tunnels, or 
you can create or edit more primary tunnels and then save and deploy all changes.

Step 4 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) appears (see Figure 5-16) and displays the state of the deployed SR.
5-17
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



Chapter 5      Basic Tunnel Management
Backup Tunnel Operations
Backup Tunnel Operations
ISC TEM allows you to perform a number of backup tunnel operations, which are described in the 
following.

Create Backup Tunnel
Backup tunnels are created in much the same way as primary tunnels. In both cases, building an explicit 
path is not required when an existing path already traverses the desired routers. A path can be used for 
any number of tunnels within its bandwidth capacity.

A precondition for creating a backup tunnel is the presence of an explicit path. To create an explicit path, 
see Create Explicit Path, page 5-3.

To create a backup tunnel, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click Create TE Backup Tunnel. The TE Protection SR window in Figure 5-20 appears.
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Figure 5-20 TE Protection SR

For an explanation of the various window elements, see Create TE Backup Tunnel, page A-58.

Step 3 Click Create. The Create TE Backup Tunnel window in Figure 5-21 appears.
5-19
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



Chapter 5      Basic Tunnel Management
Backup Tunnel Operations
Figure 5-21 Create TE Backup Tunnel

For an explanation of the various window elements, see Create TE Backup Tunnel, page A-58.

Step 4 Select, at a minimum, a Head Device, a Destination Device, and a Protected Interface. Also, specify 
a Backup Bandwidth Limit greater than zero. Add other tunnel information as desired.
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Figure 5-22 Select TE Protected Interface

For an explanation of the various window elements, see Select TE Protected Interface, page A-63.

Step 5 Click Add to add just one path. The Select TE Explicit Path window in Figure 5-23 appears.

Figure 5-23 Select TE Explicit Path 

Step 6 Select an explicit path. It must match the head and destination of an existing path. If none is available, 
you first must set one up. To do so, see Create Explicit Path, page 5-3. 

Step 7 Click Select. The selected path appears in the Path Options section of the page as shown in the Select 
TE Explicit Path window in Figure 5-24.

Figure 5-24 Path Options

For explicit paths, you can click the pathname to open the Explicit Path Viewer as shown in Figure 5-15.

Step 8 In the Create TE Backup Tunnel window, click OK to accept the entered tunnel information or click 
Cancel to quit the window without saving it. The window closes.

Step 9 In the TE Protection SR window, the Op field changes to ADD.

Note The added tunnel can be reverted to its original state by selecting it and clicking Delete. The 
ADD flag in the Op column disappears.
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Step 10 Click Save & Deploy to either deploy the new tunnel SR to the network or force deploy all tunnels, or 
you can create or edit more backup tunnels and then save and deploy all changes.

Figure 5-25 Save & Deploy Tunnels

The Save & Deploy button provides two options:

– SR Tunnels Only—Deploy all tunnel changes that does not impact tunnel placement, or if no 
changes were made to the SR, use this to re-deploy the SR that was in Requested or Invalid 
state.

– Force Deploy All Tunnels—Force deployment of all tunnels in this SR. This could be useful 
when previous provisioning of the SR has failed, so that it is necessary to force through the 
deployment of all tunnels in the SR.

Note With the exception of TE Traffic Admission SRs, TE SRs are always deployed immediately from the 
specific TE SR window, not from the Service Requests page in Inventory and Connection Manager.

Step 11 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) appears and displays the state of the deployed SR.

If the SR does not go to the Deployed state, go to the Task Logs window to see the deployment log 
(Monitoring > Task Manager > Logs) as described in SR Deployment Logs, page 10-1.

Edit Backup Tunnel
Backup tunnel attributes can be modified in the backup tunnel editor

There are two ways to access the backup tunnel editor: 

• from the Protection SR window or

• from the Service Requests window.

From the Protection SR Window

To access the Protection SR window to edit a backup tunnel, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > Create TE Backup Tunnel. The TE Protection SR window appears.

Step 2 To edit a tunnel SR, select the desired SR and click Edit. The Edit TE Backup Tunnel window in 
Figure 5-26 appears.
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Figure 5-26 Edit TE Backup Tunnel

The backup tunnel editor is identical to that of the create backup tunnel GUI. For an explanation of the 
various window elements, see Create TE Backup Tunnel, page A-58.

Step 3 Make the desired changes and click OK.

Step 4 In the TE Protection window, the Op field changes to MODIFY.

Note The modified tunnel can be reverted to its original state by selecting it and clicking Delete. The 
MODIFY flag in the Op column disappears.

Step 5 In the TE Protection SR window, click Save & Deploy to either deploy the new tunnel SR to the network 
or force deploy all tunnels, or you can create or edit more backup tunnels and then save and deploy all 
changes.

The Save & Deploy button options are discussed in Create Managed TE Tunnel, page A-39.
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Step 6 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) appears (see Figure 5-16) and displays the state of the deployed SR.

From the Service Requests Window

To edit a backup tunnel from the Service Requests window, assuming that the SR has been created use 
the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Service Requests.

Step 2 To edit the desired tunnel SR, select the SR in question and click Edit. The TE Protection SR window 
appears displaying the SR selected in the Service Requests window. An example of the TE Protection 
SR window is shown in Figure 5-20.

Step 3 Select the tunnel SR and click Edit. The Edit TE Backup Tunnel window in Figure 5-26 appears.

Go to From the Protection SR Window, page 5-22 and continue the process from Step 3.

Delete Backup Tunnel
To delete a backup tunnel from the TE Protection SR window, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > Create TE Backup Tunnel.

The TE Protection SR window in Figure 5-20 appears.

Step 2 To delete a tunnel SR, select the desired SR and click Delete. The Op field status changes to DELETE 
as shown in Figure 5-27.
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Figure 5-27 TE Protection SR - Delete Requested

For an explanation of the various window elements, see Create TE Backup Tunnel, page A-58.

Note The deleted tunnel can be reverted to its original state by selecting it and clicking Delete. The 
DELETE flag in the Op column disappears.

Click Save & Deploy to either deploy the new tunnel SR to the network or force deploy all tunnels, or 
you can create or edit more primary tunnels and then save and deploy all changes.

Step 3 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) appears (see Figure 5-16) and displays the state of the deployed SR.
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Advanced Primary Tunnel Management

In addition to the basic tunnel management tools described in Chapter 5, “Basic Tunnel Management”, 
ISC TEM gives access to a set of advanced tunnel planning tools that provide optimal placement of 
tunnels to ensure efficient use of network resources. 

The advanced primary tunnel management tools are available for managed tunnels. The difference 
between managed and unmanaged tunnels is described in the “Managed/Unmanaged Primary Tunnels” 
section on page 1-3.

This chapter contains the following sections:

• Tunnel Operations, page 6-1

– Create Primary Tunnel, page 6-2

– Edit Primary Tunnel, page 6-7

– Delete Primary Tunnel, page 6-7

– Admit Primary Tunnel, page 6-8

– Import Primary Tunnel, page 6-8

• Planning Strategy, page 6-10

• Placement Tools, page 6-11

– Tunnel Audit, page 6-12

– Tunnel Placement, page 6-16

– Tunnel Repair, page 6-21

– Grooming, page 6-25

Tunnel Operations
This section explains the advanced tunnel operations in ISC TEM that incorporate the planning tools. 

An overview of the primary tunnel management process is provided in Figure 6-1.
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Figure 6-1 Primary Tunnel Management Processes

For Tunnel Type Selection, when you select Unmanaged the TE Unmanaged Primary Tunnel SR 
window appears (see Chapter 5, “Basic Tunnel Management”).

All other elements in Figure 6-1 are described in this chapter.

Create Primary Tunnel
To create a TE managed primary tunnel with the RG license installed, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears as shown in 
Figure 6-2.
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Figure 6-2 TE Managed Primary Tunnels SR

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39.

Step 3 Click Create. The Create TE Managed Primary Tunnel window appears as shown in Figure 6-3.
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Figure 6-3 Create TE Managed Primary Tunnel

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39.

The Path Options section provides three path types, System Path, Explicit Path, and Dynamic Path.

A System Path is an ISC system generated explicit path (immovable). The first path has to be an explicit 
path. 

An Explicit Path is a fixed path from a specific head to a specific destination device. 

A Dynamic Path is provisioned by allowing the head router to find a path. The dynamic keyword is 
provisioned to the routers.

Step 4 To select a Head Device, click the corresponding Select button to open the window shown in Figure 6-4.
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Figure 6-4 Select Device for TE Head Router

For an explanation of the various window elements, see Create TE Managed Primary Tunnel SR, page 
A-43.

Select a head device and click Select. 

Step 5 To select a Destination Device, click the corresponding Select button to open the window shown in 
Figure 6-5.
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Figure 6-5 Select Device for TE Tail Router

For an explanation of the various window elements, see Create TE Managed Primary Tunnel SR, page 
A-43.

Select a tail device and click Select. 

Step 6 To select a Tunnel Policy, click the corresponding Select button to open the window shown in 
Figure 6-6.

Note If no tunnel policies are available, the reason could be that they are all unmanaged. To create a managed 
tunnel, use the Policy Manager (see Create Primary Tunnel, page 6-2) and make sure to check the 
Managed check box.

Figure 6-6 Select Managed TE Tunnel Policy

For an explanation of the various window elements, see Create TE Managed Primary Tunnel SR, page 
A-43.
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Step 7 Specify a tunnel bandwidth greater than zero. Add other tunnel information as desired.

Step 8 Optionally, if you want to specify an explicit path rather than using the system path provided by ISC 
TEM, delete the system path and subsequently add the explicit path. For a more detailed explanation of 
this step, see Create Primary Tunnel, page 5-7.

Step 9 In the Create TE Managed Tunnel window, click OK to accept the entered tunnel information or Cancel 
to quit and return to the TE Managed Primary Tunnels SR window.

In the TE Managed Primary Tunnel SR window, the Op field changes to ADD to signify that an SR has 
been added.

Note The added tunnel can be reverted to its original state by selecting it and clicking Delete. The 
ADD flag in the Op column disappears.

Step 10 In the TE Managed Primary Tunnel SR window, you can create or edit more tunnels, or if you are done 
with all the changes, proceed in one of the following two ways depending on which of the following 
buttons are active:

• Proceed with Changes: The changes you entered impacts tunnel placement. Click on this to 
continue with one of the planning flows described in the Placement Tools (see Placement Tools, 
page 6-11) until the SR is save and deployed.

• Save & Deploy: The changes you entered does not impact tunnel placement. Click on this to save 
and deploy the SR. This function is further described in Create Managed TE Tunnel, page A-39.

Note With the exception of TE Traffic Admission SRs, TE SRs are always deployed immediately from the 
specific TE SR screen, not from the Service Requests page in Inventory and Connection Manager.

Step 11 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) opens and displays the state of the deployed SR.

If the SR does not go to the Deployed state, go to the Task Logs window to see the deployment log 
(Monitoring > Task Manager > Logs) as described in Task Monitoring, page 10-1.

Edit Primary Tunnel
The only difference between creating and editing tunnels is that in the tunnel editor, the head and 
destination devices and tunnel number fields are not editable. Otherwise, you create and edit the same 
attributes.

To edit a primary tunnel, see Chapter 5, “Basic Tunnel Management.”

Delete Primary Tunnel
To delete one or more tunnels, see Chapter 5, “Basic Tunnel Management.”.
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Admit Primary Tunnel
The Admit function is used to admit selected tunnels not previously verified into the managed topology. 
This feature is used only for discovered tunnels that failed verification.

To admit a primary tunnel, use the following steps:

Step 1 In the TE Managed Primary Tunnel SR, select one or more unverified tunnels to migrate.

Step 2 Click Admit. The unverified tunnel(s) are verified and, if sucessful, and ADMITflag will appear in the 
Op column.

Step 3 Select Proceed with Changes >> > Tunnel Placement to determine if the tunnels can be placed. If not, 
edit the tunnels and try again.

Import Primary Tunnel
This feature allows you to update tunnels in bulk through a file-based import mechanism. The data is 
migrated into the managed primary tunnel service request.

Construct XML Import File

To import tunnels from a file, first construct an XML import file conforming to the structure defined in 
the system supplied Document Type Definition (DTD) file (see Appendix C, “Document Type Definition 
(DTD) File”), and save the XML file together with the DTD file on the ISC server under the same 
directory.  To create a valid import file, use the provided command line validation tool (see Command 
Line Validation Tool, page 6-8).

The following files are necessary for importing data into the ISC TEM application and are included in 
the installation:

• DTD and sample XML file for the import file in 
< installedDir >/ resources/java/xml/com/cisco/vpnsc/ui/te

– TeImport.dtd

– sample.xml

• Shell script for executing the command line validator in the <installedDir>/bin directory.

– ImportTeTunnels

Usage: importTeTunnels <importfile>

importfile is a XML file and must specify TeImport.dtd as its DTD. TeImport.dtd must be in the same 
directory as importfile.

Command Line Validation Tool

The purpose of a command line validator is to help construct a valid import file off-line that corresponds 
to TeImport.dtd.  The tool helps screen out errors associated with files that are not well-formed and files 
that do not conform to the rules set by the DTD. 

For instructions on how to use the DTD file, see the DTD file documentation.
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The tool reads the import file line-by-line, echoes each line in on the output as it parses, and reports any 
parsing error it encounters. The parsing and validation continues even when parsing errors are 
encountered for as long as the file structure makes sense.

Note This tool does not check for cross field validation or data integrity errors with respect to the ISC TEM 
application.

Import Procedure

The file-based import feature is only enabled when there are no uncommitted new, changed, or deleted 
tunnels in the service request.

It provides a way of adding, editing, deleting, or migrating many tunnels at a time.

To start the import procedure, use the following steps:

Step 1 Prepare the XML import file in accordance with the DTD file.

Step 2 Go to Service Inventory > Inventory and Connection Manager > Traffic Engineering Management.

Step 3 Select provider if this has not been done earlier in the session.

Step 4 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears as shown in 
Figure 6-2.

Step 5 Click Import to start the import process. The Select Import File window in Figure 6-7 appears.

Note The Import button is only enabled when there are no uncommitted new, changed, or deleted 
tunnels in the service request.

Figure 6-7 Select Import File

For an explanation of the various window elements, see Import Tunnel, page A-49.

The Select Import File window lists all the XML files and any directories under the directory name 
shown in the Look in field.

The default directory shown in the Look in field in Figure 6-7 corresponds to the installation directory 
in which the DTD and sample XML files reside. 
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Step 6 Select the desired XML file to be used for the import operation.

The system then parses the file. If any error is detected, it will be reported in the Tunnel Import Error 
Status window shown in Figure 6-8. 

Figure 6-8 Tunnel Import Error Status

For an explanation of the various window elements, see Import Tunnel, page A-49.

The Tunnel Import Error Status window shows the URL of the file, its last modified timestamp, the 
import status, and any error/warning messages. 

Step 7 If the import operation failed, Cancel to return to the previous screen.  If it is partially successful, the 
Continue button is enabled, thereby providing an additional option to accept system treatment for 
errors/warnings and continue with the import operation.

Step 8 If the file is parsed successfully or you click Continue, all valid tunnels in the file are added to the 
service request and the TE Managed Primary Tunnels SR window is re-displayed in the SR view. The 
imported tunnels are displayed with the appropriate tunnel Op type.

Planning Strategy
The main objective of using the planning tools is to achieve optimal overall network utilization while 
causing minimal impact on any existing traffic on the network. 

In most cases, the following strategy can be applied:

• Attempt to admit the new traffic optimising on utilisation (Placement feature) without allowing 
existing traffic to be moved.  This offers the possibility of accommodating the new traffic without 
any changes to the existing traffic, while still optimising reserved bandwidth utilisation under the 
constraint that existing tunnels do not move.

• If this fails, attempt to admit the same new traffic minimising change to existing traffic (Repair 
feature) to see if the new traffic can be accommodated without affecting any more existing tunnels 
than necessary.  
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• If this succeeds in placing the new traffic, but the user feels that the overall reserved bandwidth 
utilisation is higher than would be preferred, consider grooming the network.

• If the Repair fails, review the parameters that control how many changes can be considered. 
Alternatively the specification to the desired traffic could be changed, or resource modifications 
could be made.

This strategy reflects the different approaches taken by the different algorithms in searching for 
solutions.  However, other combinations are possible.

Placement Tools
Planning tools for primary tunnels are available in two buttons on the TE Primary Tunnel SR screen as 
shown in Figure 6-9 and Figure 6-10 depending on  whether an change has been made to the managed 
primary tunnels.

• Proceed with Changes: Used when you have made changes (add/change/delete/admit) to the tunnels.  
Tunnel operations are described in Tunnel Operations, page 6-1. Then choose one of the placement 
tools to verify primary placement with the system and continue with deployment.  This button is also 
available in Resource Management.

• Placement Tools: Used to perform planning function on the existing network. 

– The Tunnel Audit option should be used to verify the constraint-based placement of existing 
managed primary tunnels with the existing network topology.  You can use this option to find 
out the optimality of your primary placement.  If you are requiring protection levels above "Best 
Effort" on your primary tunnels, it is also important to perform an audit after any changes have 
been made in the protection network.  If the audit results in warnings/violations, you can use 
the Tunnel Repair option help you find a solution.  

– The Groom option is used for optimizing your primary placement.  In all primary computation, 
a quality report is produced which displays the optimality and utilization of the bandwidth 
pools. You can perform a Tunnel Audit first to determine if grooming is needed on your 
network. 

They are accessed from two buttons in the TE Managed Primary Tunnels SR window as shown in 
Figure 6-9 and Figure 6-10.

Figure 6-9 Proceed with Changes Button

Figure 6-10 Placement Tools Button
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The planning tools are described in detail in the following sections.

Tunnel Audit
When any type of change is required, whether tunnel modifications or TE resource modifications, a 
Tunnel Audit is run to determine what inconsistencies the change might cause, if any. Tunnel Audit can 
also be used anytime to check the for optimality of network utilization.

The audit can be performed from the primary tunnel window or from the TE Resource Modifications 
window.

Tunnel Audit can also be invoked from the Resource Management window (see Chapter 4, “TE Resource 
Management”).

To perform an audit on the created tunnel, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears as shown in 
Figure 6-2.

Tunnel Audit can be used in two ways: 
• When one or more tunnels have been created or their attributes altered (see Create Primary Tunnel, 

page 6-2), Tunnel Audit can be activated by selecting Proceed with Changes >>. 

• When no changes have taken place, Tunnel Audit can be accessed by selecting Placement Tools.

Step 3 As an example, assume that a new primary tunnel SR has been created. The TE Managed Primary Tunnel 
SR window shown in Figure 6-11 appears.
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Figure 6-11 TE Managed Primary Tunnel SR (Audit)

For an explanation of the various window elements, see Create Managed TE Tunnel, page A-39.

Step 4 Select Proceed with Changes >> > Tunnel Audit. 

The Computation In Progress window shown in Figure 6-12 appears.

Figure 6-12 Computation In Progress - Audit

To abort the computation and return to the previous window, click << Abort Computation. 

Step 5 The TE Primary Tunnel Computation Results - Changes window in Figure 6-13 appears.
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Figure 6-13 TE Primary Tunnel Computation Results - Changes

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 6 To obtain detailed information about the tunnel and whether the change request was achieved, select the 
specific tunnel and click Detail. The detail section in the right side of the window appears as shown in 
Figure 6-14.

Figure 6-14 TE Primary Tunnel Computation Results - Audit Changes (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.

A qualityReport is always generated. If the computation was successful, this will be the only report. 

If a warning or a violation was encountered, one or more warning or violation reports will also be 
generated.

Step 7 To view an audit report, click View Report >>. The TE Primary Tunnel Computation Results - Report 
window in Figure 6-15 appears.
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Figure 6-15 TE Primary Tunnel Computation Results - Audit Report

For an explanation of the various window elements, see Planning Tools, page A-51.

In this case, as shown in Figure 6-15, both a qualityReport and a violation report have been generated.

Step 8 To view the contents of the qualityReport, select the qualityReport and click the Detail button. The 
TE Primary Tunnel Computation Results - Report (details) window in Figure 6-16 appears.

Figure 6-16 TE Managed Primary Tunnels SR - Audit qualityReport (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.
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The qualityReport fields in the right window pane are described in TE Primary Tunnel Computation 
Results - Report, page A-56.

Step 9 To view the contents of the violation report, select the violation report and click the Detail button. The 
TE Primary Tunnel Computation Results - Report (details) window in Figure 6-17 appears.

Figure 6-17 TE Managed Primary Tunnels SR - Audit Violation Report (Details_

For an explanation of the various window elements, see Planning Tools, page A-51.

The report fields in the right window pane are described for each report in Appendix B, “Warnings and 
Violations.”

Step 10 Click << View Result to return to the Changes window (Figure 6-13 or Figure 6-14). If the proposed 
changes were achieved, you can Save & Deploy to save the achievable changes to the repository and 
implement the tunnel modifications on the network.

Note Save & Deploy will discard any changes that were not achievable.

Tunnel Placement
The Placement feature supports the admission of new tunnels into the network and the modification of 
tunnels already admitted into the network. ISC TEM will attempt to implement the changes in such a 
way that network utilization is optimized.

To place a created tunnel, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears as shown in 
Figure 6-2.
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Step 3 When one or more tunnels have been created or their attributes altered (see Create Primary Tunnel, page 
6-2), select Proceed with Changes >> > Tunnel Placement. The Movable Tunnel Selection 
(Placement) window shown in Figure 6-18 appears.

Figure 6-18 Movable Tunnel Selection - Placement

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 4 Set the movable and unmovable managed tunnels

The user can specify whether, when admitting a new tunnel, existing tunnels can be moved (re-routed).  
This is configurable by the user. The default is that managed tunnels are not movable. 

The user can also specify a limit on the maximum number of tunnel moves that are acceptable.

Step 5 Click Proceed >>. The Computation In Progress window shown in Figure 6-19 appears.
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Figure 6-19 Computation In Progress - Placement

To abort the computation and return to the previous window, click << Abort Computation. 

The TE Primary Tunnel Computation Results - Changes window shown in Figure 6-20 appears.

Figure 6-20 TE Primary Tunnel Computation Results - Placement Changes

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 6 To obtain detailed information about the tunnel and whether the placement request was achieved, select 
the specific tunnel and click Detail. The detail section in the right side of the window appears as shown 
in Figure 6-13.
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Figure 6-21 TE Primary Tunnel Computation Results - Placement Changes (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.

If the placement request succeeded (Achieved: yes), the Detail pane will contain a Computed Path that 
is selectable as shown in Figure 6-22.

Figure 6-22 TE Primary Tunnel Computation Results - Placement Changes Achieved (Details)

To view the path information, click the blue link in the Computed Path field. The TE Explicit Path 
window shown in Figure 6-23 appears.
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Figure 6-23 TE Explicit Path for Placement Request

Step 7 To view the placement report(s), click View Report >> in the Changes window (Figure 6-22). The TE 
Primary Tunnel Computation Results - Report window in Figure 6-24 appears.

Figure 6-24 TE Primary Tunnel Computation Results - Placement Report Window

For an explanation of the various window elements, see Planning Tools, page A-51.

A qualityReport is always generated. If the computation was successful, this will be the only report. 

If a warning or a violation was encountered, one or more warning or violation reports will be generated 
as well.

Step 8 To view the contents of a placement report, select one of the reports and click the Detail button. In the 
case of a qualityReport, the TE Primary Tunnel Computation Results - Report (details) window in 
Figure 6-25 appears in the report pane on the right.

For an example of a violation report, see Figure 6-17.
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Figure 6-25 TE Managed Primary Tunnels SR - Placement Report (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.

The qualityReport fields in the right window pane are described in TE Primary Tunnel Computation 
Results - Report, page A-56.

Step 9 Click << View Result to return to the Changes window and click Save & Deploy to save the change to 
the repository and implement the tunnel modifications on network.

Tunnel Repair
As changes are made to the bandwidth requirements or delay parameters of existing tunnels, 
inconsistencies can arise with the Tunnel Placement.  The user can run a Tunnel Repair to address such 
inconsistencies.  The objective of Tunnel Repair is to try to move as few existing tunnels as possible to 
accommodate the changes.

Tunnel Repair can also be invoked from the Resource Management window (see Chapter 4, “TE 
Resource Management”).

In the following, the case of an edited tunnel has been used:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > Create Managed TE Tunnel.
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Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears as shown in 
Figure 6-2.

Tunnel Repair can be used in two ways: 
• When one or more tunnels have been created or their attributes altered (see Create Primary Tunnel, 

page 6-2), Tunnel Repair can be activated by selecting Proceed with Changes >> > Tunnel Repair. 

• When no changes have taken place, Tunnel Repair can be accessed by selecting Placement Tools > 
Tunnel Repair.

Step 3 As an example, let us say that a new primary tunnel SR has been created. Run Tunnel Repair on the 
modified tunnels from the TE Managed Primary Tunnels SR window (Figure 6-11) by navigating

Proceed with Changes -> Tunnel Repair

The Movable Tunnel Selection window shown in Figure 6-26 appears.

Figure 6-26 Movable Tunnel Selection - Repair

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 4 Set the tunnels that should be movable.

Tunnel Repair will only move existing tunnels if it has to.  If the user does not want certain tunnels to 
be moved during Tunnel Repair, these tunnels should be explicitly excluded from the selected list of 
movable tunnels. 

Note It is not necessary to set modified tunnels to be movable as these are movable by deafult.
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Step 5 Click Proceed >>. The Computation In Progress window shown in Figure 6-27 appears.

Figure 6-27 Computation In Progress - Repair

To abort the computation and return to the previous window, click << Abort Computation. 

The TE Primary Tunnel Computation Results - Changes window shown in Figure 6-28 appears.

Figure 6-28 TE Primary Tunnel Computation Results - Repair Changes

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 6 To obtain detailed information about the tunnel and whether the change request was achieved, select the 
specific tunnel and click Detail. The detail section in the right side of the window appears as shown in 
Figure 6-29.
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Figure 6-29 TE Primary Tunnel Computation Results - Repair Changes (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 7 To view a repair report, click View Report >>. The TE Primary Tunnel Computation Results - Report 
window in Figure 6-30 appears.

Figure 6-30 TE Primary Tunnel Computation Results - Repair Report

For an explanation of the various window elements, see Planning Tools, page A-51.

A qualityReport is always generated. If the computation was successful, this will be the only report. 

If a warning or a violation was encountered, one or more warning or violation reports will also be 
generated.

Step 8 To view the contents of the repair report, click the Detail button. In the case of a qualityReport, the TE 
Primary Tunnel Computation Results - Report (details) window in Figure 6-31 appears.

For an example of a violation report, see Figure 6-17.
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Figure 6-31 TE Managed Primary Tunnels SR - Repair Report (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.

The report fields in the right window pane are described for each report in Appendix B, “Warnings and 
Violations.”

Step 9 Click << View Result to return to the Changes window and click Save & Deploy to save the change to 
the repository and implement the tunnel modifications on network.

Grooming
The purpose of grooming is to analyze the tunnel pathing with respect to the network elements and 
optimize resource allocation.

Grooming is not available when change requests have been created. In that case, only the placement tools 
under Proceed with Changes >> will be available.

To perform grooming on the network, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > Create Managed TE Tunnel.

Step 2 Click Create Managed TE Tunnel. The TE Managed Primary Tunnels SR window appears as shown in 
Figure 6-2.

Step 3 Run Grooming by navigating

Placement Tools -> Groom

The Movable Tunnel Selection window shown in Figure 6-32 appears.
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Figure 6-32 Movable Tunnel Selection

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 4 Set the tunnels that should be movable.

As with Tunnel Repair, Grooming will only move existing tunnels if it has to.  If you do not want certain 
tunnels to be moved during the Grooming process, these tunnels should be explicitly excluded from the 
selected list of movable tunnels. 

Step 5 Click Proceed >>. The Computation In Progress window shown in Figure 6-33 appears.
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Figure 6-33 Computation In Progress - Grooming

To abort the computation and return to the previous window, click << Abort Computation. 

The TE Primary Tunnel Computation Results - Changes window shown in Figure 6-34 appears. 

Figure 6-34 TE Primary Tunnel Computation Results - Grooming Changes

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 6 To obtain detailed information about the Grooming and whether it succeeded, select the specific tunnel 
and click Detail. The detail section in the right side of the window appears as shown in Figure 6-35.
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Figure 6-35 TE Primary Tunnel Computation Results - Grooming Changes (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.

Step 7 To view a Grooming report, click View Report >>. The TE Primary Tunnel Computation Results - 
Report window in Figure 6-30 appears.

Figure 6-36 TE Primary Tunnel Computation Results - Grooming Report

For an explanation of the various window elements, see Planning Tools, page A-51.

A qualityReport is always generated. If the computation was successful, this will be the only report. 

If a warning or a violation was encountered, one or more warning or violation reports will also be 
generated.

Step 8 To view the contents of the Grooming report, click the Detail button. In the case of a qualityReport, the 
TE Primary Tunnel Computation Results - Report (details) window in Figure 6-37 appears.

For an example of a violation report, see Figure 6-17.
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Figure 6-37 TE Managed Primary Tunnels SR - Grooming Report (Details)

For an explanation of the various window elements, see Planning Tools, page A-51.

The report fields in the right window pane are described for each report in Appendix B, “Warnings and 
Violations.”

Step 9 Click << View Result to return to the Changes window and click Save & Deploy to save the change to 
the repository and implement the tunnel modifications on the network.
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Protection Planning

This chapter describes the process of creating and managing the protection of network elements using 
automated protection tools. See Chapter 5, “Basic Tunnel Management” for a description of the process 
using the basic tools.

The purpose of protection planning is to protect selected elements in the network (links, routers, or 
SRLGs) against failure.  The first step is to identify the elements that must be protected and then invoke 
the protection tools to compute the protected tunnels. From the computation, the system responds for 
each element with either a set of tunnels that protect the element or a set of violations and warnings that 
help the user to determine why it could not be protected.

For successfully protected elements the tunnels can be deployed on the network.  For elements that could 
not be protected. the protection is either ignored or the constraints are altered on the protection case.  
More specifically, this can involve changing the TE bandwidth settings of the links associated to the 
element and then rerunning the protection computation on the altered network.

This chapter contains the following sections:

• SRLG Operations, page 7-2

– Create SRLG, page 7-2

– Edit SRLG, page 7-4

– Delete SRLG, page 7-4

• Configure Element Protection, page 7-5

• Protection Tools, page 7-6

– Compute Backup, page 7-6

– Audit Protection, page 7-10

– Audit SR, page 7-12

An overview of the protection management processes is provided in Figure 7-1.
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Figure 7-1 Protection Management Processes

SRLG Operations
It is not uncommon for links to have identical physical characteristics, such as being physically located 
in the same conduit, or being connected to the same hardware.  As a result, they could fail as a group 
during a single failure event.  An SRLG addesses this problem by identifying links that could fail 
together. 

After SRLG modifications (create, edit, delete), use the protection planning functions in the TE 
Protection Management window to ensure that adequate protection is available on the network.

Create SRLG
Creating a Shared-Risk Link Group (SRLG) is only necessary if a shared risk link group has been 
identified and it must be protected. 

To create an SRLG, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.
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Step 2 Click TE SRLGs. The TE SRLG List window in Figure 7-2 appears. 

Figure 7-2 TE SRLG List

For an explanation of the various window elements, see Create/Edit TE SRLG, page A-30.

Step 3 To create an SRLG in the TE SRLG List, click Create. The TE SRLG Editor window in Figure 7-3 
appears.

Figure 7-3 TE SRLG Editor

For an explanation of the various window elements , see Create/Edit TE SRLG, page A-30.

Step 4 Specify an SRLG Name.

Step 5 Click Add Link. The Links associated with SRLG window in Figure 7-4 appears.
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Figure 7-4 Links associated with SRLG

For an explanation of the various window elements , see Create/Edit TE SRLG, page A-30.

Step 6 Select one or more links and click Select. The corresponding link information is added to the link list 
and the Select window closes and returns to the SRLG editor.

Step 7 Click Save to save the SRLG. This closes the SRLG editor and brings back the TE SRLG List as the 
active window, where the newly created SRLG is listed.

Edit SRLG
To edit an SRLG, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click TE SRLGs. The TE SRLG List window in Figure 7-2 appears.

Step 3 To edit an SRLG in the TE SRLG List, from the TE SRLG List window select the SRLG that you want 
to modify and click Edit. The TE SRLG Editor window in Figure 7-3 appears

Step 4 Use Add Link and Remove Link to adjust to the desired set of links for the selected SRLG.

Step 5 Click Save to save the changes. 

Delete SRLG
To delete an SRLG, use the following steps:
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Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click TE SRLGs. The TE SRLG List window in Figure 7-2 appears.

Step 3 To delete an SRLG in the TE SRLG List, from the TE SRLG List window select the SRLG(s) that you 
want to delete and click Delete. The Delete Confirm window appears.

Step 4 Click Delete to confirm. The Delete Confirm window closes. After the TE SRLG List window has been 
updated, the deleted SRLG no longer appears in the SRLG list.

Configure Element Protection
Before a protection computation can be performed, it is necessary to configure the network element 
protection.

To do so, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > TE Protected Elements.

The TE Protection Management window in Figure 7-5 appears.

Figure 7-5 TE Protection Management

For an explanation of the various window elements, see Accessing Protection Management, page A-35.

Step 2 First, decide which network elements must be protected.

In the TE Protection Management window, click Add to add a protection element. The Select Protection 
Elements window in Figure 7-6 appears.
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Figure 7-6 Select Protection Elements

For an explanation of the various window elements, see Accessing Protection Management, page A-35.

Step 3 Select one or more elements to be protected and click Select. The Select Protection Element window closes 
and the TE Protection Management window reappears.

Next, decide which protection tools should be applied.

Protection Tools
Relying on manual creation of backup tunnels as described in Chapter 5, “Basic Tunnel Management” 
has its limitations, not just for larger and more complicated networks. 

The protection tools available in ISC TEM provide a number of tools that automatically compute and 
verify protection of specified network elements. 

Compute Backup
Compute Backup is used to let ISC TEM automatically compute the necessary backup tunnels to protect 
specified network elements. The manual process is described in Chapter 5, “Basic Tunnel Management.”

To run Compute Backup, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > TE Protected Elements.

Step 2 Configure the necessary protection elements as described in Configure Element Protection, page 7-5.
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Step 3 If you only want to perform Compute Backup on selected tunnels (elements), select one or more 
elements on which to calculate a backup path. 

Click Compute Backup and select one of the following:

• All Elements

• Selected Elements

The Computation In Progress window shown in Figure 7-7 appears.

Figure 7-7 FRR Computation In Progress - Compute Backup

To abort the computation and return to the previous window, click << Abort Computation. 

Step 4 The window in Figure 7-8 appears.

Figure 7-8 TE Protection Computation Results
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For an explanation of the various window elements, see Compute Backup, page A-36.

Step 5 Select a row corresponding to a specific warning or violation and click Detail to display a detailed 
description in the right pane and backup tunnels associated with the selected item in the bottom pane as 
shown in Figure 7-9. 

For a description of warnings and violations, see Appendix B, “Warnings and Violations.”

Figure 7-9 TE Protection Computation Results with Backup Tunnels

For an explanation of the various window elements, see Compute Backup, page A-36.

The Backup Tunnel table displays which new protection tunnels are required and any existing tunnels 
that should be kept or deleted for each element.

Step 6 In the TE Protection Computation Results window, check whether the proposed protection solution is 
acceptable. It so, click Accept Solution. The TE Protection SR window in Figure 7-10 appears with all 
tunnel additions and deletions computed by the system.
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Figure 7-10 TE Protection SR - Computed Path

For an explanation of the various window elements, see Create TE Backup Tunnel, page A-58.

Optionally, you can make tunnel changes here and then run Audit SR to ensure that you have the desired 
level of protection before you deploy (see Audit SR, page 7-12).

Step 7 Click Save & Deploy to deploy the new tunnel SR to the network.

Note With the exception of TE Traffic Admission SRs, TE SRs are always deployed immediately from the 
specific TE SR screen, not from the Service Requests page in Inventory and Connection Manager.

Step 8 The Service Requests window (Service Inventory > Inventory and Connection Manager > Service 
Requests) opens and displays the state of the deployed SR.

If the SR does not go to the Deployed state, go to the Task Logs screen to see the deployment log 
(Monitoring > Task Manager > Logs) as described in SR Deployment Logs, page 10-1.
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Audit Protection
As opposed to the Compute Backup tool described on page 6, Audit Protection does not attempt to create 
a backup solution. It seeks to verify protection of specified network elements with the current set of 
backup tunnels and reports any warnings or violations that are discovered. It is recommended that any 
time a change has been committed on the TE topology such as resources on TE links or SRLG 
memebership, a protection audit be run to verify the protection status on all elements.

The computation will display the same computation result page as for Compute Backup. When you 
return from computation result page, the Protection Status column in the TE Protection Management 
window is updated to show the level of protection for each element.

This section describes the necessary steps to perform Audit Protection on one or more network elements. 

To run Audit Protection, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > TE Protected Elements.

The TE Protection Management window in Figure 7-5 appears.

Step 2 If you only want to perform Audit Protection on selected tunnels (elements), select one or more tunnels 
on which to calculate a backup path. 

Click Audit Protection and select one of the following:

• All Elements

• Selected Elements

The Computation In Progress window shown in Figure 7-7 appears.

Figure 7-11 FRR Audit Computation in Progress - Audit Protection

To abort the computation and return to the previous window, click << Abort Computation. 

The TE Protection Computation Results window in Figure 7-12 appears.
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Figure 7-12 TE Protection Computation Results

For an explanation of the various window elements, see Compute Backup, page A-36.

Step 3 To view the backup tunnels for a particular element, select the element and click Details.

The TE Protection Computation  Results window in Figure 7-13 appears.
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Figure 7-13 TE Protection Computation Results with Backup Tunnels

For an explanation of the various window elements, see Compute Backup, page A-36.

Step 4 Select a row corresponding to a specific warning or violation and click Show to display a detailed 
description in the right pane and backup tunnels associated with the selected item in the bottom pane as 
shown in Figure 7-9. 

Tunnels associated with a warning or violation are flagged in the Report column in the Backup Tunnels 
table in the bottom pane.

The Accept Solution button is greyed out because the audit does not provide a solution but rather an 
evaluation.

For a description of warnings and violations, see Appendix B, “Warnings and Violations.”

Step 5 Click Cancel to return to the TE Protection Management window. The protection status is updated in the 
Protection Status column.

Audit SR
Audit SR audits protection of all elements in the TE Protection Management window against backup 
tunnels in the TE Protection SR window.

This feature can be used to audit the protection for manually added, modified, and deleted tunnels in the 
TE Protection SR window before deploying them.

To audit a TE backup tunnel SR, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click Create TE Backup Tunnel. The TE Protection SR window in Figure 7-14 appears.
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Figure 7-14 TE Protection SR

For an explanation of the various window elements, see Create TE Backup Tunnel, page A-58.

Step 3 To audit the protection SRs, click Audit SR.

The FRR Audit process begins and the TE Protection Computation Results window in Figure 7-12 
appears.

See Audit Protection, page 7-10 for a description of the rest of the process. Detail and report windows 
are identical in these two processes.
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Traffic Admission

Tunnel admission is the first step towards enabling services on TE tunnels. There are a number of 
mechanisms that can be used for forwarding traffic into a tunnel to provide basic IP connectivity. The 
current implementation of Cisco IP Solution Center Traffic Engineering Management (ISC TEM) uses 
static routing.

The TE Traffic Admission tool is used to assign traffic to traffic-engineered tunnels.

This chapter contains the following sections:

• Overview, page 8-1

• Creating a TE Traffic Admission SR, page 8-1

• Deploying a TE Traffic Admission SR, page 8-4

• Viewing the SR State, page 8-5

Overview
Static routing is perhaps the simplest way of forwarding traffic into a tunnel.  Traffic that matches a 
target destination prefix is routed into a particular tunnel.  

While this achieves the basic goal of directing traffic into a given tunnel, this approach has limitations.  
First, the offering of differentiated Class-of-Service (CoS) treatment is limited to destination-based CoS. 
As each source PE serves as an aggregation point for a number of traffic flows, there is no way to restrict 
which traffic receives preferential treatment to a destination since access to a tunnel is through general 
routing.  Second, it does not generally provide a scalable solution because the static routing mechanism 
must capture both the large number of subnets that can be served by each PE router, and it must be able 
to further capture CoS treatment for each of these subnets.  

Static routing works best if there is no need to provide differentiated CoS treatment by destination.  That 
is, all packets destined for one or more particular prefixes all receive the same CoS.

Creating a TE Traffic Admission SR
To create a TE Traffic Admission SR, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management.

Step 2 Click TE Traffic Admission.
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The TE Traffic Admission Tunnel Selection window in Figure 8-1 appears.

Figure 8-1 TE Traffic Admission Tunnel Selection

For an explanation of the various window elements, see Select TE Tunnel for Admission, page A-64.

The TE Traffic Admission Tunnel Selection window lists all primary tunnels, both managed and 
unmanaged, that are not already associated with an admission SR.

The Deploy Status can be Pending, Deployed, or Functional.

Note Backup tunnels are not displayed in the TE Traffic Admission Tunnel Selection window.

Step 3 Select a TE tunnel by clicking the corresponding radio button and clicking Select. The TE Traffic 
Admission SR window in Figure 8-2 appears.
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Figure 8-2 TE Traffic Admission SR

For an explanation of the various fields and buttons, see TE Traffic Admission SR, page A-65.

Step 4 When filling out the form, if Autoroute Announce is set to On, indicate whether Autoroute Metric 
should be Absolute or Relative.

When clicking the Add button, the Add TE Static Route window in Figure 8-3 appears.

Figure 8-3 Add TE Static Route

Step 5 In the Add TE Static Route window, specify at a minimum a Destination router and a network Mask. 
Optionally specify an administrative Distance. 

Click OK to accept the entries or Cancel to exit the screen.

Step 6 Back in the main TE Traffic Admission SR window, you can add another TE Static Route or edit existing 
routes.

Step 7 Click Save SR to save the SR. 

To deploy the SR from the Service Requests window, see Deploying a TE Traffic Admission SR, page 
8-4.
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Deploying a TE Traffic Admission SR
As opposed to the TE Primary and Backup Tunnel SR screens, a TE Admission SR must be deployed 
from the general Service Requests window.

To deploy a TE Admission SR, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Service Requests.

Step 2 Click TE Traffic Admission. The Service Requests window in Figure 8-4 appears.

Figure 8-4 Service Requests

The Service Requests window contains the following elements:

• Job ID—Job ID for the SR.

• State—Indicates whether the tunnel state is DEPLOYED or NOT DEPLOYED and whether it is 
Conformed or Not Conformed.

• Type—The type of service request, indicating which service issued the request. For a detailed 
description of the possible service types, see Cisco IP Solution Center Infrastructure Reference, 4.0.

• Operation Type—SR operation on the tunnel, can be either ADD, MODIFY, DELETE, or 
ADMIT. Applicable only to tunnels in the current SR.

• Creator—ID for the user who created the SR.

• Customer Name—Name of the customer to which the SR applies.

• Policy Name—Name of the policy associated with the SR.

• Last Modified—Date and time when the SR was last modified.

• Description—SR description provided by the user.

Step 3 Select the desired service request and click Deploy. A drop-down menu appears under the Deploy 
button.
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In the drop-down menu, select Deploy or Force Deploy. After having been successfully deployed, the 
State of the SR changes to Deployed.

Viewing the SR State
To view a service request state, go to the Service Requests window under Inventory and Connection 
Manager. 

If the SR does not enter the Deployed state, go to the Task Logs screen to see the deployment log 
(Monitoring > Task Manager > Logs) as described in SR Deployment Logs, page 10-1.
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Administration

A number of administrative features in Cisco IP Solution Center Traffic Engineering Management (ISC 
TEM) are common to ISC. Instructions on how to use these features are described in detail in Cisco IP 
Solution Center Infrastructure Reference, 4.0. 

In this chapter, only TE-specific administrative features are described. 

This chapter contains the following sections:

• TE User Roles, page 9-1

• TE Policies, page 9-2

– Create Policy, page 9-2

– Edit Policy, page 9-4

– Delete Policy, page 9-5

• TE Tasks, page 9-5

– Creating a TE Task, page 9-6

—Creating a TE Functional Audit Task, page 9-6

—Creating a TE Interface Performance Task, page 9-11

• SR History, Config Audit Report, and Configlets, page 9-18

• Manage Lock, page 9-18.

TE User Roles
A TE user role can be a predefined or a user-specified role defining a set of permissions. For a detailed 
description of user roles in ISC and how to use them, see the Cisco IP Solution Center Infrastructure 
Reference, 4.0.

To access the User Roles window and locate the TE user roles, navigate Administration > Security > 
User Roles. The User Roles window in Figure 9-1 appears.
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Figure 9-1 User Roles

For a description of the various window elements, see Cisco IP Solution Center Infrastructure Reference, 
4.0.

There are two pre-defined TEM user roles:

• TERole—Grants full permission to TEM operations.

• TEServiceOpRole—Grants permission only to manage the TE Admission SR.

TE Policies
Policies are used to define common tunnel attributes. Attributes such as bandwidth pools, hold and setup 
priority, and affinity bits, are set manually during policy creation as described below.

This section describes the following policy operations:

• Create Policy, page 9-2

• Edit Policy, page 9-4

• Delete Policy, page 9-5

Create Policy
ISC TEM allows you to create TE-specific policies in a manner similar to other ISC policies.

To create a TE policy, you must access the Policy Manager. Use the following steps:

Step 1 Navigate Service Design > Policy Manager.
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Step 2 Click the Policy Manager icon.

The Policies window in Figure 9-2 appears.

Figure 9-2 Policies Window

Step 3 Click Create and select TE Policy to set up a new TE policy. 

The TE Policy Editor window in Figure 9-3 appears.

Figure 9-3 TE Policy Editor

The TE Policy Editor window contains the following fields:
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• Policy Name—Name of the TE policy chosen by the user.

• Owner—The owner of the TE policy:

– Global—A global policy.

– Provider—A provider policy.

– Customer—A customer policy.

• Managed—Check this box to make the policy to be used by managed tunnels. When clicked, both 
the setup and hold priorities are set to zero and these are not editable. If the box s unchecked, the 
setup/hold priorities can be set to a value between 1 and 7.

Clicking the Managed check box will add some extra fields in the TE Policy Editor corresponding 
to two additional protection levels for FRR Protection Level (Fast Re-Route) and a new field, 
Delay Constraint.

• Pool Type—Tunnel bandwidth pool type.

– Sub Pool (BC1)—Bandwidth section nested inside the Global Pool part of the total bandwidth.

– Global Pool (BC0)—Section of the total link bandwidth containing all Sub Pools for the link.

• Setup Priority—Priority used when signaling an LSP for the tunnel to determine, which of the 
existing tunnels can be preempted. Valid values are from 0 to 7, where a lower number indicates a 
higher priority. Therefore, an LSP with a setup priority of 0 can preempt any LSP with a non-0 hold 
priority.

• Hold Priority—Priority associated with an LSP for the tunnel to determine if it should be 
preempted by other LSPs that are being signaled. Valid values are from 0 to 7, where a lower number 
indicates a higher priority.

• Affinity—Attribute values required for links carrying the tunnel (bit values are either 0 or 1).

• Affinity Mask—Which attribute values should be checked. If a bit in the mask is 0, a link's attribute 
value of that bit is irrelevant. If a bit in the mask is 1, the link's attribute value and the tunnel's 
required affinity for that bit must match.

• FRR Protection Level—Level of Fast Reroute protection required on the primary tunnel.

– None—No backup tunnel needed.

– Best Effort—Use backup tunnel if available.

– Link & SRLG—Requires the path used by the tunnel to have link and SRLG protection.

– Link, SRLG & Node—Requires the path used by the tunnel to have link, SRLG, and node 
protection.

• Delay Constraint—The path used by the tunnel is required to meet the delay constraint specified.

– Max Delay (msec)—Maximum delay allowed.

Two actions are available:

• Save—Save the TE policy with the current data.

• Cancel—Quit the TE Policy Editor and discard any changes.

Edit Policy
A policy can be edited only if it is not associated with a tunnel.
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To edit a TE policy, use the following steps:

Step 1 Navigate Service Design > Policy Manager.

Step 2 Click the Policy Manager icon.

The Policies window in Figure 9-2 appears.

Step 3 Select the desired policy and click Edit. 

The TE Policy Editor window in Figure 9-3 appears. The TE Policy Editor window in Figure 9-3 
appears. The policy editor is described in Create Policy, page 9-2. The only difference between the create 
and edit processes is that the policy name and owner are not editable when editing a policy.

Step 4 Make the desired changes to the policy attributes and click Save. If the save operation succeeds, the new 
TE policy now appears in the Policies window. If not, the Status box will indicate the type of error that 
occurred and, when possible, the corrective action required.

Delete Policy
A policy can be deleted only if it is not associated with a tunnel.

To delete a TE policy, use the following steps:

Step 1 Navigate Service Design > Policy Manager.

Step 2 Click the Policy Manager icon.

The Policies window in Figure 9-2 appears.

Step 3 Select the desired policy and click Delete. The Confirm Delete window in Figure 9-4 appears

Figure 9-4 Policies - Confirm Delete

Step 4 Check the policy marked for deletion and click OK.

Step 5 The Policies window refreshes and the selected policy disappears.

TE Tasks
ISC TEM currently offers three TE-specific tasks that are used in a manner similar to other ISC tasks:
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• TE Discovery—Populates the repository with data from the TE network. Discrepancies are 
reconciled and/or reported.

• TE Functional Audit—Performs functional audit on TE Primary or Backup SRs in certain states.

• TE Interface Performance—Calculates the interface/tunnel bandwidth utilization.

This section focuses on describing how to create TE Functional Audit and TE Interface Performance 
tasks. Instructions on how to create a TE Discovery task are included in Chapter 3, “TE Network 
Discovery”.

Creating a TE Task
TE tasks are managed in the ISC Task Manager, which is accessed as follows:

Step 1 Navigate Monitoring > Task Manager.

The Tasks window in Figure 9-5 appears.

Figure 9-5 Tasks Window

For a detailed description of the window elements in the Tasks window, see Cisco IP Solution Center 
Infrastructure Reference, 4.0.

This page shows all collection and deployment tasks that have been executed. Note that a task could be 
scheduled to happen once or there could be several scheduled runs of a task. The schedule can be viewed 
by selecting a task and clicking Schedules.

Creating a TE Functional Audit Task

For each tunnel in the SR, the TE Functional Audit task checks the LSP currently used on a router against 
the LSP stored in the repository:

• tunnel down—Ignore (do not check)

• tunnel up—Check the LSP used on the router against the one stored in the repository:
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– If they are the same, the tunnel and the SR are both set to Functional.

– If they are different, both the tunnel and the SR are set to Broken.

• tunnel missing from router—SR left untouched. The tunnel state is set to Lost.

This task only performs functional audit on TE Primary or Backup SRs, which are not in one of the 
following states:

• Closed

• Requested

• Invalid

• Failed Deploy

For a detailed explanation of the various states, see Cisco IP Solution Center Infrastructure Reference, 
4.0.

To create a TE Functional Audit task, use the following steps:

Step 1 Navigate Monitoring > Task Manager.

Step 2 Click Audit > TE Functional Audit to open the Create Task window in Figure 9-6.

Figure 9-6 Create a TE Functional Audit Task

For a detailed description of the window elements in the Create Task window, see Cisco IP Solution 
Center Infrastructure Reference, 4.0.

Step 3 Modify the Name or Description fields as desired and click Next.

The Task Service Requests window in Figure 9-7 appears.
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Figure 9-7 Task Service Requests

Step 4 Click Add to add a task service request. The Select Service Request(s) window in Figure 9-8 appears.

Figure 9-8 Select Service Request(s)

Step 5 Select an SR using the Select button. 

The Selected Service Request(s) window closes and the selected task(s) now appears in the Task Service 
Requests window. To add other SRs, repeat the procedure in Step 4 and Step 5.

Step 6 In the Task Service Requests window, click Next. The Task Schedules window in Figure 9-9 appears.
9-8
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



Chapter 9      Administration
TE Tasks
Figure 9-9 Task Schedules

Step 7 Click Now to start the task immediately or Create to create a task schedule. The Task Schedule window 
in Figure 9-10 appears.

Figure 9-10 Task Schedule

Step 8 In the Task Schedule window, indicate when and how often to run the task.

Step 9 Click OK. The scheduled task should now appear in the Task Schedules table.

Note The default setting is to schedule a single TE Functional Audit task to take place immediately (“Now”).
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Step 10 Click Next. The Task Schedule window now shows the new task in its list of created tasks as shown in 
Figure 9-11. 

Figure 9-11 Task Schedule with Scheduling Data

Step 11 A summary of the scheduled task appears as shown in Figure 9-12. 

Figure 9-12 TE Functional Audit Task Summary
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Step 12 Click Finish. This adds the task to the list of created tasks in the Tasks window (Figure 9-5).

To view the task logs for the created tasks, see Viewing a Task Log, page 10-2.

Creating a TE Interface Performance Task

This task calculates interface/tunnel bandwidth utilization using the Simple Network Management 
Protocol (SNMP). 

Calculating utilization depends on how data is presented for the object you want to measure. Interface 
utilization is the primary measure used for network utilization. Because MIB-II variables are stored as 
counters, you must take two poll cycles and figure the difference between the two (hence, the delta used 
in the equation). 

Three variables are required:

• task duration—how long the task will run (in secs)

• frequency—how frequent the data will be collected (in secs)

• interval—the distance between two poll cycles (in ms).

The following explains the variables used in the formulas:

• delta(ifInOctets)—the delta between two poll cycles of collecting the SNMP ifInOctets object, 
which represents the count of inbound octets of traffic

• delta(ifOutOctets)—the delta between two poll cycles of collecting the SNMP ifOutOctets object, 
which represents the count of outbound octets of traffic

• IfSpeed—the speed of the interface, as reported in the snmpifSpeed object.

A more accurate method is to measure the input utilization and output utilization separately, using the 
following formula:

delta(ifInOctets) x 8 x 100

Input utilization = ---------------------------------------------------

(number of seconds in delta) x ifSpeed

delta(ifOutOctets) x 8 x 100

Output utilization = ---------------------------------------------------

(number of seconds in delta) x ifSpeed

To create a TE Interface Performance task, use the following steps:

Step 1 Navigate Monitoring > Task Manager.

Step 2 Click Create to open the Create Task window in Figure 9-13.
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Figure 9-13 Create TE Interface Performance Task

For a detailed description of the window elements in the Create Task window, see Cisco IP Solution 
Center Infrastructure Reference, 4.0.

Step 3 Select TE Interface Performance in the drop-down list of the Type field.

The Select TE Provider window in Figure 9-14 appears.

Figure 9-14 Select TE Provider

Step 4 Click a radio button to select a TE provider. 
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Step 5 Click Next. The TE Performance Collection window in Figure 9-15 appears.

Figure 9-15 TE Performance Collection

Step 6 Enter desired values in the Duration, Frequency, and Interval fields.

Step 7 Use the Add button to select a tunnel or link on which to run the interface performance task:

• TE Tunnel—Add a TE tunnel. The Select Tunnel(s) window in Figure 9-16 appears.

• TE Link—Add a TE link. The Select Link(s) window in Figure 9-17 appears.
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Figure 9-16 Select Tunnel(s) - Interface Performance
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Figure 9-17 Select Link(s)

Step 8 Select one or more of tunnels and links and click Next.

Step 9 The Task Schedules window in Figure 9-18 appears.

Figure 9-18 Task Schedules
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Step 10 Click Now or Create to create a task schedule. When you select Create to customize the schedule, the 
Task Schedule window in Figure 9-19 appears (with Now, this step is skipped).

Note The default setting is to schedule a single TE Interface Performance task to take place 
immediately (“Now”).

Figure 9-19 Task Schedule

Step 11 In the Task Schedule window, make your selections to define when and how often to run the task.

Step 12 Click OK. The scheduled task should now appear in the Task Schedules table as shown in Figure 9-20.
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Figure 9-20 Task Schedules with Scheduling Data

Step 13 Click Next. A summary of the scheduled task appears as shown in Figure 9-21. 

Figure 9-21 Performance Task Summary

Step 14 Click Finish. This adds the task to the list of created tasks in the Tasks window (Figure 9-5). 
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Figure 9-22 Performance Task Summary

To view the TE Performance Report that is generated for TE Interface Performance task(s), see TE 
Performance Reports, page 10-4.

To view the task logs for the created tasks, see Viewing a Task Log, page 10-2.

SR History, Config Audit Report, and Configlets
The history, config audit reports, and configlets associated with individual service requests can be 
viewed from the Service Requests window when you click the Details button. 

The history of an SR is essentially a state change report. It lists the various states that elements 
associated with an SR has transitioned between and reports relevant details pertaining to these state 
changes.

Configlets for devices associated with SRs are in simple scrollable text format.

Manage Lock
Whenever a task is performed that incurs a database update, which might affect the resource and hence 
the result of a tunnel computation, it locks the system before the update and releases it at completion of 
the update. If for some reason the lock is not released, other updates that require the lock are blocked.  

The purpose of the lock feature is to prevent concurrent and mutually inconsistent planning activities 
from being committed to the database.  Meaning, if each user takes the same snapshot of the the 
repository, performs computations, and tries to commit what he/she sees, the locking mechanism helps 
synchronize the commit and ensures that no commit invalidates other commits.  
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If the system is locked for prolonged periods of time, the administrator should check if anyone is 
performing long planning tasks and take note of, which process locked the system and report it.  If the 
administrator is sure that no one is using the sytem, it can be unlocked by using the lock manager.

Each system lock is linked to a TE provider. To unlock the TE provider, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > TE Providers.

Step 2 The TE Providers window in Figure 2-3 appears.

Step 3 Select a TE provider that is locked by clicking the corresponding check box.

Step 4 Click Manage Lock. The System Lock Management window in Figure 9-23 appears.

Figure 9-23 System Lock Management

The text fields in this window are read-only.

Step 5 To unlock, click the Unlock button.

The System Lock Management window closes and the System Lock Status field in the TE Providers 
window is updated accordingly.
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Task Monitoring

All deployment and collection tasks are monitored and the details of the tasks are logged. The 
information can be viewed using the task monitoring pages.

This chapter contains the following sections:

• TE Task Logs, page 10-1

• TE Performance Reports, page 10-4

TE Task Logs
The TE task logs are used to view the result of running one or more TE tasks as described in TE Tasks, 
page 9-5.

Different task logs are generated by different events:

• SR deployment logs

• Logs generated by tasks issued from the Task Manager:

– TE Discovery log

– TE Functional Audit

– TE Interface Performance.

SR Deployment Logs
When any service request is deployed, whether a managed or unmanaged primary tunnel or a backup 
tunnel, a log is generated. For tunnel SRs, deployment takes place in multiple phases depending on the 
type of SR and the task logs are created similarly:

• Primary tunnel SR—a three-phase logging process corresponding to a three-phase deployment 
(phases A, B, and C as shown in Figure 10-2)

• Protection SR—a two-phase logging process corresponding to a two-phase deployment

In addition to the deployment logs, a ConfigAudit log is created regardless of the type of SR deployment, 
providing the deployment was successful.
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Logs Created from Task Manager
Specific instructions for how to generate and view a task log for a TE Discovery task are found in Task 
Logs, page 3-6.

Instructions for how to generate and view a task log for the TE Functional Audit and TE Interface 
Performance tasks are found in Creating a TE Task, page 9-6.

Viewing a Task Log
To view the task log for a TE task, three sequential steps are required:

1. Access the Task Runtime Actions window.

2. Select a runtime action to open the Runtime Actions window.

3. Select a runtime action instance to view the desired log in the Task Log window.

To view the task logs, use the following steps. A task log from the deployment of a managed primary 
tunnel has been used as an example.

Step 1 Navigate Monitoring > Task Manager.

Step 2 Select Logs in the table of contents on the left side of the Tasks window. The Task Runtime Actions 
window in Figure 10-1 appears.

Figure 10-1 Task Runtime Actions

For an explanation of the various window elements, see Task Runtime Actions, page A-67.

Step 3 Select a Task Log for viewing. A task that has been scheduled for multiple runs might have multiple 
instances to view. Click the desired task in the Runtime Task Name column. The Runtime Actions 
window in Figure 10-2 appears.
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Figure 10-2 Runtime Actions

For an explanation of the various window elements, see Runtime Actions, page A-67.

Step 4 To access the Task Log window from the Runtime Actions window, click the desired instance in the 
Runtime Task Name field. The Task Log window in Figure 10-3 appears.

Figure 10-3 Task Log

For an explanation of the various window elements, see Task Log, page A-68.

The logged messages are shown in a table. This includes the time the log message was created and the 
severity level assigned to the log message.
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There is a filter setting for the logging, which defaults to SEVERE. This means that only SEVERE 
messages in the log are shown. There are several different filter settings that can be selected according 
to the desired level of detail. To change the filter level, select the one that is required and click Filter.

How the log is structured depends on the type of task that was run.

Step 5 Click Return to Logs to close the Task Log window.

TE Performance Reports
A TE Performance Report is created when you run a TE Interface Performance task as described in 
Creating a TE Interface Performance Task, page 9-11.

It shows the traffic data collected from the TE Interface Performance task for selected tunnels and/or 
links. The TE Interface Performance task can run multiple times.

To view a TE Performance Report, use the following steps:

Step 1 Navigate Monitoring > TE Performance Report.

The TE Performance Report Table in Figure 10-4 appears.

Figure 10-4 TE Performance Report Table

For an explanation of the various window elements in the report table, see TE Performance Reports, page 
A-69.
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TE Topology

The TE Topology tool provides a graphical view of the network set up through the Cisco IP Solution 
Center Traffic Engineering Management (ISC TEM) web client. It gives a graphical representation of 
the various network elements, including devices, links, and tunnels. 

This section describes how to use the topology tool. A definition of fields and buttons in the topology 
GUI is found in TE Topology, page A-5 in Appendix A, “Traffic Engineering Management GUI”. 

This chapter contains the following sections:

• Overview, page 11-1

• Accessing the TE Topology Tool Page, page 11-2

• Using the TE Topology Interface Applet, page 11-2

Overview
The TE Topology tool can be activated from various locations within ISC. However, in this user guide 
the TE Topology tool is assumed to be accessed from the Traffic Engineering Management Services 
page.

The TE Topology tool is used to visualize the TE network based on the data contained in the repository. 
To that end, it provides a number of ways of manipulating the display, for example by applying 
algorithms to the graph layout, importing maps, and so on.

The tool is accessed from a TE Topology Interface Applet that displays the TE topology through a Java 
applet within the browser.
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Accessing the TE Topology Tool Page
The TE Topology tool is accessed as follows:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > TE Topology.

The Topology Tool window in Figure 11-1 appears.

Figure 11-1 Topology Tool

For a detailed description of the Topology Tool page, see Cisco IP Solution Center Infrastructure 
Reference, 4.0.

Step 2 To start up the TE Topology tool, select ISC-TEM Topology Interface Applet.

Using the TE Topology Interface Applet
The TE Topology Interface Applet (Topology Applet) provides a means of visualizing the network and 
tunnels present in the network. The web-based GUI is the primary means of visualizing the network 
information. The Topology Applet simply augments the web-based GUI to provide a different 
presentation format to the user.

The features offered through the Topology Applet are:

• TE Topology rendering

• Highlighting of network elements
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• Tunnel overlay (unmanaged, primary, and backup)

• Topology layout persistence

• Integration with web page content.

To access the Topology Applet, use the following steps:

Step 1 Navigate to Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > Topology Tool.

Step 2 Click ISC-TEM Topology Interface Applet.

The security warning window in Figure 11-2 appears.

Figure 11-2 Security Warning

Step 3 Click Yes or Always to accept the authenticity of the security certificate.

The Topology Display applet window in Figure 11-3 appears.
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Figure 11-3 Topology Display Applet

For an explanation of the various window elements in all the menus of the Topology Display, see 
Topology Display Window, page A-6.

Display/Save Layout
Use the two operations in the Repository menu, Layout Graph and Save Graph Layout, to display or 
save the current layout of the network graph.

Prior to generating the graph layout, the coordinates must be set on each of the network devices. 
Otherwise, the graph will have a random layout.

• Layout Graph—The graph is laid out from the repository. If a graph layout is already present, that 
layout is cleared once you click Yes in the Clear Graph Layout confirmation box. If the layout has 
not previously been saved, a random layout of the repository contents is drawn. If it has been saved 
previously, the saved layout is redrawn.

• Save Graph Layout—Save the current graph layout. Doing so will ensure that whenever the graph 
layout is cleared with Layout Graph or the topology applet is closed, the same layout will be 
created when the applet is restarted. If a map was used, the map is also redrawn.
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Using Maps
You can associate a map with each view. Currently, the topology viewer only supports maps in the 
Environmental Systems Research Institute, Inc. (ESRI) shape format. The following sections describe 
how to load maps and selectively view map layers and data associated with each map. 

The map features are accessed from the Map menu in the Topology window.

To access the Map menu, use the following steps:

Step 1 Navigate Service Inventory > Inventory and Connection Manager > Traffic Engineering 
Management > TE Topology.

Step 2 Start the ISC TM Topology Interface Applet. If link and node data for your network is already in the 
repository, a Progress Report lists the various network elements as the corresponding data is loaded.

Step 3 Select the Map menu. The menu in Figure 11-4 appears.

Figure 11-4 The Map Menu

From the Map menu, you can either load or clear (remove) maps as described in the following.

Loading a map

You might wish to set a background map showing the physical locations of the displayed devices. To 
load a map, use the following steps:

Step 1 In the menu bar, select Map > Load

Providing the web map server is running, the Load Map window appears (see Figure 11-5). 
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Figure 11-5 Load Map

For an explanation of the various window elements , see Load Map, page A-8.

Step 2 Make your selections in the Load Map window.

The right-hand side of the window contains a small control panel, which allows you to select the 
projection in which a map is shown. A map projection is a projection which maps a sphere onto a plane. 
Typical projections are Mercator, Lambert, and Stereographic. 

For more information on projections, consult the Map Projections section of Eric Weisstein's World of 
Mathematics at:

http://mathworld.wolfram.com/topics/MapProjections.html

For each projection, you can also select the region of the map to be shown. In most cases, the predefined 
values should be sufficient. The top level of the file hierarchy should contain folders for all major 
regions, such as Asia, Europe, North America, Oceania, and so on. 

If desired, make changes to the settings in the Longitude Range and Latitude Range fields.

Step 3 Navigate to the desired folder.

Each folder can contain either complete maps or folders for countries. Each map is clearly distinguished 
with the Map icon.

Step 4 Select a map file and click Open to load the map.

Selecting the map file and clicking the Open button starts loading it. Maps can consist of several 
components and thus a progress dialog is shown informing you which part of the map file is loaded.

A map similar to the one in Figure 11-6 appears. 
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Figure 11-6 Loaded Map

Step 5 Use the various functions in the menus of the Topology Display window to manipulate the display 
contents in the Topology view. Some of these are described in subsequent sections. For a more complete 
description of the menu functions available, see Topology Display, page A-5.

Adding new maps

You might need to add your own maps to the selection of maps available to the Topology Tool. This is 
done by placing a map file in the 
$ISC_HOME/resources/webserver/tomcat/webapps/ipsc-maps/data directory or a subdirectory 
thereof within the ISC installation. To make this example more accessible, assume that you wish to add 
a map of Toowong, a suburb of Brisbane, the capital of Queensland. The first step to do so is to obtain 
maps from a map vendor. All maps must be in the ESRI shape file format (see ESRI shapefile technical 
description). In addition, a data file can accompany each shape file. Data files contain information about 
objects and the corresponding shapes are contained within the shape file. Let us assume that the vendor 
provided four files: 

• toowong_city.shp

• toowong_city.dbf

• toowong_street.shp
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• toowong_street.dbf

We have to create a .map file that informs the TE Topology tool about layers of the map. In this case we 
have two layers: a city and a street layer. The map file, say, Toowong.map, would thus have the following 
contents: 

toowong_city
toowong_street

It lists all layers that create a map of Toowong. The order is important, as the first file forms the 
background layer, with other layers placed on top of the preceding layers. 

Having obtained shape and data files and having written the map file, decide on its location. As 
mentioned, Toowong is a suburb of Brisbane, located in Queensland, Australia. All map files must be 
located in or under the $ISC_HOME/resources/webserver/tomcat/webapps/ipsc-maps/data 
directory. Since by default this directory contains a directory called Oceania intended for all maps from 
that region, simply create a path Australia/Queensland/Brisbane under the directory Oceania. Next, 
place all five files in this location. Once this is done, the map is automatically accessible to the topology 
viewer.

Clearing Maps

To clear the active map, select Map > Clear (see Figure 11-3 and Figure 11-4).

Use this feature to clear (remove) the active map to leave only nodes and links in the corresponding 
network.

Using Highlighting and Attributes
The Graph menu, shown in Figure 11-7, provides access to a range of tools to manage and manipulate 
graphs.

Figure 11-7 Graph Menu

For an explanation of the various menu items, see the following sections as well as Graph, page A-10.

Use the JavaServer Pages (to pagesto) to look at the list of nodes, links, and tunnels. From the JSP pages, 
select the display button at the bottom of the window to highlight elements.

The tools in the Graph menu serve to modify the appearance of the topology.

These are described in the following sections.
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Clear Highlighting

Clear Highlighting serves to remove highlighting from specific elements as listed in its submenus. For 
a description of the individual entries, see Graph, page A-10.

Add/Modify Attributes

When you select Attributes from the Graph menu, the Graphic Attributes window in Figure 11-8 
appears.

Figure 11-8 Graphic Attributes

The Add/Modify Attributes tool is used as follows:

Step 1 Select graph elements (nodes/links) in the topology display. Use Ctrl/Shift to select multiple elements.

Step 2 Navigate Graph > Attributes to open the Graphic Attributes window.

Step 3 Change the desired attributes and click Apply All. 

Note Only selected links (Step 1) are affected.

Clear Current Graph Layout

Use the Clear function in the Graph menu to remove the topology graph from the current view.

Although this is also achieved with Layout Graph in the Repository menu, Layout Graph re-creates 
the graph last saved in the repository in addition to clearing the graph.

Using AntiAlias, BackingStore, DoubleBuffer

AntiAlias, found in the Graph menu, is used to create smoother lines and a more pleasant appearance 
at the expense of performance.

BackingStore allows graphics content to be automatically saved when moved to the background and 
regenerated when returned to the foreground. This helps avoid superfluous refreshing.
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DoubleBuffer enables double buffering for dragging elements on the graph.

Using Algorithms
In the Algorithms menu, shown in Figure 11-9, various algorithms can be used to enhance and otherwise 
alter the graph layout. 

Note The algorithms only work when the nodes are interconnected with links.

Spring is a graph layout algorithm that optimizes the graph layout based on weights. 

Randomize rearranges the nodes in the current topology layout at random.

If there are overlapping links, the layout can be optimized by selecting Optimize Links.

Figure 11-9 Algorithms Menu

For further explanation of the Algorithms menu, see Algorithms Menu, page A-12.

The spring settings are used to enhance the appearance of the topology display according to user 
preferences. When selecting Spring Settings, the Spring Settings window in Figure 11-10 appears.
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Figure 11-10 Spring Settings

For an explanation of the various fields in the Spring Settings window, see Algorithms, page A-12.
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Traffic Engineering Management GUI

This chapter describes the Cisco IP Solution Center Traffic Engineering Management (ISC TEM) GUI 
and provides an explanation of the various fields, buttons, and other GUI elements. For a detailed 
description of the process flows for the various ISC TEM services, see the respective chapters and 
sections elsewhere in this user guide.

In this chapter, the parts of the ISC GUI used by the ISC TEM component are described:

• TE Providers, page A-3

• TE Topology, page A-5

• TE Nodes, page A-18

• TE Links, page A-21

• TE SRLGs, page A-29

• TE Explicit Paths, page A-32

• TE Protected Elements, page A-35

• Assign TE Resources, page A-39

• Create Managed TE Tunnel, page A-39

• Create Unmanaged TE Tunnel, page A-58

• Create TE Backup Tunnel, page A-58

• TE Traffic Admission, page A-64

• Adminstration, page A-66

• Monitoring, page A-66

Accessing the TEM GUI
The Traffic Engineering Management GUI forms part of the general Cisco ISC GUI.

This section describes the GUI elements in the Traffic Engineering Management Services window.

To access the TEM GUI, go to Service Inventory > Inventory and Connection Manager > Traffic 
Engineering Management. The Traffic Engineering Management Services window in Figure A-1 
appears.
A-1
gineering Management User Guide, 4.0



  

Appendix A      Traffic Engineering Management GUI
  Accessing the TEM GUI
Figure A-1 Traffic Engineering Management Services

The main ISC TEM window includes the following service elements:

• Service Request Elements

– TE Providers—Create and manage TE Providers.

– TE Topology—View the ISC TEM application through a topology interface.

– TE Nodes—View TE nodes and node details.

– TE Links—View TE links.

– TE SRLGs—Create and manage Shared Link Risk Groups (SRLGs).

– TE Explicit Paths—Create and manage TE explicit paths.

– TE Protected Elements—Manage protection of network elements.

• Service Request Forms

– Assign TE Resources—Assign or manage TE resources on device interfaces.

– Create Managed TE Tunnel—Create or edit SRs for managed TE tunnels.

– Create Unmanaged TE Tunnel—Create or edit SRs for unmanaged TE tunnels.
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– Create TE Backup Tunnel—Create or edit SRs for TE backup tunnels .

– TE Traffic Admission—Assign traffic to traffic-engineered tunnels.

TE Providers
This section describes the GUI elements in the TE Providers tool.

To create a TE Provider, see Creating a TE Provider, page 2-4.

To access the TE Providers window, go to Service Inventory > Inventory and Connection Manager > 
Traffic Engineering Management > TE Providers. The TE Providers window in Figure A-2 appears.

Figure A-2 TE Providers

The TE Providers window contains the following fields:

• Provider Name—Name of TE provider.

• System Lock Status—Indicates whether or not the system lock is activated (Locked or Unlocked).

The following actions can be performed:

• Create—Create a TE provider.

• Edit—Edit the TE provider details.

• Delete—Delete a TE provider.

• Manage Lock—Manage the system lock status (see Manage Lock, page 9-18).

Create/Edit TE Provider
To access the Create/Edit TE Provider window, go to Service Inventory > Inventory and Connection 
Manager > Traffic Engineering Management > TE Providers and click Create.

The Create/Edit TE Provider window in Figure A-3 appears.
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Figure A-3 Create/Edit TE Provider

The Create/Edit TE Provider window contains the following fields:

• Provider Name—Name of the provider to be associated with the TE provider.

• Default Primary RG Timeout—Default computation timeout for primary tunnels.

• Backup RG Timeout—Computation timeout for backup tunnels.

• FRR Protection Type—Fast Re-Route (FRR) protection type:

– Sub Pool—Bandwidth section nested inside the Global Pool part of the total bandwidth.

– Any Pool—Sub Pool or Global Pool. Global Pool is the section of the total link bandwidth 
containing all Sub Pools for the link.

• Default Link Speed Factor—Default multiplication factor to be applied to the link speed in order 
to determine the amount of bandwidth that needs to be protected.

• Minimum Bandwidth Limit—Minimum bandwidth allowed for backup tunnels.

• Max. Load Balancing Tunnel Count—Maximum number of tunnels to be generated for protecting 
an element.

• Region for TE Devices—Name of provider region.

• Customer for Primary Tunnels—Customer for primary TE tunnels.

For step-by-step instructions on how to create or edit TE providers, go to Creating a TE Provider, page 
2-4.
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TE Topology
This section describes the various fields, buttons, and other GUI elements in the TE Topology GUI. For 
instructions on how to use the TE Topology tool, see Chapter 11, “TE Topology”.

ISC TEM includes a TE Topology tool that is accessed as a TE Topology Interface Applet that displays 
the TE topology through a Java applet within the browser.

For specific instructions on how to use the topology applet, see Using the TE Topology Interface Applet, 
page 11-2.

Note There are several ways to access the TE Topology tool, among others by using Inventory and 
Connection Manager > Topology Tool and Inventory and Connection Manager > Traffic 
Engineering Management > Topology Tool. In this section, it is assumed that the TE tools are accessed 
from the Traffic Engineering Management Services page.

Topology Display
To access the TE Topology tool, go to Service Inventory > Inventory and Connection Manager > 
Traffic Engineering Management > TE Topology and select ISC-TEM Topology Interface Applet

The topology display appears immediately as an separate window as shown in Figure A-4.
A-5
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



  

Appendix A      Traffic Engineering Management GUI
  TE Topology
Figure A-4 Topology Display Window

The Topology Display window contains the following menus:

• Repository—Discard or save the layout graph.

• File—Gain access to the print functionality.

• Map—Load or clear maps. Is used to associate a map with a view.

• Graph—Access a range of tools to manage and manipulate graphs.

• Tunnels—View or update the tunnel layout.

• Algorithms—Randomize or optimize links and set spring settings.

• View—Modify the zoom level in the current view.

• Tools—Modify the magnetic grid settings and the layer visibility.

The menus in the Topology Display window are described in more detail below with definitions for 
individual entries.

The Topology Display window toolbar contains the elements shown in Table A-1.
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For instructions on how to use the Topology Display, see Using the TE Topology Interface Applet, page 
11-2.

Repository

The Repository menu in Figure A-5 serves to discard or save the layout graph.

Table A-1 Topology Display Toolbar Elements

Icon Purpose

Print this view.

Zoom the graph by a factor of 200%.

Zoom the graph by a factor of 100%.

Zoom the graph by a factor of 50%.

Toggle antialiasing on/off. When drawing a view, this 
creates smoother lines and a more pleasant appearance at 
the expense of performance.

Start/stop double buffering. This smoothes the lines when 
dragging elements.

Configure the magnetic grid in the current view.

Manage active layers in the current view.
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Figure A-5 Repository Menu

The Repository menu contains the following elements:

• Layout Graph—If a graph layout is already present, the layout is cleared. If not, the layout of the 
elements in the repository is drawn. If a layout has previously been saved, the saved layout is 
re-created. Otherwise, a random layout is generated.

• Save Graph Layout—Save the current graph layout. Doing so ensures that whenever the graph 
layout is cleared with Layout Graph or the Topology Display applet is closed, the same layout is 
created when the applet is restarted.

File

The File menu in Figure A-6 provides access to the print functionality.

Figure A-6 File Menu

The File menu contains the following element:

• Print—Print the current topology view.

Map

The Map menu in Figure A-7 serves to load or clear maps.

Figure A-7 Map Menu

The Map menu contains the following elements:

• Load—Opens the Map Chooser for selecting a topology map.

• Clear—Clears the current topology map.

Load Map

When selecting Load from the Map menu, the Map Chooser window in Figure A-8 appears.
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Figure A-8 Map Chooser

The Map Chooser window contains the following elements:

• Look In—Change the location from where to load the map.

• File Name—Specify the desired file name.

• Files of Type—Select the file type of the files to be displayed.

• Open—Open the selected directory or a topology map.

• Cancel—Close the Map Chooser window.

• File Dialog Commands—Serves to determine the desired directory and level of detail of data files.

The Map Chooser window navigation toolbar contains the elements shown in Table A-2.

Table A-2 Map Chooser Toolbar Elements

Icon Purpose

Move to the parent directory of the current directory.

Return to the home directory.

Create a new folder in the selected directory or, if none are 
selected, the current directory.
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• Projection—Choose the projection in which a map is shown. A map projection is a projection which 
maps a sphere onto a plane. Typical projections are Mercator, Lambert, and Stereographic.

• Longitude Range—Choose a geographical longitude range.

• Latitude Range—Choose a geographical latitude range.

Graph

The Graph menu in Figure A-9 provides access to a range of tools to manage and manipulate graphs.

Figure A-9 Graph Menu

The Graph menu contains the following elements:

• Clear Highlighting—Remove the highlighting of selected elements in the graph layout:

– All elements—Highlighting of all network elements in the graph is cleared.

– Nodes—Highlighting of all nodes in the graph is cleared.

– Links—Highlighting of all links in the graph is cleared.

– Primary Tunnels—Highlighting of all primary tunnels in the graph is cleared.

– Backup Tunnels—Highlighting of all backup tunnels in the graph is cleared.

– Unmanaged Tunnel Paths—Highlighting of all unmanaged tunnel paths in the graph is 
cleared.

– Primary Tunnel Paths—Highlighting of all primary tunnel paths in the graph is cleared.

– Backup Tunnel Paths—Highlighting of all backup tunnels paths in the graph is cleared.

List the contents of the current directory.

Provide type, size, and date and time details about files and 
directories in the current directory.

Table A-2 Map Chooser Toolbar Elements (continued)

Icon Purpose
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– Protected Elements—Highlighting of all protected elements in the graph is cleared.

• Attributes—Opens the Graphics Attributes window in Figure A-10. 

Figure A-10 Graphics Attributes Window

To understand the tools in the Graphics Attributes window, mouse over the various attributes. 
Choose the desired settings for line color, fill color and pattern, line thickness and style, arrow, and 
transparency. 

Click Apply All to activate your selections or Close to quit the Graphics Attributes window.

• Clear—As opposed to the Layout Graph item in the Repository menu, which also clears the 
current graph from the topology display, the Clear function in the Graph menu only clears the graph 
from the current view without re-creating it.

• AntiAlias—Activate antialiasing to smooth lines in the layout.

• BackingStore—Store graphics content when moved to the background and regenerate it when 
moved to the foreground. This helps avoid superfluous refreshing.

• DoubleBuffer—Start/stop double buffering. Smoothes the lines when dragging elements.

Tunnels

The Tunnels menu in Figure A-11 is used to highlight TE tunnels in the network.

Figure A-11 Tunnels Menu

The Tunnels menu contains the following elements:

• Layout—Use Layout the first time you want to highlight tunnels using the repository.

– Unmanaged Tunnels—Highlight unmanaged tunnels only.

– Primary Tunnels—Highlight primary tunnels only.

– Backup Tunnels—Highlight backup tunnels only.
A-11
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



  

Appendix A      Traffic Engineering Management GUI
  TE Topology
Note Selecting Layout repeatedly does not update the display.

• Update—Use Update to update tunnels in the display with the last instance of the repository.

– Unmanaged Tunnels—Update the highlighting of unmanaged tunnels.

– Primary Tunnels—Update the highlighting of primary tunnels.

– Backup Tunnels—Update the highlighting of backup tunnels.

Algorithms

In the Algorithms menu in Figure A-12 various algorithms can be used to enhance and otherwise alter 
the graph layout.

Figure A-12 Algorithms Menu

The Algorithms menu contains the following elements:

• Spring—Applies the Spring algorithm to the current graph layout using the attribute settings in the 
Spring Settings window.

• Randomize—Applies the Randomize algorithm to the nodes in the current topology layout.

• Optimize Links—This feature is used to move overlapping links apart when multiple links are 
present between nodes using the Links Optimization algorithm.

• Spring Settings—The spring settings are used to enhance the appearance of the topology display 
by setting attributes according to user preferences. When selecting Spring Settings, the Spring 
Settings window in Figure A-13 appears.
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Figure A-13 Spring Settings

The Spring Settings menu contains the following elements:

• Propagate—Propagate the various settings in the Spring Settings window to all child layouts.

• Specify layout size—Specify the layout size in pixels.

• Horizonal / vertical alignment—Align the topology graph in the Topology Display.

• Use objects’ sizes—Use the objects’ actual layout sizes without scaling.

• Fix selected objects—Fix the location of selected objects in the Topology Display.

• Automatic edge length—Allow the topology application to automatically assign an appropriate 
length to each link.

• Edge length constant—If Automatic edge length is not selected, you can specify a fixed edge 
length here.

• Repaint period—Sets the period (number of loops) used to repaint objects when the objects are 
being laid out in a graph.

• Epsilon—The epsilon constant determines when the iterative process for the Spring algorithm 
should stop. The greater this constant, the faster the layout, but the more distant the final position 
from the optimal layout.

• Automatic horizontal spacing—Let the topology application automatically determine the 
horizontal spacing between the devices in the graph.

• Horizontal spacing—Specify a fixed horizontal spacing between the devices in the graph.

• Vertical spacing—Specify a fixed vertical spacing between the devices in the graph.
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Once you have made your selections, you can do any of the following:

• Apply—Save the Spring settings.

• Reorder—Rerun the Spring algorithm to reorder the graph elements based on the Spring settings.

• Close—Close the Spring Settings window without saving the selections.

View

The View menu in Figure A-14 allows zooming in the current view.

Figure A-14 View Menu

The View menu contains the following elements:

• Zoom In—Increases the magnification level.

• Zoom Normal—Resets the magnification level to the default setting.

• Zoom Out—Decreases the magnification level.

Tools

The Tools menu in Figure A-15 allows you to modify the magnetic grid settings and the layer visibility. 
Different network elements are drawn in different layers. Individual layers can be turned on or off using 
the Layers menu.

Figure A-15 Tools Menu

The Tools menu contains the following elements:

• Grid—Allows you to add a background grid to the graph based on the selections in the Magnetic 
Grid window.

• Layers—Allows you to select the layers to be dispayed in the graph using the Layer Visibility 
window.

Grid

The Magnetic Grid window in Figure A-16 allows you to modify the magnetic grid settings. An activated 
grid appears under the graph layout in the Topology Display.
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Figure A-16 Magnetic Grid

The Grid window contains the following elements:

• Not activated—Tells the application not to place a magnetic grid in the Topology Display.

• Activated but not visible—The network elements are not visible but still snaps to grid.

• Activated and visible—Make the grid active and visible in the Topology Display.

• Grid spacing—Set the spacing between the lines in the grid.

• Grid color—Click the square to open the color palette to set the grid line color as described in Grid 
Color, page A-15.

• Display points—Display links using dotted lines.

• Display lines—Display links using solid lines.

Click OK to apply the settings or click Cancel to cancel the operation and return to the Topology Display 
window.

Grid Color

The Grid Color window in Figure A-17 has three tabs:

Swatches—The Swatches palette (shown) provides color swatches for making rapid color choices.

HSB—The HSB palette in Figure A-18 is used to set hue, saturation, and brightness.

RGB—The RGB window in Figure A-19 is used to set the color intensity for red, green, and blue, 
respectively.
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Figure A-17 Edit Grid Color - Swatches

Figure A-18 Edit Grid Color - HSB Settings
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Figure A-19 Edit Grid Color - RGB Settings

Make the desired changes and click OK. 

Click Reset to reapply the default settings.

Layers

The various network elements are organized into layers that can be turned on and off to display only the 
part of the TE network that you want to see.

Select Tools > Layers to access the Layer Visilibity window shown in Figure A-20. 

Figure A-20 Layer Visibility
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In the Layer Visibility window, specify which layers should be visible by clicking the corresponding 
check boxes in the Visible column:

• Map Lines—Select to display map lines.

• Map Data—Select to display map data.

• Nodes—Select to display TE nodes.

• Links—Select to display TE links.

• Unmanaged Tunnels—Select to display TE unmanaged tunnels.

• Unmanaged Tunnel Paths—Select to display TE unmanaged tunnel paths.

• Primary Tunnels—Select to display TE primary tunnels.

• Primary Tunnel Paths—Select to display TE primary tunnel paths.

• Computed Primary Tunnel Paths—Select to display paths for computed primary tunnels.

• Backup Tunnels—Select to display TE backup tunnels.

• Backup Tunnel Paths—Select to display TE backup tunnel paths.

Click Apply to apply the settings or click Close to cancel the changes and quit the Layer Visibility 
window.

TE Nodes
This section describes the GUI elements in the TE Nodes tool. 

The nodes of the TE network can be viewed after running a TE Discovery task. For instructions on how 
to run a TE Discovery task, see Chapter 3, “TE Network Discovery.”

The TE Nodes tool gives access to both textual and visual information about the nodes discovered in the 
TE network.

To access the TE Nodes window, go to Service Inventory > Inventory and Connection Manager > 
Traffic Engineering Management > TE Nodes. The TE Nodes List window in Figure A-21 appears.
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Figure A-21 TE Nodes List

The following actions can be performed:

• Close—Close the Topology Display, if open.

• Display—Show the topology for one or more nodes in the TE network.

• Details—Show details for a selected node.

• Find—You can search for particular devices by selecting the device type in the drop-down menu 
Show Devices with and specify matching criteria in the TE routers matching field.

Display TE Nodes
The Topology Display can be invoked to highlight selected nodes. 

Go to Service Inventory > Inventory and Connection Manager > Traffic Engineering Management. 
Click TE Nodes. Select one or more devices by clicking the corresponding check boxes. Click the 
Display button. The Topology Display applet in Figure A-22 appears.
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Figure A-22 TE Nodes Topology Display

For a description of how to use the Topology Display features, see Topology Display, page A-5.

View Node Details
To view the detailed information about a particular node, use the following steps, go to Service 
Inventory > Inventory and Connection Manager > Traffic Engineering Management > TE Nodes.

Select a device by clicking the corresponding check box. Click the Detail button. The TE Node Details 
window in Figure A-23 appears.

Figure A-23 TE Node Details
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The TE Node Details window contains the following fields:

• Router Name—Hostname of the router

• IP Address—IP address of the router

• MPLS TE lD—TE ID assigned by the router

• Interfaces—TE interfaces on the routers

• Topology Map Coordinates—Coordinates of the nodes in the Topology Display.

Click OK to close the TE Node Details window.

TE Links
This section describes the GUI elements in the TE Links tool. 

The links of the TE network can be viewed after running a TE Discovery task. For instructions of how 
to run a TE Discovery task, see Chapter 3, “TE Network Discovery.”

The TE Links window gives access to both textual and visual information about the links discovered in 
the network.

To access the TE Links window, go to Service Inventory > Inventory and Connection Manager > 
Traffic Engineering Management > TE Links. The TE Links List window in Figure A-24 appears.

Figure A-24 TE Links List

The columns in the links list table provides the following information:

• End Device A—Hostname on endpoint A of the link.
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• Interface A—Interface name on endpoint A of the link.

• End Device B—Hostname on endpoint B of the link.

• Interface B—Interface name on endpoint B of the link.

• Label—IP addresses of the interfaces on the link.

• Admin Status—Indicates whether the link is UP or DOWN.

Note This is local to ISC TEM. It is not the network interface status.

The following actions can be performed:

• Close—Close the Topology Display applet if open.

• Display—Open the Topology Display applet to visualize one or more links in the TE network.

• Details—Show link details.

• Show Tunnels—Display only tunnels that meet the following criteria (see Figure A-25):

– All—Show all tunnels.

– Managed—Show managed tunnels.

– Unmanaged—Show unmanaged tunnels.

– All Primary—Show all primary tunnels.

– Backup—Show backup tunnels.

For more information about the Show Tunnels feature, see Show Tunnels, page A-25.

Figure A-25 Show Tunnels Options

• Edit:

– Interface A—Edit the resources associated with interface A on the link.

– Interface B—Edit the resources associated with interface B on the link.

• Change Status:

– Enable—Make a link active (UP in the Admin Status column).

– Disable—Deactivate a link (DOWN in the Admin Status column).

• Proceed with Changes >> (see Figure A-26): For verifying a committing resource change that 
might impact tunnel placement. 

– Tunnel Audit—If you disable an interface, Tunnel Audit checks if the status change affects 
Tunnel Placement.

– Tunnel Repair—If Tunnel Audit reveals that Tunnel Placement is affected, Tunnel Repair can 
be used to move the tunnel away from the links to be disabled.
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Figure A-26 TE Links List - Proceed with Changes

• Cancel—Cancel the operation and return to the Traffic Engineering Management Services window.

• Find—You can search for particular links by specifying a device type or a label in the drop-down 
menu Show TE Links with and specifying matching criteria in the Matching field.

Display TE Links
The Topology Display can be invoked to highlight selected links. 

Go to Service Inventory > Inventory and Connection Manager > Traffic Engineering Management 
> TE Links. Select one or more devices by clicking the corresponding check boxes. Click the Display 
button. The Topology Display Applet in Figure A-4 appears.

For a description of how to use the Topology Display features, see Using the TE Topology Interface 
Applet, page 11-2.

For an explanation of the GUI elements in the TE Topology Display applet, see Topology Display, page 
A-5.

View Link Details
To view the detailed information about a particular link, go to Service Inventory > Inventory and 
Connection Manager > Traffic Engineering Management > TE Links. Select a device by clicking the 
corresponding check box. Click the Detail button. The TE Objects Details window in Figure A-27 
appears.
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Figure A-27 TE Objects Details

The TE Links Details contains the following fields:

• Link—IP addresses of Endpoint A and Endpoint B.

• Endpoint A/Endpoint B:

– Device—Hostname of the device.

– Interface—Interface name.

– TotalAllocated BW—The total amount of allocated bandwidth on the link by tunnel hold 
priority (bw[0]-bw[7]).

– GlobalPool BW—The allocated Global Pool bandwidth on the link by tunnel hold priority 
(bw[0]-bw[7]).
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– SubPool BW—The allocated Sub Pool bandwidth on the link by tunnel hold priority 
(bw[0]-bw[7]).

– GlobalUtil—Global Pool bandwidth utilization percentage.

– SubpoolUtil—Sub Pool bandwidth utilization percentage.

– Managed TotalAllocated BW—The total amount of allocated managed bandwidth (hold 
priority 0).

– Managed GlobalPool BW—The total amount of allocated managed bandwidth (hold priority 
0) in the Global Pool.

– Managed SubPool BW—The total amount of allocated managed bandwidth (hold priority 0) 
in the Sub Pool.

– Managed GlobalUtil (%)—Global Pool bandwidth utilization percentage for a managed 
tunnel.

– Managed SubpoolUtil (%)—Sub Pool bandwidth utilization percentage for a managed tunnel.

• Admin Status—Indicates whether the link is Up or Down.

Show Tunnels
This feature allows you to display which TE tunnels (primary and/or backup) a particular TE Link is 
using and helps facilitate the tunnel planning and placement processes. In addition, you can see which 
tunnels are impacted when an interface (or link) in the TE network is shut down.

To view specific types of tunnels using the Show Tunnels button, go to Service Inventory > Inventory 
and Connection Manager > Traffic Engineering Management > TE Links. Select the desired link in 
the TE Links List (Figure A-24) and click Show Tunnels and select the type of tunnel you want to list.

The Show TE Tunnel List window in Figure A-28 appears.

Figure A-28 Show TE Tunnel List

The TE Managed Primary Tunnels SR window contains the following elements:

The columns in the tunnel list provides the following information:

• Tunnel ID—Unique tunnel identifier used within ISC TEM.

• T#—Tunnel number on the head router.

• Head—Hostname of the head router.

• Dest—Hostname of the destination router.
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• Tunnel Type—Type of tunnel (managed or unmanaged).

• Deploy Status—Tunnel deployment status.

• Policy—TE policy for the tunnel.

• BW—Tunnel bandwidth. If the tunnel is auto-bw enabled, BW shows the higher of tunnel 
bandwidth and maximum automatic bandwidth.

• BW Quota—The amount of bandwidth this backup tunnel can protect. The router limits the LSPs 
that can use this backup tunnel so that the sum of the bandwidth of the LSPs does not exceed the 
specified amount of bandwidth. If there are multiple backup tunnels, the router will use the best-fit 
algorithm.

To view the tunnel details for a particular tunnel, select the tunnel in question and click Detail.

Figure A-29 Show Tunnels - TE Objects Details

For an explanation of the various GUI elements, see View Managed Primary Tunnel Details, page A-42.

Edit Interface
To edit information about a particular link, go to Service Inventory > Inventory and Connection 
Manager > Traffic Engineering Management > TE Links. Select the desired link in the TE Links 
List (Figure A-24). Click Edit > Interface A or Edit > Interface B to edit one of the interfaces on the 
link.

The TE Resource Modification window in Figure A-30 appears.
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Figure A-30 TE Resource Modification

The TE Resource Modification window contains the following fields:

• Device/Interface—Name of device and interface.

• Peer Device/Interface—Name of device and interface for the other endpoint of the link.

• Description—Service request description.

• Link Bandwidth—Total bandwidth of the link.

• Max Global (BC0) Reservable—Maximum amount of bandwidth, in kbps, that might be allocated 
by Resource Reservation Protocol (RSVP) flows.

• Max Sub Pool (BC1) Bandwidth—Maximum amount of bandwidth in kbps to be reserved to a 
portion of the total. The range is from 1 to the value of Max Global Reservable.

• Attribute Bits—Links attributes to be compared to a tunnel's affinity bits during selection of a path. 
Valid values are from 0x0 to 0xFFFFFFFF, representing 32 attributes (bits) where the value of an 
attribute is 0 or 1.

• TE Metric—Metric used to override the Interior Gateway Protocol (IGP) administrative weight 
(cost) of the link.

• Propagation Delay—The time it takes for traffic to travel along a link from the head interface to 
the tail interface.

• Max Delay Increase—Used in computations of FRR backup-tunnels to constrain the propagation 
delay of a backup-tunnel for the link.
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• Link Speed Factor—Multiplication factor to be applied to the link speed in order to determine the 
amount of bandwidth that needs to be protected. 

The following actions can be performed:

• Continue >>—Proceed to the confirmation page shown in Figure A-31.

• Cancel—Cancel the operation and return to the TE Links List window.

Figure A-31 TE Resource Modification (Confirmation Page)

The Confirmation Page provides a view-only snapshot of the SR data and offers the following options:

• << Edit—Return to the TE Resource Modification window.

• Proceed with Changes >> (Figure A-32)—For verifying a committing resource change that can 
impact tunnel placement.

– Tunnel Audit—If you change a resource, Tunnel Audit checks if the change affects Tunnel 
Placement.

– Tunnel Repair—If Tunnel Audit reveals that Tunnel Placement is affected, Tunnel Repair can 
be used to move the affected tunnel.
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Figure A-32 TE Links List - Proceed with Changes

• Save & Deploy (Figure A-33)—For committing resource changes that do not impact tunnel 
placement. There are two options for saving and deploying the resource modification SR to the 
network:

– Deploy—Use Deploy when the service request state is Requested or Invalid. This places the 
Resource Modification SR in the deployment queue.

– Force Deploy—Use Force Deploy when the service request state is Deployed or Failed Audit. 
This could be useful when the provisioning failed, so that you need to force through the 
deployment of the Resource Modification SR for this provider to the network. 

Figure A-33 TE Links List - Save & Deploy Tunnels

TE SRLGs
This section describes the GUI elements in the TE SRLGs tool. It is used to manage Shared Risk Link 
Groups (SRLGs) as part of ISC TEM protection management.

To access the TE SRLGs window, go to Service Inventory > Inventory and Connection Manager > 
Traffic Engineering Management > TE SRLGs. The TE SRLG List window in Figure A-37 appears.

Figure A-34 TE SRLG List

The TE SRLG List window lists SRLGs by name.

The following actions can be performed:

• Close—Close the Topology Display.
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• Display—Open the Topology Display applet to visualize the SRLG. 

• Create—Create an SRLG.

• Edit—Edit an SRLG.

• Delete—Delete one or more SRLGs.

• Show SRLG with—You can search for particular SRLGs by specifying matching criteria in the 
Matching field and clicking Find.

Create/Edit TE SRLG
This section describes the GUI elements in the TE SRLG Editor, which is used to both create and edit 
SRLGs.

The process of creating an SRLG is described in Create SRLG, page 7-2.

To access the TE SRLG Editor, go to Service Inventory > Inventory and Connection Manager > 
Traffic Engineering Management > TE SRLGs. In the TE SRLGs window, to create an SRLG click 
Create or to edit or select an SRLG that you want to edit by clicking the corresponding check box and 
clicking Edit.

In either case, the TE SRLG Editor window in Figure A-35 appears.

Figure A-35 TE SRLG Editor
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The TE SRLG Editor window contains the following GUI elements:

• Provider Name—Name of the TE provider.

• SRLG Name—Unique name to identify the SRLG.

The columns in the TE SRLG Editor provide the following information:

• Device From—Hostname of the TE device that the path originates from.

• Label—IP addresses of the source and destination interfaces.

• Device To—Hostname of the TE destination device.

The following actions can be performed:

• Add Link—Add a link to the SRLG.

• Remove Link—Remove selected links from the SRLG.

• Save—Save the created or modified SRLG.

• Cancel—Cancel the operation and return to the TE SRLG List window.

Step 4 When clicking Add Link to associate a link with the SRLG, the links associated with the SRLG window 
in Figure A-36 appears. This table displays links that can be added to the SRLG.

Figure A-36 Links associated with SRLG

The columns in the TE SRLG Editor provide the following information:

• From Device—Hostname of the TE device that the path originates from.

• Link—IP addresses of the source and destination devices.

• To Device—Hostname of the TE destination device.

The following actions can be performed:

• Select—Add selected links to the SRLG.
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• Cancel—Cancel the operation and return to the TE SRLG Editor window.

• Show Links with—You can search for particular links by specifying matching criteria in the 
Matching field and clicking Find.

TE Explicit Paths
This section describes the GUI elements in the TE Explicit Path tool. 

TE explicit paths can be created after the execution of a TE Discovery task. For instructions on how to 
create an explicit path, see Create Explicit Path, page 5-3.

To access the TE Explicit Path List window, go to Service Inventory > Inventory and Connection 
Manager > Traffic Engineering Management > TE Explicit Paths. The TE Explicit Path List window 
in Figure A-37 appears.

Figure A-37 TE Explicit Path List

The columns in the TE Explicit Path list provides the following information:

• Path Name—Name of the explicit path.

• Head—Hostname of the head router.

• Dest—Hostname of the destination router.
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The following actions can be performed:

• Create—Create an explicit path.

• Edit—Edit an explicit path.

• Delete—Delete an explicit path.

• Find—You can search for particular links by selecting the search variable in the drop-down menu 
Show Paths with and specify matching criteria in the Matching field.

Create/Edit Explicit Path
This section describes the elements in the create and edit explicit path windows.

To create or edit an explicit path, see Create Explicit Path, page 5-3.

To create or modify an explicit path, go to Service Inventory > Inventory and Connection Manager 
> Traffic Engineering Management > TE Explicit Paths. In the TE Explicit Path List window, click 
Create to create an explicit path. To edit an explicit path, select the explicit path that you want to edit 
by clicking the corresponding check box and clicking Edit.

When clicking the Create button, the New TE Explicit Path window in Figure A-38 appears. A similar 
window appears when clicking the Edit button.

Figure A-38 New TE Explicit Path

The New TE Explicit Path window contains the following GUI elements

• Path Name—Name of explicit path.

• Head Router—Name of the head router.

• Links (table)—Lists the links added for the current path and contains the following information:

– Device—Hostname of the TE device that the path originates from.

– Outgoing Interface—Interface name of the outgoing interface from the originating device.
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– Outgoing IP—IP address of the outgoing interface.

– Next Hop—Hostname of the next hop device.

– Incoming Interface—Incoming interface name on the next hop device.

– Incoming IP—Incoming interface IP address on the next hop device.

• Provision Preference—Preference for provisioning the next-address subcommand of the ip 
explicit-path command. Choose between Outgoing Interface and Incoming Interface.

– Outgoing Interface—Outgoing interface on the router.

– Incoming Interface—Incoming interface on the router.

The following actions can be performed:

• Add Link—Add a link to the explicit path.

• Delete Link—Delete a link in the explicit path.

• Save—Save all the explicit path data entered.

• Cancel—Cancel the operation and return to the TE Explicit Path List window.

Step 5 When clicking Add Link to add a blank line to the hop list table, the Select Next Hop window in 
Figure A-39 appears.

Figure A-39 Select Next Hop

The columns in the TE Explicit Path list provide the following information:

• Outgoing Interface—Interface name of the outgoing interface from the originating device.

• Outgoing IP—IP address of the outgoing interface.

• Next Hop—Hostname of the next hop device.

• Incoming Interface—Incoming interface name on the next hop device.

• Incoming IP—Incoming interface IP address on the next hop device.
A-34
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



  

Appendix A      Traffic Engineering Management GUI
  TE Protected Elements
TE Protected Elements
This section describes the TE Protected Elements GUI. 

For instructions on how to configure protected elements, see Configure Element Protection, page 7-5.

Accessing Protection Management
To access the TE Protection Management window, go to Service Inventory > Inventory and 
Connection Manager > Traffic Engineering Management. Click TE Protected Elements.

The TE Protection Management window in Figure A-40 appears.

Figure A-40 TE Protection Management

The columns in the TE Protection Management table provide the following information:

• Element Name—Name of the network element to be protected.

• Type—Network element type (node, link, or SRLG).

• Protection Status—The protection status displayed is determined from the last time an audit was 
performed. The audit is performed either explicitly by the user or when the protection SR is 
deployed. The protection status is stated for each network element as either Protected, Not Fully 
Protected, or Unknown. Click on the column header, Protected, to sort elements according to 
protection status.

The following actions can be performed:

• Close—Close topology.

• Display—Open the Topology Display applet to visualize one or more protected elements.

Figure A-41 Compute Backup Button
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• Compute Backup (Figure A-41)—Automatically calculate the optimal backup tunnel for:

– All Elements—all network elements listed, whether selected or not.

– Selected Elements—all selected network elements.

Figure A-42 Audit Protection

• Audit Protection (Figure A-42)—Perform a protection audit on:

– All Elements—all network elements listed, whether selected or not.

– Selected Elements—all selected network elements.

• Add—Add a new protection element.

• Delete—Delete a protection element. 

• Cancel—Cancel the operation and return to the Traffic Engineering Management Services window.

• Find—You can search for particular elements by selecting the All, Node, Link, or SRLG in the 
Show drop-down menu and specify matching criteria in the Matching field.

Compute Backup
This section describes the Compute Backup GUI. 

For instructions on how to run Compute Backup on all or selected elements, see Configure Element 
Protection, page 7-5.

To run Compute Backup, go to Service Inventory > Inventory and Connection Manager > Traffic 
Engineering Management > TE Protected Elements. The TE Protection Management window in 
Figure A-40 appears.

In the TE Protection Management window, select one or more elements for which you want ISC TEM 
to calculate a backup path. 

Click Compute Backup and select one of the following:

• All Elements

• Selected Elements

The window in Figure A-43 appears.
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Figure A-43 TE Protection Computation Results

The Element: table displays the outcome of the computation for each element in the protection 
computation. The status for each element is indicated by at least one row per element in the table. If the 
status is not valid, the table will contain one row per warning or violation.

The Element: table contains the following columns:

• Element Name—Name of the network element to be protected.

• Type—Network element type (node, link, or SRLG).

• Report—Warning or computation on the network element reported by the computation engine.

• Status—Computation status of the network element.

The following actions can be performed:

• Close—Close the Topology Display applet if open.

• Display—Open the Topology Display applet to visualize one or more protected elements and their 
protection tunnel(s). The Topology Display is shown in Figure A-4.

• Details—List backup tunnels and violations/warnings for the selected network element. The 
information is displayed in the Backup Tunnels: section and the Violation and Warning: section, 
if applicable, as shown in Figure A-44.

Violation and Warning: pane—Describes the selected violation/warning and any relevant details about 
the corresponding link or flow.
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Figure A-44 TE Protection Computation Results with Backup Tunnels

The columns in the tunnel list provide the following information:

• Op—SR operation on the tunnel. This can be either of the following:

– ADD—Indicates a new tunnel calculated by the computation.

– DELETE—Signifies that the computation found an existing backup tunnel that do not provide 
adequate protection on the element and, therefore, should be deleted.

• Tunnel ID—Unique tunnel identifier used within ISC TEM.

• Head—Hostname of the head router.

• Dest—Hostname of the destination router.

• T#—Tunnel number on the head router.

• BW—The amount of bandwidth this backup tunnel can protect. The router limits the LSPs that can 
use this backup tunnel so that the sum of the bandwidth of the LSPs does not exceed the specified 
amount of bandwidth. If there are multiple backup tunnels, the router will use the best-fit algorithm.

• Path—Tunnel path in the form of either a computed path or an existing path . Click to view the path.

• Protection Type—Protection side-effect from activating the tunnel.

• Report—If it says yes in the Report field, the tunnel is associated with the selected 
violation/warning. A blank field indicates that no report was generated.
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The following actions can be performed (buttons):

• Accept Solution—Accept the proposed element protection solution and place the backup tunnels in 
the TE Protection SR window for further action.

• Cancel—Discard the proposed element protection solution and return to the TE Protection 
Management window.

• Find—You can search for particular elements by selecting the element type in the drop-down menu 
Show and specifying matching criteria in the with name matching field.

Audit Protection
This section describes the Audit Protection GUI. 

For instructions on how to run Audit Protection on all or selected elements, see Configure Element 
Protection, page 7-5.

To run Audit Protection, go to Service Inventory > Inventory and Connection Manager > Traffic 
Engineering Management > TE Protected Elements. The TE Protection Management window in 
Figure A-40 appears.

In the TE Protection Management window, select one or more elements for which you want ISC TEM 
to perform an Audit Protection computation. 

Click Audit Protection and select one of the following:

• All Elements

• Selected Elements

ISC TEM reports FRR Audit Protection in progress and the same computation result window as for 
Compute Backup in Figure A-43 appears.

The GUI for the rest of the process is identical to that described for Compute Backup, page A-36.

Assign TE Resources
To access the TE Resource Management part of the TEM GUI, click Assign TE Resources in the Traffic 
Engineering Management Services window (see Figure A-1).

The graphical user interface for Assign TE Resources is identical to that of TE Links. For an 
explanation of the GUI elements of this window, see TE Links, page A-21.

The process of assigning TE resources is explained in Chapter 4, “TE Resource Management.”

Create Managed TE Tunnel
In this section, the GUI used to create managed traffic engineering tunnels is explained. For step-by-step 
instructions on how to create a managed TE tunnel, see Chapter 5, “Basic Tunnel Management.”

To access the Create Managed TE Tunnel window, go to Service Inventory > Inventory and 
Connection Manager > Traffic Engineering Management > Create Managed TE Tunnel.

The TE Managed Primary Tunnels SR window in Figure A-45 appears.
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Figure A-45 TE Managed Primary Tunnels SR

The TE Managed Primary Tunnels SR window contains the following elements:

The columns in the tunnel list provides the following information:

• Op—SR operation on the tunnel. This can be one of the following:

– ADD—Indicates a newly added tunnel.

– MODIFY—Indicates a modified existing tunnel.

– DELETE—Indicates an existing tunnel to be deleted.

– ADMIT—Indicates an existing tunnel to be admitted by tunnel computation.

• Tunnel ID—Unique tunnel identifier used within ISC TEM.

• T#—Tunnel number on the head router.

• Head—Hostname of the head router.

• Dest—Hostname of the destination router.

• Policy—TE policy for the tunnel.

• BW—The amount of bandwidth this backup tunnel can protect. The router limits the LSPs that can 
use this backup tunnel so that the sum of the bandwidth of the LSPs does not exceed the specified 
amount of bandwidth. If there are multiple backup tunnels, the router will use the best-fit algorithm. 
If the tunnel is auto-bw enabled, BW shows the higher of tunnel bandwidth and maximum automatic 
bandwidth.

• AutoBW—Auto Bandwidth enabled if true, otherwise false.

• Deploy Status—Tunnel deployment status.
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• Verified—Indicates whether tunnel verification was successful (succeed, failed, or unknown).

• Allow Reroute—Specifies whether reroute is allowed (true or false). If reroute is not allowed, the 
tunnel cannot be set to movable, and hence cannot be rerouted by the repair operation.

The following actions can be performed (buttons):

• Close—Close the Topology Display applet if open.

• Display—Open a Topology Display for the network and highlight the selected primary tunnel(s). 
Selected tunnels are marked in color with directional arrows.

• Details—Open the TE Tunnel Details window, which provides type, status, LSP, and other 
information about the tunnel.

• Admit—Admit selected tunnels not previously verified into the managed topology. This feature is 
used only for discovered tunnels that failed verification or for migrating unmanaged tunnels.

• Create—Create a managed primary tunnel.

• Edit—Edit a selected primary tunnel.

• Delete—Delete selected primary tunnels.

• Import—Import tunnel data from import XML file.

• Placement Tools—These tools are available only when no change has been made to the tunnels. 
Apply the following functions against the current topology and tunnels:

– Groom—Analyze elements (nodes, links, or SRLGs) in the TE network and optimize the way 
they handle the network traffic.

– Tunnel Audit—Determine if any inconsistencies exist in the TE network.

– Tunnel Repair—Resolve inconsistencies in the TE network by moving as few existing tunnels 
as possible to accomodate the changes.

The Placement Tools GUI is described in Planning Tools, page A-51.

• Proceed with Changes >>—For verifying changes in tunnels. When tunnels have been created, 
deleted, admitted, or their attributes altered, you can proceed with one of the following placement 
tools:

– Tunnel Audit—Determine what inconsistencies modifications to tunnels or network elements 
might cause.

– Tunnel Placement—Admit new tunnels and modify tunnels already admitted into the network.

– Tunnel Repair—Resolve inconsistencies caused by changes to bandwidth requirements or 
delay parameters of existing tunnels by moving as few existing tunnels as possible to 
accomodate the changes.

• Save & Deploy (Figure A-46)—For committing tunnel changes that do not impact tunnel 
placement. There are two options for saving and deploying SR tunnels to the network:

– SR Tunnels Only—Deploy all tunnel changes that does not impact tunnel placement, or if no 
changes were made to the SR, use this to re-deploy the SR that was in Requested or Invalid 
state.

– Force Deploy All Tunnels—Force deployment of all tunnels in this SR. This could be useful 
when previous provisioning of the SR has failed, so that it is necessary to force through the 
deployment of all tunnels in the SR.
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Figure A-46 Save & Deploy Tunnels

• Cancel—Cancel the operation and return to the Traffic Engineering Management Services window.

The tunnel SR search tool allows you to look for particular tunnels by selecting tunnel characteristics in 
the drop-down menu tunnels with and specify matching criteria in the Matching field:

• Show:

– Existing—Show existing tunnels already deployed in the TE network.

– SR—Show tunnels not yet deployed in the TE network.

• Tunnels with:

– All—Show all managed tunnels under the current provider.

– Tunnel Number—Tunnel number on the head router.

– Head Device—Full or partial name of the tunnel head device.

– Destination Device—Full or partial host name of the tail device of the tunnel.

– Head, Dest Devices—Exact host name of the head and tail devices of the tunnel.

– Deploy Status—Tunnel deployment status.

– Policy Name—Name of the TE policy.

• Matching/Equal—Specify matching criteria for your search. Wildcards are accepted. Matching 
changes to Equal if Head, Dest Device is selected in the drop-down menu. For Equal, the exact 
host name of the head or tail device must be entered (wildcards not accepted).

• Find—Click the Find button when the search criteria has been entered.

View Managed Primary Tunnel Details
This section describes the elements in the TE Managed Primary Tunnel Details window.

To view the details of a TE managed primary tunnel, go to Service Inventory > Inventory and 
Connection Manager > Traffic Engineering Management. > Create Managed TE Tunnel. The TE 
Managed Primary Tunnels SR window in Figure A-45 appears.

To view the details of a particular managed primary tunnel, select the desired tunnel by first clicking the 
corresponding check box and then clicking the Details button. When clicking Details, the TE Tunnel 
Details window in Figure A-47 appears.
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Figure A-47 TE Tunnel Details

The TE Tunnel Details window contains the following elements:

• Type—Managed or unmanaged.

• Tunnel—Tunnel name, head and destination routers, and total bandwidth.

• Status—The operational and administrative status of the TE tunnels as of the latest TE Discovery 
task.

• State—Indicates whether the tunnel state is DEPLOYED or NOT DEPLOYED and whether it is 
Conformed or Not Conformed.

• LSP configured—IP address of the tunnel’s Label-Switched Path (LSP) interface on the head 
router.

• LSP in use—Actual LSP in the network as of the latest TE Discovery task.

• AutoBW—Auto Bandwidth Enabled or Disabled.

Create TE Managed Primary Tunnel SR
This section describes the GUI elements in the Create TE Managed Primary Tunnel SR and Edit TE 
Managed Primary Tunnel windows. The create feature is here used as an example.

To create a TE Managed Primary Tunnel SR, see Chapter 5, “Basic Tunnel Management.” 

To access the Create TE Managed Primary Tunnel SR window, go to Service Inventory > Inventory 
and Connection Manager > Traffic Engineering Management > Create Managed TE Tunnel. The 
TE Managed Primary Tunnels SR window appears. Click Create, to open the Create TE Managed 
Primary Tunnel window as shown Figure A-48.
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Figure A-48 Create TE Managed Primary Tunnel

The Create TE Managed Primary Tunnel window contains the following elements:

• Head Device—Head device for the tunnel.

• Destination Device—Destination device for the tunnel. 

• Tunnel Policy—A set of rules established for a tunnel. 

• Tunnel Bandwidth—Total allocated bandwidth of the tunnel.

• Tunnel Number—Tunnel number corresponding to the tunnel interface name.

– Auto Gen—Check this box to generate the tunnel number automatically. Otherwise, enter a 
desired number.

• Customer—Selected customer for the tunnel.

• Auto BW—A way to configure a tunnel for automatic bandwidth adjustment and to control the 
manner in which the bandwidth for a tunnel is adjusted.

– Enable—Check this box to enable automatic bandwidth.

– Freq—Interval between bandwidth adjustments.
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– Min—Minimum automatic bandwidth, in kbps, for this tunnel.

– Max—Maximum automatic bandwidth, in kbps, for this tunnel.

Path options:

• Option #—Sequential number of available explicit paths.

• Path Name—Name of the explicit path. In case of an existing path, the name is a URL that links to 
the Explicit Path Viewer (see Figure 5-15).

– System Path—ISC system generated explicit path (immovable). For managed tunnels, the first 
path has to be an explicit path. If a tunnel contains a system path, the planning function will 
generate an optimal path for the tunnel.

– Dynamic Path—A dynamic path is provisioned by allowing the head router to find a path. The 
dynamic keyword is provisioned to the routers.

• Path Type—Path option type, Explicit or Dynamic.

• Lock Down—Disables reoptimization check on the tunnel, if checked, meaning the path cannot be 
changed.

The following actions can be performed:

• Add—Add a path option. This opens the Select TE Explicit Path window in Figure A-52.

• Delete—Delete a path option.

• OK—Accept all changes and return to the TE Managed Primary Tunnels SR window. 

• Cancel—Cancel the operation and return to the TE Managed Primary Tunnels SR window.

Select Devices and Policy

To select a Head Device in the Create TE Managed Primary Tunnel window (Figure A-48), click the 
corresponding Select button to open the Select Device for TE Head Router window shown in 
Figure A-49.
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Figure A-49 Select Device for TE Head Router

The Select Device for TE Head Router window contains the following elements:

• Device Name—Hostname for the device.

• IGP ID—Interior Gateway Protocol (IGP) ID.

• MPLS TE ID—TE ID assigned by the router. 

• Admin Status—Indicates whether the router is UP or DOWN.

The following actions can be performed:

• Select—Accept the selected device and return to the previous window. 

• Cancel—Cancel the operation and return to the previous window.

• Find—You can search for particular devices by selecting the device type in the drop-down menu 
Show Devices with and specify matching criteria in the Matching field.
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Figure A-50 Select Device for TE Tail Router

For a description of the GUI elements in the Select Device for TE Tail Router window, see the 
explanation for the Select Device for TE Head Router window.

Figure A-51 Select Managed TE Tunnel Policy

The Select Managed TE Tunnel Policy window contains the following elements:

• Policy Name—Name of the TE policy.

• Pool Type—Tunnel bandwidth pool type.

– SUB POOL—Bandwidth section nested inside the Global Pool part of the total bandwidth.

– GLOBAL—Section of the total link bandwidth containing all Sub Pools for the link.

• Setup Priority—Priority used when signaling an LSP for the tunnel to determine, which of the 
existing tunnels can be preempted. Valid values are from 0 to 7, where a lower number indicates a 
higher priority. Therefore, an LSP with a setup priority of 0 can preempt any LSP with a non-0 hold 
priority.
A-47
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



  

Appendix A      Traffic Engineering Management GUI
  Create Managed TE Tunnel
• Hold Priority—Priority associated with an LSP for the tunnel to determine if it should be 
preempted by other LSPs that are being signaled. Valid values are from 0 to 7, where a lower number 
indicates a higher priority.

• Affinity—Attribute values required for links carrying the tunnel (bit values are either 0 or 1).

• Affinity Mask—Attribute values to be checked. If a bit in the mask is 0, a link's attribute value of 
that bit is irrelevant. If a bit in the mask is 1, the link's attribute value and the tunnel's required 
affinity for that bit must match.

• Delayed Constraint—Delay constraint for the path used by the tunnel.

• FRR Protection—Used to enable an MPLS traffic engineering tunnel to use a backup tunnel in the 
event of a link failure if a backup tunnel exists.

– None—No backup tunnel needed.

– Best Effort—Use backup tunnel if available.

– Link and SRLG—Specifies that primary tunnels should be routed only through links and 
SRLGs that are protected by FRR backup tunnels. 

– Link, SRLG and Node—Specifies that primary tunnels should be routed only through links, 
SRLGs and nodes that are protected by FRR backup tunnels.

Select TE Explicit Path

An explicit path is added to a tunnel by clicking Add in the tunnel editor. The Select TE Explicit Path 
window in Figure A-52 appears.

Figure A-52 Select TE Explicit Path

Two path types are available:

Explicit Path—A fixed path from a specific head to a specific destination device. 

Dynamic Path—A path that is provisioned by allowing the head router to find the path. The dynamic 
IOS keyword is provisioned to the routers. This signifies that the router calculates a valid path.

Explicit Path Viewer

When creating a primary tunnel, the Path Options list by default suggests a System path and a Dynamic 
path. If an explicit path is added, this link will be selectable as shown in the Path Options section of the 
create window in Figure A-53. By clicking an explicit path link, a non-editable Explicit Path Viewer in 
Figure A-54 appears.
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Figure A-53 Path Options

For an explanation of the various GUI elements, see Create Managed TE Tunnel, page A-39.

Figure A-54 TE Explicit Path Viewer

For an explanation of the various GUI elements, see Create/Edit Explicit Path, page A-33.

Import Tunnel

This section describes the GUI elements in the import tunnel feature. 

For instructions on how to import TE tunnels, see the Import Primary Tunnel, page 6-8.

The tunnel import function is found under Service Inventory > Inventory and Connection Manager 
> Traffic Engineering Management > Create Managed TE Tunnel, which opens the TE Managed 
Primary Tunnels SR window (see Figure A-62).

When you click Import to start the import process, the Select Import File window in Figure A-55 
appears.

Note The Import button is only enabled when there are no uncommitted new, changed, or deleted 
tunnels in the service request.
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Figure A-55 Select Import File

The Select Managed TE Tunnel Policy window contains the following elements:

• File Name—Name of XML file.

• Size—Size in kilobytes of XML file.

• Last Modified—Date and time when the file was last modified.

The following actions can be performed:

• Select—Accept the selected XML file(s) and start the tunnel import operation. 

• Cancel—Cancel the tunnel import operation and return to the TE Managed Primary Tunnels SR 
window.

• Find—Specify the directory containing the XML import files and directories to import in the Look 
in field and click Find. This brings up the data import directory and the XML files contained are 
listed in the accompanying table.

• Up—Go to the parent directory.

Import Error Status Window

When you click Select to start the import operation, the system parses the file, and if any error is 
detected, it will be reported in the Tunnel Import Error Status window shown in Figure A-56. 
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Figure A-56 Tunnel Import Error Status

The Tunnel Import Error Status window contains the following elements:

• Import File—Directory containing XML import files and directories.

• Last Modified—Date and time when the file was last modified.

• Import Status—There are two possible Import Status values: 

– Failed—Critical errors are present and the import process cannot continue.

– Partial Success—There are either non-critical errors or warnings or both in the file.  In this case 
the error tunnel is reported and skipped and the warning tunnel is processed with certain defaults 
applied.  There is no “Success” status because when there are no errors or warnings, the Tunnel 
Import Error Status window will not appear.

The following actions can be performed:

• Continue—If the import operation is partially successful, click Continue to accept system 
treatment for errors/warnings and continue with the import operation. 

• Cancel—Cancel import operation and return to the previous window.

Edit TE SR (Primary or Backup)
The tunnels editor windows differ only very slightly from the create tunnel windows. All fields in the 
editor windows are found in the create windows for both primary managed, primary unmanaged, and 
backup tunnels (see Chapter 5, “Basic Tunnel Management”).

The only difference from the create window is that the head and destination device and tunnel number 
fields are not editable and the Path Options table lists existing path options on the tunnel rather than the 
default System and Dynamic paths.

Planning Tools
This section describes the GUI elements in the sequence of windows used by the planning tools Tunnel 
Audit, Tunnel Placement, Tunnel Repair, and Grooming. Screenshots from Tunnel Repair has been used 
as an example but it covers the GUI elements for all four processes.
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To use the planning tools, see Placement Tools, page 6-11 

To access the Create TE Managed Primary Tunnel SR window, go to Service Inventory > Inventory 
and Connection Manager > Traffic Engineering Management > Create Managed TE Tunnel. The 
TE Managed Primary Tunnels SR window in Figure A-62 appears.

There are two ways to activate the planning tools:

• When one or more tunnels have been created or their attributes altered (see Create Primary Tunnel, 
page 6-2), Tunnel Audit, Tunnel Placement, and Tunnel Repair can be activated by selecting 
Proceed with Changes >>. 

• When no changes have taken place, Grooming, Tunnel Audit, and Tunnel Repair can be accessed by 
selecting Placement Tools.

As an example, assume that we run Tunnel Repair on a set of tunnels as described in Tunnel Repair, page 
6-21.

Movable Tunnel Selection Window

When selecting Tunnel Repair from the Placement Tools button, the Movable Tunnel Selection 
window in Figure A-57 appears.

Figure A-57 Movable Tunnel Selection
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The Movable Tunnel Selection window contains the following elements:

• Computation Type—Indicates which tool is used for the computation (Placement, Repair, 
Grooming).

• Maximum computation duration—The maximum amount of time allowed for the computation 
before timeout occurs.

• Maximum number of tunnel moves—The maximum number of tunnels that can be moved during 
Tunnel Repair.

• Number of reroutable tunnels selected as movable—Indicates how many reroutable tunnels 
among the ones shown in the tunnel list are movable.

• Non-reroutable—Indicates how many tunnels among the ones shown in the tunnel list are not 
movable. This is set in the tunnel editor.

• Find—You can search for particular tunnels by selecting the search variable in the drop-down menu 
Show tunnels with, specifying matching criteria, and clicking Find.

Show tunnels with options:

– All—Show all managed tunnels under the current provider.

– Tunnel Number—Tunnel number on the head router.

– Head Device—Full or partial name of the tunnel head device.

– Destination Device—Full or partial host name of the tail device of the tunnel.

– Head, Dest Devices—Exact host name of the head and tail devices of the tunnel.

– Deploy Status—Tunnel deployment status.

– Policy Name—Name of the TE policy.

matching/equal—Specify matching criteria for your search. Wildcards are accepted. matching 
changes to equal if Head, Dest Device is selected in the drop-down menu. For equal, the exact host 
name of the head or tail device must be entered (wildcards not accepted).

• Movable—Indicates whether the tunnel is movable (yes, no or NA). This setting can is toggled by 
clicking Set Movable and Set Unmovable.

• Allow Reroute—Specifies whether reroute is allowed (true or false). If reroute is not allowed, the 
tunnel cannot be set to movable.

• Tunnel ID—Unique tunnel identifier used within ISC TEM.

• T#—Tunnel number on the head router.

• Head—Hostname of the head router.

• Dest—Hostname of the destination router.

• Policy—TE policy for the tunnel.

• BW—The tunnel bandwidth. If the tunnel is auto-bw enabled, BW shows the higher of tunnel 
bandwidth and maximum automatic bandwidth. 

The following actions can be performed:

• Set Movable—Set selected tunnel to movable.

• Set Unmovable—Set selected tunnel to unmovable.

• << Back—Return to the previous window.

• Proceed >>—Proceed to computation.

• Cancel—Cancel the operation and return to the previous window.
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TE Primary Tunnel Computation SR - Changes Window

Still using Tunnel Repair as an example, after selecting Proceed >> from the Movable Tunnel Selection 
window, the TE Primary Tunnel Computation Results - Changes window in Figure A-58 appears.

The figure shows the computation results window after clicking Detail to obtain detailed information 
about the tunnel and view the status of the change request.

Figure A-58 TE Primary Tunnel Computation Results - Tunnel Repair Changes (Details)

The TE Primary Tunnel Computation Results - Changes window contains the following elements:

Status section (top):

• Computation Status—Indicates whether the computation succeeded or failed.

• Tunnels:

– unplaced—Number of unplaced tunnels out of the total.

– moved—Number of tunnels that were moved.

• Bandwidth - unplaced—Amount of bandwidth that was not placed out of the total available 
bandwith.

• Global Util.—Global Pool bandwidth utilization percentage.

• Sub Pool Util.—Sub Pool bandwidth utilization percentage

• Solution—Utilization for the generated solution.

• Original—Utilization for the original solution.

Changes section (left):

• Changes—Number of changes achieved out of the total number of changes.

– Achieved—Indicates whether a specific change is successful (Yes or No).

– Origin—The originator of the change. Can be user (change by user) or compute (from a 
computation, e.g. rerouting of a tunnel).
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– Type—The type of change requested: Tunnel Add Change, Tunnel Modify Change, Tunnel 
Remove Change, or Element Modify Change.

– Object ID—A tunnel or link ID.

Information section (right):

• Change Type—The type of change requested: Tunnel Add Change, Tunnel Modify Change, 
Tunnel Remove Change, or Element Modify Change.

• Achieved—Indicates whether a specific change is successful (Yes or No).

• Description—Description of the computation attempt.

• ID—Tunnel ID.

• Head—Hostname of the head router.

• Tail—Hostname of the destination router.

• Policy—TE policy for the tunnel.

• Bandwidth—Bandwidth used in computation.

• Path—Tunnel path in the form of either a computed path or an existing path . Click to view the path.

• Changed attribute table:

– Changed Attributes—Lists the tunnel attributes that have changed.

– New Value—New value of the attribute.

– Achieved—Indicates whether a specific change is successful (Yes or No).

The following actions can be performed:

• Close—Close the Topology Display applet if open.

• Display—Invoke the Topology Display to view selected links and/or tunnels in the network. 
Selected links/tunnels are displayed with a unique color.

• Detail—Open the detail panel in the right side of the Computation Result window to see the 
tunnel/link information.

• << Back—Return to the previous window.

• View Report >>—View a list of generated reports. The Report window appears (see Figure A-60).

• Save & Deploy (Figure A-59)—For committing all user originated and system computed changes. 
There are two options for saving and deploying tunnel SRs to the network:

– Deploy Achieved Changes—Place all achieved changes in the deployment queue.

– Force Deploy All Tunnels—Force deployment of all elements in the SR. This could be useful 
when previous provisioning of the SR has failed, so that it is necessary to force through the 
deployment of all tunnels in the SR.

Figure A-59 Save & Deploy

• Cancel—Cancel the operation and return to either the Links List, TE Managed Primary Tunnels SR, 
or the TE Resource Management SR window depending on the originating flow.
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TE Primary Tunnel Computation Results - Report

To view the computation reports, click View Report >>. The TE Primary Tunnel Computation Results 
- Report window in Figure A-60 appears.

In this case, there is both a quality report and a violation report. In that case, a detail report such as the 
violation report in Figure A-61 will appear. Warning and violation reports have different fields and they 
are all described in Appendix B, “Warnings and Violations.”

Select the desired report and click the Detail button

Figure A-60 TE Managed Primary Tunnels SR - Tunnel Repair Report (Details)

The TE Primary Tunnel Computation Results - Report window contains the following elements:

Status section (top): described above (Figure A-58).

Report section (left):

• Report Type—There are three basic report types: a qualityReport (generated every time), warning 
reports, and violation reports.

• Summary Info—Summary information about the findings of the report.

Information section (right):

• Report Type—See description above.

• Description—Specific information about the report.

• Achievement—Success or failure of the computation attempt/solution (Yes or No).
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• Solution—Indicates whether a solution was found.

• Termination—Indicates whether the computation was completed.

• Optimality—Indicates whether the computation was optimal.

Tables:

• Tunnel Placement: Tables that compares various tunnel placement attributes of the original 
configuration with the solution configuration.

– Tunnels: Attributes of the original and computed tunnels.

– Bandwidth: Attributes of the tunnel bandwidth.

– %Placed—Percentage of tunnels that were successfully placed.

– Placed—Number of tunnels that were successfully placed.

– Unplaced—Number of tunnels that were not placed.

– Total—Total number of tunnels.

– Tunnels moved—Number of tunnels moved from their original paths.

– TE-Metric Sum (Primary Tunnel Paths)—TE metric sum for the computed and the original 
paths.

• Utilization:Table that compares various utilization measurements of the original configuration with 
the solution configuration

– Global Pool—Comparison data for various Global Pool attributes.

– Sub Pool—Comparison data for various Sub Pool attributes. 

– Median—[to be added]

– Max. Modifiable—[to be added]

– Mean—[to be added]

– Max.—[to be added]

The following actions can be performed:

Changes actions (buttons, left):

• Detail—When a report is selected, the Detail button displays the contents of the report, which can 
contain warnings or violations, in the right window pane.

Note For a description of possible warnings and violations in ISC TEM, see Appendix B, “Warnings 
and Violations.”

• << View Result—Return to the Changes window.
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Figure A-61 TE Managed Primary Tunnels SR - Violation Report (Details)

In Figure A-61, the top status section and the left Report section contain the same fields as in 
Figure A-60. 

Create Unmanaged TE Tunnel
The only two differences between the managed and the unmanaged tunnel GUIs is that the path option 
table does not automatically populate the two System/Dynamic paths and that the Conformance status 
is only indicated for unmanaged primary tunnels.

For a description of the rest of the GUI, see Create Managed TE Tunnel, page A-39.

Create TE Backup Tunnel
To access the TE Protection SR window for managing backup tunnels, go to Service Inventory > 
Inventory and Connection Manager > Traffic Engineering Management > Create TE Backup 
Tunnel. The TE Protection SR window in Figure A-62 appears.
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Figure A-62 TE Protection SR

The TE Protection SR window contains the following elements:

The columns in the tunnel list provides the following information:

• Op—Current SR operation on the tunnel. This can be one of the following:

– ADD—Indicates a newly added tunnel, either calculated by the system or entered by the user.

– MODIFY—Indicates a modified existing tunnel.

– DELETE—Indicates an existing tunnel to be deleted, either computed by the system or 
originated by the user.

• Tunnel ID—Unique tunnel identifier used within ISC TEM.

• Head—Hostname of the head router.

• Dest—Hostname of the destination router.

• T#—Tunnel number on the head router.
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• BW Quota—The amount of bandwidth this backup tunnel can protect. The router limits the LSPs 
that can use this backup tunnel so that the sum of the bandwidth of the LSPs does not exceed the 
specified amount of bandwidth. If there are multiple backup tunnels, the router will use the best-fit 
algorithm.

• Deploy Status—Tunnel deployment status.

• Conformance—Indicates whether the tunnel is found to be conformant when running discovery. A 
tunnel is non-conformant if it has a non-zero bandwidth reservation and a zero hold or setup priority. 
If a tunnel is entered through ISC TEM, it is always conformant.

The following actions can be performed (buttons):

• Close—Close the Topology Display applet if open.

• Display—Open a Topology Display for the network and highlight the selected backup tunnel(s). 
The selected tunnel(s) is/are marked in color with directional arrows.

• Details—Open the TE Tunnel Details window, which provides type, status, LSP, and other 
information about the tunnel.

• Create—Create a backup tunnel.

• Edit—Edit the selected backup tunnel.

• Delete—Delete the selected backup tunnels.

• Audit SR—Audit protection of protected elements using all existing backup tunnels and proposed 
changes in the SR.

• Save & Deploy (Figure A-63)—For committing resource changes in the SR. Two options for saving 
and deploying Backup Tunnel SRs to the network:

– SR Tunnels Only—Deploy all tunnel changes in the SR, or if no changes were made to the SR, 
use this to re-deploy the SR that was in Requested or Invalid state.

– Force Deploy All Tunnels—Force deployment of all tunnels in this SR. This could be useful 
when previous provisioning of the SR has failed, so that it is necessary to force through the 
deployment of all tunnels in the SR.

Figure A-63 Save & Deploy Tunnels

• Cancel—Cancel the operation and return to the Traffic Engineering Management Services window.

The tunnel SR search tool allows you to look for particular tunnels by selecting tunnel characteristics in 
the drop-down menu tunnels with and specify matching criteria in the Matching field:

• Show:

– Existing—Show existing tunnels already deployed in the network.

– SR—Show tunnels not yet deployed in the network.

• tunnels with:

– All—Show all managed tunnels under the current provider.

– Tunnel Number—Tunnel number on the head router.

– Head Device—Full or partial name of the tunnel head device.
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– Destination Device—Full or partial host name of the tail device of the tunnel.

– Head, Dest Devices—Exact host name of the head and tail devices of the tunnel.

– Tunnel Status—Tunnel deployment status.

– Conformance—Conformant or non-conformant tunnel.

• matching/equal—Specify matching criteria for your search. Wildcards are accepted. matching 
changes to equal if Head, Dest Device is selected in the drop-down menu. For equal, the exact host 
name of the head or tail device must be entered (wildcards not accepted).

• Find—Click the Find button when the search criteria has been entered.

Create TE Backup Tunnel Window

From the TE Protection SR window, click Create to access the Create TE Backup Tunnel window shown 
in Figure A-64.
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Figure A-64 Create TE Backup Tunnel

The Create TE Backup Tunnel window contains the following elements:

• Head Device—Head device for the tunnel. For selecting devices, see Figure A-49.

• Destination Device—Destination device for the tunnel. For selecting devices, see Figure A-50.

• Protected Interface—Interface(s) on the head router that this backup tunnel protects.

• Backup Bandwidth Limit—Bandwidth protected by the backup tunnel.

– Any Pool BW—Bandwidth set aside for the protection of either the Sub Pool or the Global 
Pool.

– Sub Pool (BC1) BW—Bandwidth set aside for the Sub Pool.

– Global Pool (BC0) BW—Bandwidth set aside for the Global Pool.

• Tunnel Number—Tunnel number corresponding to the tunnel interface name.
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– Auto Gen—Check this box to generate the tunnel number at provisioning time. Otherwise, 
enter a desired number.

• Tunnel Bandwidth—Total allocated bandwidth of this backup tunnel (display only).

• Tunnel Pool Type—Tunnel bandwidth pool type (display only).

– Global Pool (BC0)—Section of the total link bandwidth containing all Sub Pools for the link.

– SubPool (BC1)—Bandwidth section nested inside the Global Pool part of the total bandwidth.

• Setup Priority (0-7), Hold Priority (0-7), Affinity, Affinity Mask—Should not normally be used 
for backup tunnels. See definitions accompanying Figure A-51.

Path options:

• Option #—Sequential number of available explicit paths.

• Path Name—Name of the explicit path.

• Path Type—Explicit path type (Explicit or Dynamic)

• Lock Down—Disables reoptimization check on the tunnel, if checked.

The following actions can be performed (buttons):

• Add—Add a path option. This opens the Select TE Explicit Path window in Figure A-52.

• Delete—Delete a path option.

• OK—Accept all changes and return to the TE Managed Primary Tunnels SR window. 

• Cancel—Cancel the operation and return to the TE Managed Primary Tunnels SR window.

Select TE Protected Interface

When clicking the Select button in the backup tunnel editor to select a TE protected interface, the 
window in Figure A-65 appears.

Figure A-65 Select TE Protected Interface

The Select TE Protected Interface window contains the following elements:

• Interface Name—Name of the interface to be protected.

• IP Address—IP address of the interface.

• Next Hop—Name of the next hop device.
A-63
Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

OL-6376-01



  

Appendix A      Traffic Engineering Management GUI
  TE Traffic Admission
The following actions can be performed:

• Select—Accept the selected interface and return to the previous window.

• Cancel—Cancel the operation and return to the previous window.

TE Traffic Admission
This section describes the GUI elements in the TE Traffic Admission SR window.

To assign traffic to traffic-engineered tunnels, see Chapter 8, “Traffic Admission.” 

Select TE Tunnel for Admission
To access the TE Traffic Admission SR window, go to Service Inventory > Inventory and Connection 
Manager > Traffic Engineering Management > TE Traffic Admission. 

Prior to reaching the main TE Traffic Admission SR window, a tunnel has to be selected as shown in 
Figure A-66.

Figure A-66 Select TE Tunnel for Admission

The TE Traffic Admission SR list contains the following columns:

• Op Type—SR operation on the tunnel, can be either ADD, MODIFY, DELETE, or ADMIT.

• Tunnel ID—Unique tunnel identifier used within ISC TEM.
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• T#—Tunnel number on the head router.

• Head—Hostname of the head router.

• Dest—Hostname of the destination router.

• Deploy Status—Can be Pending, Deployed, or Functional.

• Type—Managed or unmanaged.

• Policy—Tunnel policy.

TE Traffic Admission SR
After selecting a TE tunnel by clicking the corresponding radio button and clicking Select, the TE Traffic 
Admission SR window in Figure A-67 appears.

Figure A-67 TE Traffic Admission SR

The main TE Traffic Admission SR window contains the following fields:

• Tunnel—Tunnel name.

• Description—Service request description.

• Autoroute announce—Used to specify that the Interior Gateway Protocol (IGP) should use the 
tunnel (if the tunnel is up) in its enhanced shortest path first (SPF) calculation.

– On—Autoroute announce is enabled.

– Off—Autoroute announce is disabled.

• Autoroute Metric—Used to specify the Multiprotocol Label Switching (MPLS) traffic engineering 
tunnel metric that the Interior Gateway Protocol (IGP) enhanced shortest path first (SPF) calculation 
uses.

– Absolute—Absolute metric mode; you can enter a positive metric value.
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– Relative—Relative metric mode; you can enter a positive, negative, or zero value.

• Static Routes—Lists any static routes that the tunnel uses.

• Destination—Name of the static route for the tunnel destination.

• Mask—Prefix mask for the destination.

• Distance—Administrative distance (cost).

The following actions can be performed:

• Add—Add static route.

• Edit—Edit selected static route.

• Delete—Delete selected static routes.

• Save SR—Save service request to the SR pool.

• Cancel—Cancel the operation and return to the previous window.

Adminstration
As the administrative features of ISC TEM are general to ISC, some features are described in Chapter 9, 
“Administration”, others in Cisco IP Solution Center Infrastructure Reference, 4.0.

For further clarification, see Chapter 9, “Administration”.

Monitoring
This section describes the GUI elements in the following windows:

• TE Task Logs (see also TE Task Logs, page 10-1)

• TE Performance Reports (see also TE Performance Reports, page 10-4).

TE Task Logs
The TE task logs are used to view the result of running one or more TE tasks as described in TE Task 
Logs, page 10-1.

To view the task log for a TE task, three sequential steps are required:

1. Access the Task Runtime Actions window.

2. Select a runtime action to reach the Runtime Actions window.

3. Select the desired log in the Task Log window.

Each window in this process is described as follows.

Note Specific instructions for how to view a task log for a TE Discovery task are found in the TE Discovery 
Task Logs, page 3-6.
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Task Runtime Actions

To access the Task Runtime Actions window, go to Monitoring > Task Manager. Select Logs in the 
table of contents on the left side of the Tasks window. The Task Runtime Actions window in Figure A-68 
appears.

Figure A-68 Task Runtime Actions

The Task Runtime Actions window contains the following GUI elements:

• Runtime Task Name—Automatically attributed task name specifying when the runtime task was 
created.

• Type—Type of task, either TE Discovery, TE Functional Audit, or TE Interface Performance.

• Start Time—The date and time when the runtime task was started.

• End Time —The date and time when the runtime task ended.

• Status—Indicates the result of the runtime task.

Search fields:

• Show Runtime Tasks with Task Name matching—Type a filter string matching part of the desired 
Runtime Task Name.

• of type—The type of task created using the Task Manager. The following types are available:

– TE Discovery—Search for a TE Discovery task.

– TE Functional Audit—Search for a TE Functional Audit task.

– TE Interface Performance—Search for a TE Interface Performance task.

Runtime Actions

To access the Runtime Actions window, go to the Task Runtime Actions window and click the desired 
task in the Runtime Task Name field. This open the Runtime Actions window shown in Figure A-69.
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Figure A-69 Runtime Actions

The Runtime Actions window contains the following GUI elements:

• Refresh—Refresh the Runtime Actions table to list recently completed tasks.

• Action—Name of the Runtime Actions log.

• Start Time—The date and time when the runtime task was started.

• End Time —The date and time when the runtime task ended.

• Status—Indicates the result of the runtime task.

Task Log

To access the Task Log window, go to the Runtime Actions window and click the desired log in the 
Action field or select a check box and click Log. The Task Log window in Figure A-70 appears.
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Figure A-70 Task Log

How the log is structured depends on the type of task that was run.

The following actions can be performed:

• Filter—Select the desired log level, optionally enter exact Component name, and click Find.

• Return to Logs—Return to the Runtime Actions window.

TE Performance Reports
Performance reports are created when you run a TE Interface Performance task as described in 
Creating a TE Interface Performance Task, page 9-11.

To view a performance report, go to Monitoring > TE Performance Report. The TE Performance 
Report Table in Figure A-71 appears.
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Figure A-71 TE Performance Report Table

The TE Performance Report Table window contains the following GUI elements:

• Report table—The table shows a list of Interface Performance tasks 

– Start Time—The date and time when the runtime task was started.

– End Time—The date and time when the runtime task ended.

– Device—Name of the device.

– Interface—IP addresses of the interfaces on the link.

– Octets In—Number of inbound octets of traffic.

– Octets Out—Number of outbound octets of traffic.

– Speed—Speed of the interface.

– Util In—Interface utilization for inbound traffic.

– Util Out—Interface utilization for outbound traffic

• Reconcile Data—When an Interface Performance task has been run multiple times on an interface, 
you can choose to reconcile the data according to the following criteria: 

– Pick Peak—Select the highest interface utilization.

– Pick Valley—Select the lowest interface utilization.

– Average—Select the average interface utilization.

– Pick First—Select the first occurrence of interface utilization.

You can perform the following actions:

• Find—Filter out performance data according the criteria selected in the drop-down menu.

• Cancel—Quit the report page.

• Close—Close the Topology Display applet if open.

• Display—Invoke the Topology Display to view selected links and/or tunnels in the network. 
Selected links/tunnels are displayed with a unique color.
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Warnings and Violations

This appendix lists warnings and violations that might be invoked when using the planning tools in Cisco 
IP Solution Center Traffic Engineering Management (ISC TEM) (computation engine).

Warnings and violations are tied in with the planning tools (see the “Planning Tools” section on 
page 1-4). They are issued under the following circumstances:

• During an attempt to audit, place, repair, or groom a primary managed tunnel.

• During an attempt to protect selected network elements (links, routers, or SRLGs). Here, they help 
determine the cause of the failed protection (see Chapter 7, “Protection Planning”).

When the off-line backup route generation is called to determine if certain elements can be 
protected, the backup route generator responds for each element with either a set of tunnels that 
protect the element or a set of violations and warnings that help determine why the element could 
not be protected.

This appendix contains the following sections:

• Warnings, page B-1

• Violations, page B-3

Note In the following, the term DirectedLink refers to a router interface.

Warnings
This class is characterized by all reports that are warnings. They are considered less severe than 
violations in the sense that they don’t prevent the computation of a protection path.

Protection Computation Warnings

WarningFixVetoed 

A fix of this element would have caused a neighbouring element to become unprotected.  This fix is 
vetoed and no changes are proposed.

WarningRouterNotConformant 

This element or any adjacent routers is/are not Protocol Conformant. It cannot therefore be protected.
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Fields:

• Report Type—Name of report type.

• Description—Description of the problem signaled by the violation.

• Non-conformant router—Router that does not support traffic engineering.

WarningTunnelBandwidthQuotaTooSmall 

The bandwidth of a backup tunnel that protects this element is below the minimum allowed bandwidth 
capacity. 

Fields:

• Minimum allowed bandwidth quota—Minimum bandwidth allowed to protect the element in 
question.

• Actual tunnel bandwidth quota—Actual bandwidth of the backup tunnel.

WarningTunnelNumberTooLarge 

There are too many backup tunnels for a flow through this element. 

Fields:

• Maximum tunnel number allowed—Maximum number of tunnels allowed for a given network 
element.

• Actual Tunnel Count—Actual number of tunnels imposed on this network element.

• Flow:

– Maximum Bandwidth—Maximum bandwidth for the traffic flow that needs to be protected.

– Head Links—Protected interface for this flow.

– Through Router —Protected device through which the regular traffic flow passes. If the 
protected element is a link, the Through Router field will not appear.

– Tail Router—Host name of destination (tail) router.

– Type (NHop, NNHop)—Next hop type: NHOP for link (no through router) and NNHOP for 
node.

WarningZeroProtectedFlow

A flow through this element is protected by a backup tunnel, but has a maximum flow of zero. 

Fields:

• Flow:

– Maximum Bandwidth—Maximum available bandwidth on the element.

– Head Links—Protected interface for this flow.

– Through Router —Protected device through which the regular traffic flow passes. If the 
protected element is a link, the Through Router field will not appear.

– Tail Router—Host name of destination (tail) router.

– Type (NHop, NNHop)—Next hop type: NHOP for link (no through router) and NNHOP for 
node.
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Violations
This class is specialized by all reports that are violations. They are considered more "severe" than 
warnings because unlike warnigns, they will prevent the computation of a protection path.

Primary Placement Computation Violations

ViolationFrrProtectionInadequate 

The FRR protection for a tunnel does not meet the specified protection level. 

Fields:

• Report Type—Name of report type.

• Description—Description of the problem signaled by the violation.

• Required FRR Protection Level—Used to enable an MPLS traffic engineering tunnel to use a 
backup tunnel in the event of a link failure if a backup tunnel exists. Possible levels are None, Best 
Effort, Link and SRLG, and Link, SRLG and Node.

• Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

• Path—Tunnel Path

– Node—Device host name. Is only displayed if the protection level is "Link, SRLG & Node".

– Protected (Node)—Indicates whether each node is protected (Yes) or not (No). Is only 
displayed if the protection level is "“Link, SRLG & Node".

– Link Label—IP addresses of the interfaces on the link.

– Protected (Link)—Indicates whether each link is protected (Yes) or not (No).

ViolationInconsistentResourceAttributeChanges 

A Topology-change attempts to modify one or more attributes on a resource causing a pair of its 
attributes to become inconsistent. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Resource—

– Id—Id for head device or head interface representing the network resource.

– Type—Resource device or interface.

• Attributes:

– Attribute—Names of inconsistent attributes.

– New Value—New attribute value proposed by user.
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ViolationInconsistentTunnelAttributeChanges 

A Tunnel-change attempts to modify one or more attributes on a tunnel causing a pair of its attributes to 
become inconsistent. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

• Attributes:

– Attribute—Names of inconsistent attributes.

– New Value—New attribute value proposed by user.

ViolationLinkAffinityMismatch 

A least one directed link in the path of a Primary Tunnel does not have attribute flags that match the 
affinity bits and mask of the Tunnel. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Affinity Bits/Mask—Affinity bits and mask of the tunnel.

• Path—Name of tunnel path.

– Outgoing Interface—Host name/IP address of outgoing interface.

– Attribute Flags—Links attributes to be compared to the tunnel's affinity bits. All have to be 
identical to have a valid path. The violation is triggered when at least one is different.

ViolationLinkPoolOversubscribed 

The specified bandwidth pool for a directed link is over-subscribed by Primary Tunnels that  pass 
through it. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Directed Link:

– Head Device/Interface—Host name for the head device and IP address of interface.

– Tail Device/Interface—Host name for the destination (tail) device or interface.

– Pool—Global pool or sub pool.
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– Pool Bandwidth—The allocated global pool or sub pool bandwidth on the link.

• Primary Tunnel (table)—Specifies how many tunnels are using the link resource.

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Bandwidth—Total bandwidth of the tunnel.

– Pool—Global pool or sub pool.

– Path—Name of tunnel path.

ViolationMaxReRoutesExceeded 

This number of Primary Tunnel re-routes in this solution exceeds the specified maximum. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Number of re-routes in solution—Number of re-routes proposed by the computation engine.

• Specified maximum number of re-routes—Maximum number of re-routes allowed.

ViolationNoPathInLayout 

In the presence of other Primary Tunnels that have already been placed on the topology, no legitimate 
path is possible for a requested Primary Tunnel.  Note: If a user requested path was specified this only 
means that the Primary Tunnel could not be placed on that requested path in the presence of other 
Primary Tunnels. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Requested Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Bandwidth—Total bandwidth of the tunnel.

– Requested Path—User-specified path for the tunnel.

– Pool—Global pool or sub pool.

– FrrProtection—Possible protection levels are None, Best Effort, Link and SRLG, and Link, 
SRLG and Node.

– Propagation Delay—The time it takes for traffic to travel along a link from the head interface 
to the tail interface.

– AffinityBits/Mask—Affinity bits and mask of the tunnel.

ViolationNoPathInTopology 

Irrespective of other Primary Tunnels placed upon the topology, no valid path is possible for a requested 
Primary Tunnel. Note: If a user requested path was specified this only means that the Primary Tunnel 
could not be placed on that requested path irrespective of other tunnels. 
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Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Requested Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of (destination) tail router.

– Bandwidth—Total bandwidth of the tunnel.

– Requested Path—User-specified path for the tunnel.

– Pool—Global pool or sub pool.

– FrrProtection—Possible protection levels are None, Best Effort, Link and SRLG, and Link, 
SRLG and Node.

– Propagation Delay (optional)—The maximum time allowed for traffic to travel along the 
requested path..

– AffinityBits/Mask—Affinity bits and mask of the tunnel.

ViolationNoTunnelForDemand 

No path implements a requested PrimaryTunnel, even though there exists a valid path in the network that 
this tunnel could take. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Requested Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Bandwidth—Total bandwidth of the tunnel.

– Requested Path—User-specified path for the tunnel.

– Pool—Global pool or sub pool.

– FrrProtection—Possible protection levels are None, Best Effort, Link and SRLG, and Link, 
SRLG and Node.

– Propagation Delay (optional)—The maximum time allowed for traffic to travel along the 
requested path.

– AffinityBits/Mask—Affinity bits and mask of the tunnel.

ViolationPathMismatch 

A Primary Tunnel has a different path to that specified for it in the User Specified Path. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.
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• Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Actual Path—Actual path of the tunnel associated with the violation.

– Requested Path—User-specified path for the tunnel.

ViolationPathNotConnected 

The path of a Primary Tunnel is not “connected”, that is. it does not form a connected sequence of 
admin-up links between the tunnel head and tail, or it contains loops. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Path—Name of tunnel path.

ViolationPathUsesMissingLinks 

A Tunnel-change attempts to create or modify a Tunnel so that its path or “User Requested Path” uses 
one or more directed links that do not exist in this topology. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Change Type—Add Tunnel/Modify Tunnel.

– Path Type—Requested/Actual.

– Path—Name of tunnel path.

– Outgoing Interface—Yes or No depending on whether a link is missing.

– Incoming Interface—Yes or No depending on whether a link is missing.

ViolationPrimaryTunnelDelayTooLong

A Primary Tunnel has a propagation delay that is larger than the Maximum Propagation Delay specified 
for it. 

Fields:

• Report Type—Quality report, warning report, or violation report.
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• Description—Description of the problem signaled by the violation.

• Required Max Propagation Delay—The maximum time allowed for traffic to travel along the 
requested path.

• Primary Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

– Path—Name of tunnel path.

– Actual Propagation Delay (table)—The time it takes for traffic to travel along each link in the 
entire path.

- Link—Link segments in path.

- Propagation Delay—Travel time for the traffic for each link segment.

ViolationResourceIdUnknown 

A change attempts to remove or modify a resource (link, router or SRLG) with an Id, when no resource 
with that Id exists.

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Resource to be removed:

– Id—Id for head device or head interface representing the network resource.

– Type—Resource device or interface.

ViolationTunnelIdInUse 

A change attempts to add a Primary Tunnel with an Id that already exists. 

Fields:

• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Tunnel to Add:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

• Existing Tunnel:

– Name—Tunnel identifier composed of a name and a tunnel number.

– Head—Host name of head router.

– Tail—Host name of destination (tail) router.

ViolationTunnelIdUnknown 

A change attempts to remove or modify a Primary Tunnel with an Id when no tunnel with that Id exists. 

Fields:
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• Report Type—Quality report, warning report, or violation report.

• Description—Description of the problem signaled by the violation.

• Tunnel to Remove:

– Id—Unique tunnel identifier used within ISC TEM.

Protection Computation Violations

ViolationAggregateBandwidthOnLink 

The bandwidth of backup tunnels for this element, which pass through the link, have a maximum 
bandwidth quota that exceeds the backup bandwidth of the link. 

Fields:

• Required Bandwidth (due to tunnels)—Required bandwidth for the tunnels on the link.

• Link:

– Backup Bandwidth—Total available bandwidth of the link.

– Head Router—Host name of the head router.

– Head Interface—IP address of the head interface.

– Tail Router—Host name of destination (tail) router.

– Tail Interface—IP address of the destination (tail) interface.

– Label—IP addresses of the interfaces on the link.

– Admin Status—Indicates whether the link is Up or Down.

ViolationBadBackupTunnel 

The tunnel does not protect a flow over this element. 

ViolationBandwidthProtectionMismatch 

The tunnel backup bandwidth quotas of all the tunnels protecting a flow do not add up exactly to the 
maximum bandwidth of that flow. 

Fields:

• Protected bandwidth—The protectable bandwidth of the protection path.

• Flow:

– Maximum Bandwidth—Maximum available bandwidth on the element.

– Head Links—Protected interface for this flow.

– Through Router —Protected device through which the regular traffic flow passes. If the 
protected element is a link, the Through Router field will not appear.

– Tail Router—Host name of destination (tail) router.

– Type (NHop, NNHop)—Next hop type: NHOP for link (no through router) and NNHOP for 
node.

ViolationLinkLevelTunnelDelayTooLarge 

The delay of  the backup tunnel is greater than that allowed. 

Fields:
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• Maximum allowed delay—Maximum delay allowed on the backup tunnel.

• Actual delay of tunnel—Actual delay of the backup tunnel.

ViolationNoBackupTunnels 

There are no backup tunnels protecting this flow through the element.

Fields:

• Flow:

– Maximum Bandwidth—Maximum available bandwidth on the element.

– Head Links—Protected interface for this flow.

– Through Router —Protected device through which the regular traffic flow passes. If the 
protected element is a link, the Through Router field will not appear.

– Tail Router—Host name of destination (tail) router.

– Type (NHop, NNHop)—Next hop type: NHOP for link (no through router) and NNHOP for 
node.

ViolationPassesThroughSRLG 

A backup tunnel is protecting a flow over this element that starts at a link within an Shared risk link 
group(SRLG).  However that tunnel also passes through another link in the same SRLG.

Fields:

• Link:

– Backup Bandwidth—Total available bandwidth of the link.

– Head Router—Host name of the head router.

– Head Interface—IP address of the head interface.

– Tail Router—Host name of destination (tail) router.

– Tail Interface—IP address of the destination (tail) interface.

– Label—IP addresses of the interfaces on the link.

– Admin Status—Indicates whether the link is Up or Down.

• SRLG—User-defined SRLG name.

• Flow:

– Maximum Bandwidth—Maximum available bandwidth on the element.

– Head Links—Protected interface for this flow.

– Through Router —Protected device through which the regular traffic flow passes. If the 
protected element is a link, the Through Router field will not appear.

– Tail Router—Host name of destination (tail) router.

– Type (NHop, NNHop)—Next hop type: NHOP for link (no through router) and NNHOP for 
node.

ViolationUsesFailedElement 

A backup tunnel that protects this element also uses it. 
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Document Type Definition (DTD) File

The Document Type Definition (DTD) file provides the rules required by the XML import file for 
importing bulk data into ISC TEM.

For instructions on how to import tunnels into ISC TEM, see the “Import Primary Tunnel” section on 
page 6-8.

The following shows an example of a DTD file.

<?xml version="1.0" encoding="UTF-8"?>

<!-- Data Definition for file based tunnel import -->

<!-- Import File Structure -->
<!ELEMENT IMPORT_DATA (TUN_ADD|TUN_CHANGE|TUN_DELETE|TUN_MIGRATE)+ >

<!-- Notes on attributes:
     importId:must be unique within the file,
          it is alphanumeric, must begin with alpha character,
          and no special character
     head, tail:hostname of valid TE enabled device
     policy:name of existing managed tunnel policy
     bw: must be numeric and values between 0-2147483647
     tnum:is the number portion of a tunnel interface
          E.g. for "interface tunnel3", use tnum="3"
          must be numeric and values between 0-65535
-->

<!-- Tunnel Add

   - #IMPLIED attributes are optional, if not specified, defaults to null
   - If tnum is not specified, system will generate tunnel number
   - To enable auto bandwidth, specify AUTOBW element
   - bw is required if autobw is not enabled
   - By default, tunnel will be created with a system path and a dynamic path

-->

<!ELEMENT TUN_ADD (AUTOBW?)>
<!ATTLIST TUN_ADD
         importId ID #REQUIRED

head CDATA #REQUIRED
tail CDATA #REQUIRED
policy CDATA #REQUIRED
bw CDATA #IMPLIED
tnum CDATA #IMPLIED>
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<!-- Tunnel Change

  - #IMPLIED attributes are optional, if not specified, value on existing
    tunnel is kept
  - To enable auto-bw, or to change auto-bw parameters, specify AUTOBW element
  - To disable auto-bw, set disableAutoBw="yes" and do not specify AUTOBW element
  - Existing tunnel path cannot be changed directly, setting reroutable="true"
    will enable system to reroute the tunnel if necessary

-->

<!ELEMENT TUN_CHANGE (AUTOBW?)>
<!ATTLIST TUN_CHANGE
         importId ID #REQUIRED

head CDATA #REQUIRED
tnum CDATA #REQUIRED
policy CDATA #IMPLIED
bw CDATA #IMPLIED
disableAutoBw (yes) #IMPLIED
reroutable (true|false) #IMPLIED>

<!-- Tunnel Delete

  - all attributes are required to identify tunnel to be deleted

-->

<!ELEMENT TUN_DELETE EMPTY>
<!ATTLIST TUN_DELETE
         importId ID #REQUIRED

head CDATA #REQUIRED
tnum CDATA #REQUIRED>

<!-- Tunnel Migrate

  - #IMPLIED attributes are optional, if not specified, value on existing
    tunnel is kept
  - All comments under Tunnel Change (above) applies to Tunnel Migrate
  - only unmanaged primary tunnel can be migrated
  - for tunnels with unmanaged tunnel policy, must specify a managed policy
  - for tunnels that was non-conformant:
         . if bw was zero, specify a new bw or enable auto-bw
         . if path was dynamic or non-conformant, the path options will be
           replaced with a system path and a dynamic path, and reroutable will
           be set to true.
  - reroutable attribute applicable only for tunnel that had a conformant first
         explicit path (i.e. explicit path with no loopback)

-->

<!ELEMENT TUN_MIGRATE (AUTOBW?)>
<!ATTLIST TUN_MIGRATE
         importId ID #REQUIRED

head CDATA #REQUIRED
tnum CDATA #REQUIRED

         policy CDATA #IMPLIED
         bw CDATA #IMPLIED

disableAutoBw (yes) #IMPLIED
         reroutable (true|false) #IMPLIED>
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<!-- Auto Bandwdith

  - #IMPLIED attributes are optional, if not specified, value is set to null
    for TUN_ADD and existing value is kept TUN_CHANGE
  - maxBw is required when used in TUN_ADD or if existing tunnel is not auto-bw
    enabled
  - minBw and maxBw must be numeric and values between 0-2147483647
  - maxBw must be greater than minBw if specified
  - freq must be numeric and values between 300-604800

-->

<!ELEMENT AUTOBW EMPTY>
<!ATTLIST AUTOBW

freq CDATA #IMPLIED
minBw CDATA #IMPLIED
maxBw CDATA #IMPLIED>

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE IMPORT_DATA SYSTEM "TeImport.dtd">

<IMPORT_DATA>

<!--  Add New Managed Tunnel -->
<TUN_ADD importId="a1" head="isctmp3" tail="isctmp1" policy="mgdPolicy" bw="400" />
<TUN_ADD importId="a2" head="isctmp2" tail="isctmp9" policy="mgdPolicy" >
  <AUTOBW freq="300" minBw="100" maxBw="200"/>
</TUN_ADD>

<!--  Modify Existing Tunnel -->
<TUN_CHANGE importId="c1" head="isctmp2" tnum="200" bw="30" />
<TUN_CHANGE importId="c2" head="isctmp4" tnum="2" policy="mgdPolicy" reroutable="true"/>
<TUN_CHANGE importId="c3" head="isctmp5" tnum="46">
  <AUTOBW freq="300" minBw="100" maxBw="200"/>
</TUN_CHANGE>
<TUN_CHANGE importId="c4" head="isctmp2" tnum="200" bw="30" disableAutoBw="yes"/>

<!--  Delete Existing Tunnel -->
<TUN_DELETE importId="d1" head="isctmp3" tnum="45"/>

<!--  Migrate Tunnel -->
<TUN_MIGRATE importId="m1" head="isctmp2" tnum="3" policy="mgdPolicy"/>
<TUN_MIGRATE importId="m2" head="isctmp5" tnum="1" policy="mgdPolicy"/>

</IMPORT_DATA>
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